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Objective

In this chapter, users will learn the basic layout of Aptify:

• Introduction to End User Training

• Learning Initial Aptify Display, the Dashboard Contents

• Understanding Basic Aptify Terminology

• Connecting to Aptify

• Displaying the Folder List

• Adding Applications

• Removing Services

• Working with Shortcuts

• Viewing the Exception Log

• Using the Help Menu

• About Recently Used Records
1.1



Introduction to End User Training Aptify Basics
Introduction to End User Training

The following chapters and sample exercises will guide users through the various functions 
available in Aptify and how it should be used.

This course provides an overview of Aptify’s basic features and will familiarize users with 
core functions of Aptify. It offers a solid background for users to become acquainted with the 
system as it introduces the basic Aptify framework, using a fictitious association's database to 
gain experience with a wide variety of system applications and creation of many types of data 
views.

With step-by-step directions, users learn how to navigate the system as well as enter and view 
data by partaking in sample, hands-on exercises. The focus of this End User course and 
manual is learning the applications by using the system, and in doing so, Subject Matter 
Experts (SME's) will have the knowledge to prepare to move into the next phase of the Aptify 
implementation process in a more efficient and effective manner. 

Additionally, this manual provides information that can be utilized as a reference for Aptify 
users in their workplace.

Upon completion of the course, users will have learned the best practices regarding how to 
use Aptify for their needs and the Aptify terminology. For example, Aptify users learn that 
"persons" records are any person in their database, "products" are anything that can 
generate income, including a virtual product such as membership, a class or meeting, 
and physical products like publications. 
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How Aptify Should be Used

Aptify is designed to display data from multiple departments in one database. When set up 
and used correctly, Aptify should be relatively simple and easy for each department to 
interface with on a daily basis.

Setting up Aptify

Aptify users are added to the database by using the Aptify User Administration Wizard. As a 
step in user creation (step 6 of the Wizard) each New Aptify client will copy the Baseline 
profile. Once copied, the Baseline profile can then be modified as a second, renamed profile 
(such as Customer Service Representative). Subsequent users with that same function should 
copy the new (e.g. Customer Service Representative) profile.

By copying a profile, a user inherits the previous profile’s metadata. In terms of end users, 
metadata is composed of the Dashboards, Views, and personal Navigation settings. Each new 
profile should be built by adjusting the Baseline User’s, copied profile. The new profile, when 
completed, should reflect that department’s function.

By carefully setting up profiles from the Baseline profile, administrators significantly jump 
start the Go-Live capabilities of their end users. Those users now have focused Views, 
Shortcuts, and Dashboards that reflect their department/functions needs. 

The setup and copying of the Baseline profile is an Administrator function, but it is critical 
that each department review the existing components: Dashboards, Views, Shortcuts of the 
Baseline profile. After reviewing, the end users can then contribute, through a series of 
meetings, what components need to be added.

Navigating Aptify

Aptify should be navigated by using Shortcuts, Dashboards, and Views. Users will always 
enter Aptify via the Home Dashboard. Users can then employ their Dashboard shortcut bar, 
Services shortcuts, Views shortcuts, and/or Dashboard buttons to navigate to the data. Users 
should utilize Prompted List Views to find data, and focused Wizards tied to Dashboard 
buttons, to enter new data. For a typical Aptify end user, the desired data should be no more 
than three clicks away. This structure is designed to make Aptify both flexible in its 
deployment and configuration and focused in its final design.

How Aptify Works

Aptify is Customer Relationship Software (CRM) designed for Association-based clients and 
is built around the following hierarchy:

• Applications

• Services

• Records

• Views

• Shortcuts

• Dashboards
Aptify End User Training Manual 1.3
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Initial Aptify Display

When Aptify opens, users automatically land on the Home Dashboard. The Home 
dashboard serves as a consolidated functional/viewing area that reflects the user’s main tasks 
and data needed to use often. The Home dashboard should be configured, via the user’s 
profile, to mirror the user’s department/function within the database. For many users, this and 
2-3 additional dashboard applications, will be all the access needed. Home should have a 
Button Bar tied to it that reflects the user’s function. For instance, a customer service rep’s 
Home could have a New Order, New Member, Find Member, etc., buttons, while, an 
accounting user’s Home Dashboard might have New Order Batch button, New Payment, Find 
Payment buttons. 

Home should also have multiple, embedded Views that reflect the user’s most important daily 
functions. A customer service rep might see views titled, Orders Taken Today and/or 
Payments Taken Today. An accounting user might see a view of Past Due Balances over the 
past 30 Days or Batches Scheduled for Today.

Shortcuts, appear on the left-hand side, will display no matter where the user navigates. They 
should also reflect a focused usage on the user’s main functions. 

Users in the Training database will be working with the Baseline user’s Home Dashboard. 
The Baseline profile encompasses ALL base Aptify functionality. As such, it reflects the most 
widespread usage across multiple departments. When users go-live with Aptify, they will 
encounter a more focused, configured Home dashboard suited to their needs. Training users 
also have an embedded Recently Used Records part in their Home Dashboard which will be 
explained during training and in the following chapters. Home Display:
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Digital Dashboards

A dashboard is a gateway for accessing information related to a particular application. 
Administrators can customize dashboards to provide a single interface for commonly used 
tasks. For example, a Customer Management dashboard could include targeted views of the 
Persons and Companies services, with buttons that open a New Company, New Person, New 
Contact Log Entry, Invoice Consolidation, or New Member Wizard. Dashboards should 
contain the most critical summary Views and the most frequently used functions (buttons) per 
Application. They should be each department’s landing page in the system.

Dashboard Buttons

Dashboards are made up of Areas composed of Parts. The two most commonly used Parts 
are Views and Buttons. Buttons are extremely valuable because they can be tied to diverse 
functions and are easily viewable/accessible. Below is a list of button functions:

• New Form (Persons, Company, Member record, etc)

• Find

• Wizard - simplified form entry

• Additional Dashboard

• View

• Report

Dashboard Shortcut Bar

The Dashboard Shortcut Bar enables users to easily navigate between Dashboards. It will 
contain a dashboard shortcut per each enabled (permitted) user dashboard.
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Shortcuts

Shortcuts are embedded Groups and Links that display initially on the left-hand side of the 
screen. They are designed to organize Groups of quick links per function/department for 
instant usage. They are most often tied to Views (specific queries of the data) and Services. 
They enable users to save their most common looks into the data. They are invaluable for 
quick navigation and, along with Dashboards, are the primary navigation aids in the system. 
Shortcuts should be configured according to the user’s profile and should be tied to their 
specific department/function.

It is strongly recommended that Shortcuts be tied to Shared Folders that are governed by 
Department or Function based Administrators - see Ch. 5 for details.
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Using Aptify 

Applications 

Applications are sectioned areas of the database that organize related services to functional 
area of the system. For example, the Customers application maintains customer information 
and contains Services such as Companies, Contact Log, Members Types, Persons, & Tasks. 

Services

Services refer to a type of record. Each service corresponds to one collection of data; for 
example, the Companies service maintains information about the companies with which a 
user’s organization interacts. Note than when switching applications, Services remain the 
same. A service is technically known as an Entity. 
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Views

Views are displays of information from a subset of the records within a particular service. The 
most commonly used type of View is the List View. Users or administrators can specify the 
type or amount of data the view displays. For example, the list view below displays All New 
Memberships added in the Last 90 Days. Once created, views are saved within each user's 
profile for future use and can be distributed via shared folders to other users.

Views are the center of the Aptify system. They are used both to access data records and to 
communicate that data through shared dashboards and reports. 

Prompted Views

The most effective everyday use of Views are Prompted List Views. Prompted List Views 
enable users to interact with the data by making choices as to the values a View (query) will 
use to run. The example below is of a Persons Lookup Prompted List View. 
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Records

Records are entries in a service with a unique ID. Every Service in Aptify has associated 
records. Each Record contains multiple tabs that contain unique information concerning the 
particular record. 

However, records do NOT have to be opened to display valuable data. Embedded, record data 
can be presented much more effectively and concisely using Views. In Views, users can 
display focused, particular data from a record. Utilizing View features, such as the Fields tab, 
Hierarchy tab, and the Preview Pane function (see Ch. 4 & 5), users can avoid opening 
densely, data packed record forms. 

In the example below, only partial data of Aiesha Baldwin is viewable by opening the form. 
Users would need to navigate to additional tabs to see Membership and Orders information. 
In a correctly configured View, that data is already present via its fields and a Preview Pane.

Aiesha Baldwin’s Persons record:

Aiesha Baldwin’s data displayed in a View: 
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Aptify Button

The Aptify Button is a centralized area for controlling several facets of the user’s navigation 
in Aptify. Once comfortable with Aptify’s uses, it may not be necessary for users to return to 
the Aptify button very often. 

• New: This option opens a new record in the currently selected service. (The option is 
grayed out if a user has an application selected.) This provides the same functionality as 
the New button on the Quick Access toolbar.

• Change Password: This option allows users who are not using Windows Integrated 
Security to change their Aptify password (when applicable). 

• Print: Prints the view currently displayed in the main display area. Note that if printing a 
list view that has multiple pages, only information from the currently displayed page is 
printed. This provides the same functionality as the Print button on the Quick Access 
toolbar.

• Print Preview: Displays the current view as it will appear when printed. Note that if 
printing a list view that has multiple pages, only information from the currently displayed 
page is previewed/printed.

• Page Setup: This options allows a user to set up a view’s print options.

• Applications: Select this option to open the application selection dialog to add or 
remove applications. 

• Shortcuts: This option toggles the Shortcut Bar so user can add or remove it from the 
Aptify Desktop. 
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• Folder List: This option toggles the Folder List so a user can add or remove it from the 
Aptify Desktop. 

• Help: This option provides access to the Aptify online help documentation.

• Contents: Selecting this option, or clicking F1 on the keyboard, opens the Aptify 
5.5 online help documentation. Note that the specific page that displays 
depends on what application is currently selected. The page's location is dis-
played in the Help Table of Contents. 

• Index: Selecting this option, or clicking Ctrl+F1 on the keyboard, opens the 
Index tab of the Aptify 5.5 online help documentation.

• Search: Selecting this option, or clicking Ctrl+Shift+F1 on the keyboard, opens 
the Search tab of the Aptify 5.5 online help documentation. 

• Exit: Closes Aptify. Users can also double-click the Aptify Button.

• Session Exceptions: This option opens the Session Exceptions viewer which records 
errors generated by Aptify during the current session. 

• Aptify On The Web: This option opens the Aptify home page in a Microsoft Internet 
Explorer window. 

• About Aptify: This option opens a window that displays information about the version 
of Aptify that is running.
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Folder List

The Folder list is a hierarchical display of Aptify’s applications, services, and views. It is 
basically a Site Map for Aptify akin to Windows Explorer. However, 95% of the functionality 
found in the Folder List can be also accessed via other methods which are explained in this 
manual.

By default, the Folder List does not display for end users. Once accessed it should be closed 
since it occupies valuable display space and does not need to be used on a daily basis. 

If temporarily needed, users can follow these steps to display or hide the Folder List:

1. Click the Aptify Button to display the menu.

2. Select Folder List to display the Folder List.

• Users can pin/unpin the Folder List by clicking the pin icon in the upper right 
corner. The Folder List slides to the left when not in use. 

Users can change the Folder List’s width by placing the cursor on the right 
border of the Folder List’s frame, until the cursor becomes a double arrow. 
Users may then drag the edge of the Folder List to the left or right.
1.12 Aptify End User Training Manual



Aptify Basics Adding Applications
Adding Applications

Applications are a logically grouped collection of services that correspond to a job function, 
and appear below the Home heading in the Folder List. Users can add and remove applica-
tions to save space on screen; removing an application does not delete any data. It would be 
unusual for a user to need to add/delete Application access as this should be done by a SA. 

Follow these steps to select only applications needed:

1. From the Aptify Button menu, select Applications.

2. The system displays the Applications dialog box.

3. From the left-hand window, double-click the Organization Management application to 
move it to the right-hand window. Users can also use the central arrows to perform this 
function.

4. To sort the applications in alphabetical order, click the Application column header 
(Name) in either the left-hand or right-hand window. Clicking once sorts the applications 
in descending order, twice sorts the applications in ascending order.

5. Clear the Show in Ribbon Bar checkbox across from Organizational Management. 
Users may not even need the use of the Ribbon Bar. 

6. Click OK and Organization Management is added to the Dashboard Shortcut bar.
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Navigation Bar

The Navigation Bar is a bread crumb bar for navigating to applications, services, and views. 
It provides a visual indicator of where a user is within Aptify, and may be used in place of the 
Folder List, which was one of the main navigation tools in previous versions of Aptify. To 
browse Aptify using the Navigation Bar, click the arrow that appears to the right of an item to 
display its available options.

For example, clicking the arrow to the right of the Home heading displays all the Applica-
tions a user has available. Users can specify which applications appear in the Navigation Bar 
through the Applications dialog. System administrators may also determine which applica-
tions are available to the user. 
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The Navigation Bar displays Services to the right of an Application heading. These services 
contain specific data types and are logically grouped together within a particular application. 

The Navigation Bar displays the active Views and View Folders to the right of a Service 
heading. The system also displays the list of views and folders available in the main display 
area when a service heading is selected. 

Use the Navigation Bar to navigate from screen to screen within the main display area. Use 
the arrow buttons and drop-down lists to the left of the Home heading to perform the 
following:

• Back: return to the previous screen in the main display area. 

• Forward: move forward one screen; this is the same as the Forward button on the main 
toolbar.

• Go To: from a drop-down list, selects a location previously visited during a session to 
reload that screen.
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Advanced users can type directly into the Navigation Bar and enter a location to access if they 
know the path where the item can be found. To type a location, click to the right of the last 
item in the Navigation Bar. After typing the desired path, click the Enter key.

A user can then navigate to previously typed views, services, or applications, by using the 
Previous Location drop-down list located on the right side of the Navigation Bar. Selecting a 
location from this list reloads the previously visited screen during this session. Note that only 
locations that have been manually typed will appear in this drop-down list.
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Adding Services

Services appear under Applications and are logically grouped together to correspond to a job 
function. Services are represented by icons under applications. A user can add or remove 
services from applications to save space and make it easier to find a particular service.

Follow these steps to remove services from an application. (The steps below refer to 
removing steps from the Customers Service, but they can be applied to any desired service).

1. In the Navigation Bar, click the arrow to the right of Home 

2. From the Application list that displays in the Navigation Bar, select Customers 

3. From the pop-up list, right click the Customers heading and select Services....

• The Services dialog displays. The services that currently appear in the Folder List 
are listed in the right-hand column.

4. Do one of the following to move the Education service to the right-hand column:

• Double-click the Education entry.

• Click once to highlight the Education entry and click the >> button.

5. Repeat the previous step to move the Functions services to the right-hand column.

6. Click OK.
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Working with Shortcuts
Shortcuts are one of the most critical areas for end users to utilize to quickly navigate to 
desired data. Shortcuts enable users to instantly open a service or view. Shortcuts should be 
created and loaded as part of a profile, but there will be the need to include additional 
Shortcut Groups and Shortcuts by end users. 

Follow the steps below to add a Shortcut Group and then a Shortcut itself.

Creating a Shortcut Group for Views of data

1. Right click the Shortcut Bar (under the Services group) to activate the area.

• (Shortcuts to Services is the top level group on the Shortcuts bar to the left.

• Users can add as many Shortcuts to Views and Shortcut Groups as desired.

2. From the pop-up list, select Add Group.

3. In the Name field, enter My Views

4. Click OK- the new group appears at the bottom of the Shortcuts area. 

5. Drag the My Shortcuts Group to the top of the page under the Services Shortcut Group.
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Adding a Shortcut

1. On the left side of the screen, from the Services shortcut group, click the Persons Ser-
vice.

2. All the Persons Views and folders will display on the right.

3. Double click ANY existing View - the View will run - if a prompt displays, click on the 
cancel button. Notice that the View’s name will also display in the top Navigation Bar.

4. Click on the My Views shortcut group heading created earlier. (Once selected, it will 
have a selection rectangle). Users MUST select the targeted shortcut group prior to 
selecting the shortcut to be added.

• It may contract - click again to expand

5. In the Navigation Bar, right click the displayed View name.

6. Select Add to Shortcut Bar. Note the addition of the view name under the shortcut 
group. Repeat to add another view to the My Shortcuts.
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Removing a Shortcut

1. In the My Views shortcut group, right click the shortcut view.

2. From the pop-up list, select Remove Item.

3. Click OK to confirm the deletion.

Removing a Shortcut Group

1. Right click any shortcut Group.

2. From the pop-up list, observe the Remove Group but do NOT remove the group just 
created. 

Note: For the transfer of large numbers of shortcuts into a shortcut group, users can open the 
Folder List and drag and drop the shortcut into the desired group. This may be more 
effective when transferring a large number of shortcuts from a newly connected to 
Shared Folder.

Removing a Shortcut Group also removes the shortcuts in that group.
1.20 Aptify End User Training Manual



Aptify Basics Exception Log
Exception Log

If a problem occurs while using Aptify, the system can record information about the error 
encountered in the Session Exceptions viewer; this is found by clicking the Aptify Button 
and selecting this option from the drop-down list, (bottom right).

This information can be very helpful in aiding an administrator to determine what caused the 
error.

Users can track session errors as they occur by leaving the Session Exceptions viewer open 
on the desktop, with the Auto Refresh option selected. With this setting, errors are automati-
cally added to the Session Exceptions viewer. 

When the Manual Refresh option is selected, new errors do not appear while the viewer is 
open until the user clicks the Refresh button. 

To ensure the Sessions Exceptions viewer remains in the foreground of the desktop, click the 
pin icon. When Auto Refresh is selected and the viewer is pinned to the desktop, users can 
easily monitor whenever a new error is logged.
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Most Recently Used Records/Views

Aptify's main dashboard includes the Most Recently Used dashboard component which 
provides a quick and easy method to access records/views that are used on a regular basis. 
This component displays a list of Records and a list of Views that a user recently opened or 
updated and can display up to 50 items. 

Simply double-click an entry in the Most Recently Used Records window to open the corre-
sponding record or view.
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Objective

In this chapter, users will understand how to:

• Read a Record Form

• Create a Companies Record

• Create a Persons Record

Membership Based Records

Aptify recognizes that for most clients, Companies, and Persons records will be the most 
frequently entered and interacted with records in the database. For some clients, Aptify’s 
naming convention will be an adjustment - Companies and Persons, may not equate to what a 
client knows as Customers or Member records. For others, it will be the fact that the Aptify 
Database will track ALL TYPES of Companies and Persons, not just Members. 

Below are a few basic definitions according to Aptify:

Companies — The businesses with whom the organization (Client) has a business 
relationship. These companies can be customers, vendors, maintenance contractors, etc. They 
are the businesses that need to be tracked for various reasons. 

Persons — People with whom the organization/association (Client) has a relationship, for 
example, association members. Most notably these would encompass members, who the user 
tracks membership related data; these can include vendors, hotels, POCs, etc. 
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Reading a Record Form

A record refers to a specific group of data in Aptify, while a record’s form is the display of 
that data. All record forms share many common features.

The basic layout of a form includes:

• Service Name and Record ID — Displays the record’s service and ID number.

• Data Control Bar — Located at the top of the form; is used for saving, closing, printing 
and launching functions such as wizards.

• Link Box — Multi-function field that can:

1. Create a blank record for the linked service

2. Link to an existing record (by multiple search parameters)

3. Open the record listed in the field

4. Enable the user to search for records in the linked service

• Tabs — Contain additional fields or views of data.
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Record Button Bar & Shortcut Keystrokes

Aptify Records contain the same button bar regardless of the type of record accessed. The 
standard button bar and its functions are shown below:

Keyboard Shortcuts exist throughout Aptify. 

Commonly used shortcut keystrokes:

New Record - Ctrl + N

Save Record - Ctrl + S 

Save and Close - Ctrl + Shift + S

Save and Create - Ctrl + N

Print Record - Ctrl + P

Find Record - Ctrl + F

Record History - Ctrl + R

Help - F1

Refresh - F5
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Creating a New Person and Companies Record

For Training purposes, students/users in the Aptify End User class will create two records: a 
Company and Persons record. These records will be referenced and built upon for the 
remainder of the class and use of this class/manual.

The New Persons Wizard is used to enter this information. Users can directly enter infor-
mation into a record, but it is recommended they use/have wizards created for ease of entry.

Contact Information

1. In the Navigation tool bar, click the Customers Application.

2. On the Customers Dashboard, click the New Person Wizard button.

3. Users will enter information to create a new person record. Note that the default is a busi-
ness address.

4. In the Name field, enter a <fictional person name>.

5. In the Line One Address for this person, enter any address

6. In the Zip Code field, enter a familiar Zip Code, click the Tab button.

• Completing the Zip Code field auto-fills the City, State, and County fields

• Zip Code will take International Postal Codes where available.

7. Click the Next button.
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Company Information

1. Click the blue Primary Company link.

• Clicking a blank, linked field opens a new record for the associated service

• Users can do this when a new, unique record is needed and not a link to an exist-
ing one.

2. In the Name field, enter a unique <Company Name>.

3. In the Line 1 field, enter a unique <Line One address> as the company’s main address.

4. In the Zip Code field, enter a unique Zip Code.

5. Enter a Main Phone number.

• For Phone & Fax numbers,: the 1st field is the Country Code (1 for the U.S.), the 
2nd field is the three-digit area code, and the 3rd field is the seven-digit number.

• Use the Phone drop-down list to toggle between the phone and fax numbers.
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Adding New Addresses

For reference with the following exercises, turn to page 2.10 to see a summary of the Address 
Tool Bar.

1. To add additional addresses associated with the business, click the Add New Address 
button located next to the address drop-down list.

2. In the Enter the new name for the address field, enter Supply Warehouse.

3. Click OK.

4. A blank Contact area of the Companies record is returned.

5. In the Address Line 1 field, enter 4565 Leland Ave. 

6. In the ZIP Code field, enter 95842, click Tab, city and state will auto-fill.

7. Select the Details tab.

8. From the Credit Status drop-down list, select Approved.

9. In the Credit Limit field, enter 10,000.

10. Save and Close the Companies record (tab, top left).

• Note that the Company name now appears in the Primary Company linked 
field of the wizard.
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• (Steps above could have been written into the wizard as well).

Other tabs will become available once the record is saved. Users will investigate 
these tabs progressing through the remainder of the class/manual.

11. Click the Next button of the Wizard.

Title and Function Info

Now that a company record is created and a person record is associated with it, a user can 
specify more information about the person.

1. In the Title field, enter Customer Service Representative.

2. In the Primary Function field, enter Customer Support.

3. Scroll down, check the Sales checkbox below; this designates Sales as an additional func-
tion.

4. Click the Next button.

5. Sampco should default into the Organization field.

6. In the Referred By field, enter a 1 and click Tab (Aiesha Baldwin will auto-fill).

7. From the Referral Type drop-down, choose Friend.

8. From the Credit field drop-down, select Approved.

9. In the Amount field, enter 5000, click Tab.

10. Click the Finish button.
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11. From the Wizard pop up box, click the No button (to not repeat process).

12. In the Navigation Bar, click Home 

13. Above the Recent Customer Records column, click the Most Recently Used Views.

14. Click back on the Most Recently Used Records.

15. The new Persons record will be listed.

16. Click the Persons record to open it.

17. Note the company information associated with this person is shown, and by clicking on 
the address field drop-down, one can see the additional address criteria as well.
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Adding New Addresses

For the Persons record, the Contact tab is the default. A users’ Companies Address is 
automatically used as the Business Address. To add a person’s home address:

1. From the address drop-down list, choose Home Address.

2. For the Person, enter a new <home address>.

3. This Persons record will now have two different addresses configured, the Pref. Mail 
Addr. which is the Business Address and the home address.

4. Click Save button (top left). Once the record is saved, a check mark will appear next to 
address types that have an associated record.

5. To add an additional address for example, a persons’ vacation address during a certain 
time frame, click the Add New Address button.

6. In the Enter the new name for the address field, enter Vacation.

7. Click OK.

8. In the Address Line 1 field, enter 47 Truman Annex Circle.

9. In the ZIP Code field, enter 33040, click Tab.

10. In the address tool bar, click the Setup Default Address and Date Ranges button.

11. From the Address box, (seen below) setting column drop-down list, select Date Range.

12. Enter a Start Date of 12/17/20xx. (xx is current year)

13. Enter an End Date of 12/28/20xx.

14. Click OK and Save and close the record.
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Address Bar

The Addresses tool bar allows users to manage address additions and deletions.

The Contact tab of a Companies or Persons form can stores all the addresses for a company or 
person. The addresses are available when selecting a Ship To or Bill To address on an Orders 
form.

The Company Address record includes an Address Type field, which links to the Address 
Types service. An administrator can add or edit Address Types as necessary from the Admin-
istration -  CRM application.

If the address is temporary, users can enter a Start and End Date to indicate a time frame for 
when this address is valid.

Also, users can place a check mark in the Use As Preferred During Date Range box to 
indicate that this is the address to use for the Company during the time period specified. 
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Bad Addresses

Users can label an Address as a Bad Address by utilizing the Bad Address checkbox in the 
Address section of a Persons record.

Users can then create Views of records with designated bad addresses and call/email those 
users for corrections.
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Organizations and Employees Records

The Organization Management application uses Organizations and Employees records to 
store information about the internal structure of both the user’s organization and its 
employees. 

The Organizations and Employees records do NOT store external customer information. This 
is contained in the Customers Application as Companies and Persons records.

First time users of Aptify often confuse Organizations with Companies and Employees with 
Persons. Most end users of Aptify will NOT need to access either Organizations or 
Employees; those areas will usually only be accessed by IT and Accounting for initial entry, 
and HR for occasional maintenance.

Employee Records will be set up initially in the database by Administrators. Admins will 
then use the Aptify User Administration Wizard to link the appropriate Licenses, Profile, 
Security, and Employee record together. This structure will then create an audit trail where the 
employees actions are tracked throughout their use of the system.

For the purposes of standard End User training, each user in class will be known as 
Baseline User.
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Organization Accounting

Aptify enables users to track the General Ledger (GL) entries for Accounting via the 
Organizational structure that is set up during the user’s configuration. When an Organization 
(i.e. the company that is buying and will be using the Aptify software) is set up, that company 
becomes the parent organization of all GL entries. This setup enables standard accounting 
or multi-entity accounting.

Multi-Entity Accounting

Aptify can create GL entries to segregate funds as necessary between a parent organi-
zation and its subsidiaries.

• For example, an association may run a Foundation, which is a separate business entity, 
so the organization would use multi-entity accounting to ensure that the funds are associ-
ated with the proper entity.

• A user specifies “Due To” and “Due From” GL accounts to establish debits and credits 
accounts between a parent organization and one or more subsidiaries. This is for account-
ing purposes only and does not affect orders or payments from customers.

Setting Up an Organization’s Multi-Entity Accounting

1. Create the Organization and its subsidiaries (as needed).

2. Enable the Generate Inter-Company Entries option on each entity’s Accounting tab.
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3. Establish GL Accounts between a parent organization and a subsidiary:

Two sets of accounts

• From parent organization perspective, “Parent Due to Subsidiary” and “Par-
ent Due from Subsidiary” 

• From subsidiary perspective, “Subsidiary Due to Parent” and “Subsidiary 
Due from Parent”

4. Add these accounts to each Organization’s Inter-Company GL Accounts tab.

• For example, a user would add the “Parent Due to Subsidiary” and “Parent Due 
from Subsidiary” to the Parent record.

5. Specify organization-specific A/R and Sales accounts for products linked to that parent/
subsidiary.

6. Create Payment types that use organization-specific Cash account.

7. Aptify automatically generates GL entries between organizations as necessary.

• In this example, a customer purchases a subsidiary product from the parent organization, 
so GL entries are created to specify how the payment should be accounted for between 
the entities.
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Objective

In this chapter, users will learn how to:

• Work with records

• Resolve Record Conflicts

• Duplicate records using multiple methods
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Finding Records

In this section, users will utilize the Find Items function to locate records in a service.

1. In the top tool bar, right click the Persons service and select Find Items... from the list. 
The Find Items dialog box will appear.

• The Find Items dialog box can also be opened by clicking the binoculars button 
in the Services or View toolbar. Locate the binoculars button.

2. From the Find-Persons box, click on the blue field labeled Persons search. This will 
bring up a box with additional filters for selection.

3. From the Field drop-down list, scroll down to select Company Name.

4. From the Operator drop-down list, select Contains.

5. In the Value field, enter danube.

6. Click Find.

• A new View window appears that displays the records whose company contains 
the word danube.

• A record from this window can be opened by double-clicking it.
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7. From the results of this find, click the Find Items button (binoculars) to open a new Find 
Items window.

8. Under the column headings, on the first line, in the Field column, enter Company Name; 
in the Operator column, enter Contains; and in the Value column, enter danube.

9. On the second line, in the Field column, enter First Name; in the Operator field, enter 
Exactly Matches; in the Value view, enter jessica.

• Search lines in the Find Items dialog are separated by AND operators.

10. Click Find.

• Aptify displays the Persons record for Jessica Rodriquez. Aptify displays the 
record itself rather than a results screen since only one record fulfilled the search 
criteria entered.

11. Close the view.
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Reviewing Record History

In this exercise, a user will use Record History to view previous versions of a record.

1. Open the Persons record, if not already opened.

2. At the bottom of the form, change the Phone drop-down from Phone to Fax.

3. In the Fax field, enter 1 212 555-5555.

• In the first Fax field (Country Code), enter 1.

• In the second Fax field (Area Code), enter 212.

• In the third Fax field (Phone Number), enter 555-5555.

4. Click Save.

5. Change the Fax number from 555-5555 to 123-4567.

6. Click Save.

7. In the record’s toolbar, click the Record History button.

8. Observe the Record History window that displays.

9. Resize the columns of the Record History window as needed to display additional 
information.

• Move the cursor between a column header until it becomes a left/right arrow. 

• Hold down the mouse button and drag the cursor left or right to expand the width 
of the columns.
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10. In the top field, notice the version of the record that shows the original fax number 
entered (555-5555).

11. IF users had Admin privileges, the Restore button would be active. This would create a 
new version of the record that resets it to the previous version. In other words, this pro-
cess reverts the Fax field to 555-5555.

12. Click Yes to continue.

13. Otherwise, click Close to close the Record History window.

14. Close persons the record.
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Viewing Dependencies

In this section, users will learn how to View Dependencies- records that contain information 
that are dependent, or related to, another. 

In the top Navigation tool bar, right click Persons service and select Find Items.

15. To open Persons record ID #268, enter 268.

16. Click the Show Dependencies button in the record’s data control bar.

17. Observe the Persons Record Dependencies window that displays. 

• This window contains a list of all records, or dependencies, that reference the 
Persons record and require its information. The list includes multiple Orders, 
Payments, etc. Because dependencies must link to another record, Aptify will not 
allows users to delete any record that has dependencies. If a user attempts to 
delete a record with dependencies, the system will present an error message. For 
example, a company record with related persons records may not be deleted.

18. Close the Record Dependencies window.

19. Close the Persons record.

20. If prompted, click No to confirm closing the record without saving changes.
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Using the Conflict Wizard

Within Aptify, two users may work with the same record simultaneously. However, it is 
possible that the changes made by the users to the record may conflict with each other. 
Therefore, the Conflict Wizard will launch automatically whenever one user attempts to save 
a record that has been modified by another user since the form was opened.

The first screen of the Conflict Wizard lists the changes that user2 made to the record since it 
was opened by user1.

On this screen, user1 can click Next to continue or Cancel to close the wizard and return to 
the form without saving the changes by user2.

The second screen of the Conflict Wizard lists the changes that user1 has made to the record. 
On this screen user1can click Next to continue, Back to return to the previous screen, or 
Cancel to close the wizard and return to the form without saving changes by user1.

The third screen of the wizard gives user1 three options for resolving the conflict:
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1. Save changes by user1 and integrate the changes from the other users that do not conflict 
with the changes user1 has made.

2. Save user1’s changes and override all of the changes made by other users.

3. Do not save user1’s changes and keep the changes made by the other users. If this option 
is selected, user1’s changes are still displayed in the form but they are not saved to the 
record. (User1 will need to close the record without saving.)

Click Finish after one of these three options is selected. Back can also be clicked to return to 
the previous screen, or Cancel to close the wizard without making any changes.
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Resolving Duplicate Records

An organization can customize Aptify to check for possible duplicates when users save 
new records. This helps avoid a situation where the same person has multiple records 
within the system.

By default, Aptify provides a duplicate checking component for the Persons service. This is 
provided for demonstration purposes so an organization’s developers can create their own 
duplicate-checking components as necessary. 

When a message is received about a possible duplicate, choose one of the following options:

1. Yes: Click Yes to view the record or records that may be duplicates of the record a user is 
attempting to save. If only one potential duplicate exists, the matching record will open. 
If more than one duplicate exists, Aptify will display a view that lists the matching 
records.

2. No: Click No to save the new record without seeing the potential match.

3. Cancel: Click Cancel to return to the record without saving. 

If duplicate records exist, a user can merge them into single record

• A user can specify which record and which fields should survive the merging process

• Any dependent records are automatically linked to the surviving record

• A user may not have the ability to merge records, since this is often configured by a sys-
tem administrator

• Can vary from service to service and from user to user
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Merging Records

1. Follow these steps to merge records:

1. Create a view that contains all of the records that a user wants to merge.

2. Select the records to merge (hold down the CTRL key to select multiple records).

3. Right click within the view and from the pop-up list, select Merge Records.

4. If there are additional records to include in this merge, click Add Record and use the 
Find Items utility to locate them (one at a time).

5. To remove a record from merge, highlight the record’s column & click Remove Record.

6. By default, the Merge Tool only shows the fields that have different values across the 
records selected. To show all of the fields in the record, click the Show All Fields button.

7. Determine which record to keep. The other records will merge with the record selected. 
To select the record (also referred to as the default record), highlight the record’s column, 
right click and choose Set Record as Default from the pop-up list.

8. Determine which field values desired. To select a field value in a record other than the 
default record, place the cursor in that field and right click. Then, select Set Field as 
Default from the pop-up list. The field will appear with a yellow highlight (within the 
Merge Tool; items that will persist in the merge record are highlighted in yellow).

9. When ready to merge the records, click Merge.

10. Click OK to begin the Merge process.

11. Click OK to commit the Merge results to the system.
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Cloning Records

• Makes a copy of an existing record

• Useful if a user needs to create multiple records that share many of the same values

• Reduces data input time and can increase accuracy

To clone a record:

1. Open an existing desired record to clone.

2. From the Data Control Bar, click the Clone button.

3. The new, clone of the original record will open. Make the desired edits and Save.
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Save As Pending

Sometimes it is beneficial to be able to make certain changes to records that take effect at a 
future date. For example, a company is moving locations and will have a new address as of 
the beginning of next year. The Save As Pending option saves the record as pending, allowing 
a user to modify records prior to a specific date, and then applies those changes automatically 
on the scheduled date. When a pending change exists, it automatically enables the Alerts 
button prompting the user that there are pending changes on this record. A user can also edit 
and delete pending changes as necessary.

Saving Changes as Pending

Follow these steps to save changes to a record that should be applied on a specific date in the 
future:

1. Open the Persons record created previously. (Double click Home, go to Recently used 
records column, find persons record created)

2. Change the Street Address.

3. In the toolbar, select the Save As Pending button.

4. In the Scheduled Date drop-down, select a month from today.

• The default value is the current date and time.

5. Click the OK button to close the dialog. 

• The form repopulates with the currently saved data (the pending changes are 
removed since they are not applicable yet).

• The Alerts icon turns red to notify all users that pending changes exist for record. 

6. After the pending change’s specified date and time passes, the Aptify Scheduled Tasks 
system automatically updates the record with the appropriate changes. Once the pending 
changes have been saved to the record, the Alerts icon no longer appears in red.
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Modifying Pending Changes

Follow these steps to modify changes that have been saved as pending:

1. Select the Alerts button.

• When a pending change exists for a record, the Alerts button becomes active, 
notifying the user that there are pending changes on this record.

2. Expand the Pending Changes hierarchy by selecting the plus sign (+).

3. Double-click the pending change to be modified to open the associated Alert Detail dia-
log. This enables the user to see information about pending changes applied to the record.

4. Click the Edit button.

• The record is refreshed with the pending changes specified in the Alert Detail 
Dialog.

5. Change the Address to 1000 Northwest Union Avenue and select Save As Pending.

• Even if a user decides not to make any modifications to the existing pending 
change, they still need to select the Save As Pending option to reset the Sched-
uled Date.

Note: the modified changes can be viewed by selecting the corresponding change from the 
Alert List. Follow these steps:

• Select the Alerts button.

• Expand the Pending Changes hierarchy by selecting the plus sign (+).

• Double-click the appropriate pending change to view the modified changes.
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Deleting Pending Changes

Follow these steps to delete a pending change:

1. Select the Alerts button.

• When a pending change exists for a record, the Alerts button becomes active 
prompting the user that there are pending changes on this record.

2. Expand the Pending Changes hierarchy by selecting the plus sign (+).

3. Double-click the appropriate pending change to view the modified changes.

4. Click the Delete button.
3.14 Aptify End User Training Manual



Chapter 
 4 Working with Views

Objective......................................................................................................................... 4.2

Understanding Views...................................................................................................... 4.2

Creating List Views ........................................................................................................ 4.3

Using View Filters .......................................................................................................... 4.4

Editing View Fields ........................................................................................................ 4.5

Sorting Data in Views..................................................................................................... 4.7

View Formatting ............................................................................................................. 4.8

Hierarchical Viewing...................................................................................................... 4.9

View Paging.................................................................................................................... 4.10

Auto Refresh................................................................................................................... 4.11

Scheduling Views ........................................................................................................... 4.12

Advanced View Filters ................................................................................................... 4.14

Creating Prompted Views............................................................................................... 4.18

Using the Between Operator........................................................................................... 4.22

Utilizing Base Views ...................................................................................................... 4.25

Copying & Editing Existing Views ................................................................................ 4.27

Grouping Data in Views ................................................................................................. 4.29

Preview Pane .................................................................................................................. 4.32

Composing a Bulk Message ........................................................................................... 4.34

Topic Codes .................................................................................................................... 4.37

Creating View Templates................................................................................................ 4.39

Creating a Chart View .................................................................................................... 4.42

Creating a Calendar View............................................................................................... 4.46

Pivot Tables .................................................................................................................... 4.49

Managing and Sharing Views......................................................................................... 4.50

Connecting to Shared Folders and Views....................................................................... 4.51
4.1



Objective Working with Views
Objective

In this chapter, users will learn how to:

• Create and Edit Views

• Sort and Arrange Views

• Understand different types of Views 

• Compose Bulk Messages

• Manage Views

Understanding Views

Views are the most critical function for finding and communicating data in Aptify. Views are 
similar to reports, in that they display a subset of data, but unlike reports, views allow users to 
open records and work with the data. 

They are the function most interacted with in the database as well. Views are spread 
throughout all of Aptify and every Service in Aptify will have multiple Views pulling from it. 

Any view that is valuable to a user should be embedded as part of their dashboard and/or 
saved as a shortcut. If a view is used daily for a user to see large portions of data, it belongs in 
a dashboard. If used interactively to find data daily/weekly, it should be made a shortcut.

Views are organized displays of data that represent subsets of the records contained in a 
Service. A user defines filters which define the data displayed in the view. Once created, 
views can be saved within each user's profile and used again by selecting the view. 

Four Major View Types

List Views

• Most common used view in Aptify - approximately 90% of all Views are List Views

• Contains a list of records, formatted using columns and rows

Chart Views

• Excellent for inclusion in dashboards, especially at the Executive level

• Groups data based on specified criteria and displays as a chart or graph

Calendar Views

• Good for Meetings, Committees, Education, etc. that utilize date based functions.

• Organizes records using time data, and displays them on a calendar

Pivot Table Views

• Power view option that provides interactive reports to summarize large amounts of data

• Table information can be expanded or collapsed depending on the level of detail needed
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Creating List Views 

Follow these steps to create a List view: 

1. Select the Persons Service shortcut.

2. In the Navigation Bar, right click Persons and select Create View from the list.

3. Give the View a name or title. In the Name field, enter Persons in CA. (Give explicit 
description for others who might also use it).

• This exercise will create a View of Persons in CA

• Later in this chapter the exercise will add additional Filters and edit the name.

4. Leave List View selected from the View Type drop-down list.
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Using View Filters

Aptify lets users locate specific information within a database by filtering data to present in 
views. Filtered views will only show a view of data based on specific criteria. For example, a 
user could create a filtered view that displays only the following records:

Customers who work in the state of California.

Create a Basic Filtered View for Persons

1. On the Persons in CA view properties in progress, select the Filters tab to create data 
record filter criteria.

• Persons appears in the Service column by default. The Service column 
drop-down list shows a set of services that are linked to the selected service. 

2. From the Field column drop-down list, select State:

• First, click in the Field column. A drop-down arrow appears.

• Start typing State. After entering a few letters, the field will fill in automatically.

3. From the Operator column drop-down list, select Exactly Matches.

4. In the Value column field, enter CA.

• The State field uses the two-letter abbreviation.

5. Click OK to show the view created. 

NOTE: Even though the Field designation above reads “State”, it actually is pulling the 
Work State of the Person. Work State, because it is the default value on the Persons form, is 
only indicated by the text, “State”.

A Persons record’s Home State would be designated by the text, “Home State”. 

Add to Shortcuts Bar:

To add this view to the user’s shortcut bar, click on the “My Shortcuts” bar to activate it, then 
from the top Navigation bar, right click the Persons in CA and select Add to Shortcuts Bar
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Editing View Fields

This exercise illustrates how to select which fields display in a view, how to rename a view’s 
field headings, and how to change the order in which fields appear. By default, views display 
a list of selected fields. Users can customize which fields a view displays using the Fields tab 
in the view’s properties screen.

1. From a selected view, on the View button bar, click the Properties button, then select the 
Fields tab.

2. In the Selected Fields column, select from Address Line 1 to Primary Function.

• Hold down the CTRL key to select multiple, separated fields in the list.

• Hold down the Shift key to select multiple, contiguous fields in the list.

3. Double-Click on the selected fields, or use the left facing arrow, to move them to the 
Available Fields column.

4. Scroll through the Available Fields column values to the Department field.

• Tip: clicking the ‘Field’ column heading in the Available Fields area will sort the 
displayed fields in alphabetical order.

5. Double-click Department to move it to the Selected Fields column. 

6. Use the Up arrow on the right side to move Department below the Company field.

• When the View is displayed, the selected fields will display left to right as the 
Column Values.
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7. In the Selected Fields column, use the scroll bar to view the Display Name column, then 
click in the row for MemberType to edit its Display Name.

8. Enter Membership in the field provided.

• Click OK. Once the View is displayed (OK clicked), Membership will display as 
the column header, not MemberType.
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Sorting Data in Views

Within a view’s properties’ screen, users can specify multiple sorting criteria.

1. From the Persons in CA view, on the View button bar, click the Properties button. Select 
the Sorting tab.

2. From the Sort By field’s drop-down list, select Member Type.

• Leave the Direction set to Ascending.

3. In the first Then By field, select Company. (Select the CompanyName or Company field 
from the drop-down list rather than the CompanyID field. Set Direction to Descending 
for this field.

4. In the second Then By field, select LastName. Set Direction to Descending for this 
field.

5. Click OK to save the changes to see the modified view on the screen.

6. Scroll through records displayed in view and confirm that records are sorted as specified.

• Corporate Members are listed before Individual Members, who are listed before 
Non-Members. Within each Member Type, companies are listed in reverse alpha-
betical order. For each company, persons are listed in reverse alphabetical order. 
Note that setting the sort order within a view by selecting a column and clicking 
the Sort Ascending or Sort Descending button will override the sorting order 
specified in the View Properties screen.

• WARNING - If a user chooses to change a Views sort by clicking on a column in 
the display of the View (after clicking OK), that sort will OVERRIDE the previ-
ous sort designated under the Sort tab.
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View Formatting

Aptify enables users to change many aspects of how Views results look. Users can change the 
text’s size, font type, color, bolding, underlining, and italicizing.

1. From the view, on the View button bar, click the Properties button.

2. Select the Format tab.

3. Place a check mark in the Use Custom Formatting for this View box to display the 
formatting options.

4. Select the Row Color sub-tab.

5. Click the ellipsis (...) button next to Alternate Color.

6. Select a desired color as the alternate color.

7. When displayed, the View will have alternating colors which will enable the rows to be 
distinguished more easily.
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Hierarchical Viewing

Aptify has a powerful feature called hierarchical viewing. This feature enables users to drill 
into subsets of data directly through the view results set. Users can select what subsets of data 
they want to drill into through the Hierarchy tab. To set up this feature:

1. On the View button bar, click the Properties button, then select the Hierarchy tab.

• Aptify provides numerous hierarchial choices and multiple subsets of data which 
can be selected. 

2. Select the first of the four Orders listed by scrolling down the list and selecting the 
checkbox next to it.

3. Click OK.

• The view results return; in the far left-hand column, when the cursor is over a 
record a + sign displays; this indicates the record can be selected and its associ-
ated orders displayed

4. Move the cursor along the far left-hand column to see + signs appear for each record. 
Move to a record and click the + sign in the left-hand column.

5. The Orders results frame will display.

6. Minimize the Orders data by clicking the minus (-) signs.

7. Observe the other changes made to the View thus far: Filters, Fields, Sorting, and For-
matting.
Aptify End User Training Manual 4.9



View Paging Working with Views
View Paging

The View Paging settings determine how many records appear on one screen at a time. 
Follow the steps below to configure View Paging.

1. Reopen the Persons in CA View.

• On the View button bar, click the Properties button.

• OR From the display list, right click on the View and select Views Properties 
(near bottom of list).

2. Click OK and look in the bottom right-hand corner of the screen. A number should dis-
play for the amount of records in the view page.

3. Multiple pages of results should display. Users can control how many pages the view will 
return by setting up paging preferences.

4. Open the View Properties. 

5. Select the Paging tab. 

6. Notice the default is to allow for paging with 250 results per page. Change the number of 
results per page to 50. 

7. Click OK. The user should now have more pages of results.

As a rule, most users should NOT change the number of results displayed per page. This 
function can be tied by administrators to a Record Set Query as well whereby users will be 
limited in the actual number of records they can return overall. For instance, if a user with a 
pre-set, Record Set Query amount of 500 tries to return a View of 1000+ records, they will 
only receive the first 500 of the records in two, 250 results filled pages. 
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Auto Refresh

Users can set how frequently they want the system to refresh the view’s results. This is 
helpful when they need to keep a view open for long time periods and there is a lot of activity 
that will change the results over time. This function should be combined with opening the 
view in a separate window (right click in the Navigation Bar on the View). 

1. Re-open Persons in CA. In the View button bar, click the Properties button, then select 
the Auto Refresh tab. 

2. Change the Auto Refresh Mode drop-down from None to Interval Based.

• When the mode is changed to Interval Based, an Interval (Minutes) field appears 
that can be changed to specify how often the view is refreshed. 

3. Change the interval to 1 minute and check the Show Refresh Interval Timer on View 
box. This will enable a viewable countdown until the next auto refresh in the lower left-
hand section of the view page. 

4. Click the OK button to return to the view results and note the timer at bottom left.
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Scheduling Views

Users can schedule a view to automatically output its information once or on a recurring 
basis. When the view runs, Aptify can save the view as an Excel file or a Crystal Report and 
then print it on a network printer, or send it to multiple recipients as an email attachment. 

For example, a sales manager can create a view that displays all orders taken that day. 
Then, they can schedule the view to run nightly and send the results to the sales 
department in an email message. 

1. On the View button bar, click the Properties button.

2. Select the Scheduling tab.

3. In the Schedule This View To Run Automatically box, place a check mark.

4. For the Frequency Type, enter Weekly. 

5. Select the Output Options tab.
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6. In the Output Modes drop-down, leave Email selected.

7. From the Message Systems field, enter Outlook Email 

8. Observe the Output Types (click the arrow to see options), but keep View as option.

9. Resize the View Properties window to full screen, and from that screen’s toolbar, under-
neath the Recipients button, click the New Record button.

10. Observe the Available fields, then click Cancel.

11. Select the Email Properties sub-tab; observe the available fields.

12. Select the Advanced Scheduling tab.

13. Users can set the View to run on a separate Application Server to reduce the processing 
load on the main server.

14. Click Cancel.
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Advanced View Filters

Create a View with Two Filters

1. From the top Navigation Bar, right click Persons in CA, select Properties (or Properties 
button, if open).

2. Edit the Name and Description fields to read: San Francisco Student Members 

• If Persons in CA was previously made a Shortcut, the user must delete that 
shortcut since the parameters have changed, and add the new San Francisco Stu-
dent Members as a shortcut.

3. Click the Filters button.

4. Keep Persons as the Service and the rest of the first row of the Filters dialog.

5. For the second row, keep Persons as the Service, from the Field drop-down list, select 
Member Type.

• Quickly type “Mem” to jump to the Member Type field

• Or click the Field column header to sort alphabetically, scroll to Member Type

NOTE: The first Member Type that displays is the numeric value, referring to the mem-
ber type record’s ID. For this exercise, scroll down to the text value. This enables the 
filter to use the actual name of the member type,“Student”. Aptify recommends using 
the ID whenever possible to reduce search time.

6. From the Operator drop-down list, select Exactly Matches.

7. From the Value drop-down, select Student Member.

8. Third row: Persons is the Service, for Field, select City

9. From the Operator drop-down, select Exactly Matches

10. From the Value drop-down, select San Francisco.

11. Click OK to return to display the View. Note the fields listing student members.
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Editing Filter Logic

Users can also create Views that use an OR operator so the view can display records where, 
for example, State is CA or Last Name begins with D.

1. Either from the view, select the Properties tab, OR from the top Navigation Bar, right 
click the San Francisco Student Members view and select View Properties.

2. Select the Filters tab.

3. Click the Show Advanced button.

• The Filter Logic box reads: 1 AND 2 AND 3.

4. Change the second AND to OR so the Filter Logic reads: 1 AND 2 OR 3.

5. Click OK to display the view.

6. Enter the number of records that appear in the view: ____ (see bottom right).

7. From the San Francisco Student Members view, select Properties.

8. Select the Filters tab to return to the View’s Filters screen.

9. Click the Show Advanced button.

10. Click the Reset Filter Logic button.

• The Reset Filter Logic button returns the logic to its default settings.

• The Filter Logic changes to 1 AND 2 AND 3 (since AND is the default operator).

11. Click Cancel to return to the Aptify desktop.

12. Close the view.
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Using the In-List Operator

1. From the Navigation bar, right click the Persons service and select Create View.

2. In the Name field, enter In List.

3. Click Filters.

4. From the Field Column drop-down list, select State.

5. From the Operator drop-down list, select In List.

6. To the Value field, enter Illinois, Massachusetts, Oregon, and Pennsylvania using one of 
the following methods:

• Manually enter the list of states; separate each state with a comma: 
IL, MA, OR, PA

• For fields that have pre-defined values, a user can click the ellipsis (...) button 
and select the items to include from the list of possible values.

7. Click OK to return the view display.

8. From the “In List” view, click Properties. Click Filters.

9. From the Service drop-down list, select Persons in the second row of the Filters dialog.

10. From the Field drop-down list, select ID.

11. From the Operator drop-down list, select > (greater than).

12. In the Value field, enter 100.

13. Click OK to generate the View on the Aptify desktop.

14. The view now displays the Persons records whose State is IL, MA, OR, or PA and whose 
record ID is greater than 100.
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Using the Proximity Operator

1. From the top Navigation Bar, right click the Persons service and select Create View.

2. In the Name field, enter Proximity of within 50 mi of 20006.

3. Click Filters.

4. Keep Persons as the Service.

5. From the Field drop-down list, select Zip Code (text).

6. From the Operator drop-down list, select Proximity.

7. Move the cursor over the Value field, and click the down arrow that appears. It becomes 
an ellipsis. (...) Click the ellipsis.

8. The Proximity Search Wizard displays.

9. Click Next at the introduction screen.

10. In the Postal Code field, enter 20006.

11. Click Next.

12. Keep the Closer or Exact Distance radio button selected.

13. In the Distance From Postal Code field, Enter 50.

14. Click Next.

15. Click Finish. 

16. Click OK and view the results.

NOTE: There is an example of a Proximity Prompt view built into the Baseline Users 
shortcuts. If a user clicks on this view (located under Customer/Member Searches shortcut 
Group), they will be able to enter the desired zip code into the prompt. However, this prompt 
is based on SQL written directly in the SQL tab of that prompted View and can only be edited 
by an advanced user. Therefore the settings are static for that prompted view at 50 miles 
from the center of the zip. 

New Postal Codes CAN be added for international use.
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Creating Prompted Views

The most valuable type of everyday use View a user can create is a Multi-prompt view. Multi 
prompted views enable users to look up a record by multiple level’s of criteria from one 
interface. In the exercises that follow, users will first create a single prompt finding Persons 
from a particular Company to understand basic prompt construction. Then users will create a 
complicated multi-prompt view for finding Persons record(s) based on multiple possibilities.

Users logged in with a profile of Aptify Baseline User have available to them multiple 
prompted views already created under the pre-existing shortcuts on the left-hand side of the 
screen. Many have multiple prompts attached to them. Most are created using “OR” state-
ments in the filter logic so that the user may choose from only one selection. Users can easily 
integrate “OR” statements and even more complicated combinations of “ANDs”, “ORs”, or 
other SQL/boolean search characteristics.

Creating A Prompted View—Text Box

1. From the top Navigation Bar, right click the Persons service and select Create View.

2. In the Name field, enter Prompt for Company Name.

3. Click Filters.

4. From the Field drop-down list, select Company.

5. From the Operator drop-down list, select Begins With.

6. Click the Show Advanced button.

7. Click the Prompt Wizard button.

8. Leave Text Box selected and click Next.

9. Enter Company: as the Prompt Value

10. Enter <Company> as the Default Value
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11. Click Finish.

12. Click OK to return to the Aptify desktop. See prompt box.

13. In the Prompt box, enter Danube over the Default Value of <Company>.

14. Click OK.

15. Observe the displayed records in the view created as a result.

16. Refresh the view to bring up the Prompt box again.

• A view can be refreshed in four ways:

• Click F5.

• Click the Refresh button on the View Toolbar.

• Right click within the view and select Refresh from the pop-up list.

• Select a different view and then reselect the Prompt for Company view.

17. Enter Otto in the Prompt box and click OK.

18. Observe the displayed records.
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Creating A Multi-Prompted View

1. Reopen the Prompt for Company Name view just created.

2. Click the Name field and delete the current Name.

3. Enter Persons Search in the Name field as the new Name.

4. Click Filters.

5. Select the second, blank filter line Field (first, existent line will be for CompanyName).

6. From the Field drop-down list, select Name/Company.

7. From the Operator drop-down list, select Begins With.

8. Leave the Value field Blank.

9. Click the Show Advanced button.

10. Click the Prompt Wizard button.

11. Leave Text Box selected and click Next.

12. Enter First Name, Last Name as the Prompt Value

13. Enter <First, Last> as the Default Value, then click Finish.

14. Click in the third, blank filter line Field.

15. From the Field drop-down list, select ID.

16. From the Operator drop-down list, select “=”.

17. Leave the Value field Blank.

18. Click the Show Advanced button.

19. Click the Prompt Wizard button.

20. Leave Text Box selected and click Next.

21. Enter ID: as the Prompt Value

22. Enter 0 as the Default Value, then click Finish.

23. In the Filter Logic area, change each AND to an OR.

24. Click OK.

25. Attempt different values in each prompt to bring results.

NOTES:

• For text based prompts, always use Begins With as the Operator - This will 
ensure a more expedited search. Using Contains will search through an entire 
table and is NOT recommended.

• Always use default value for a prompt of the field name contained in Less Than 
and Greater Than symbols for Text based fields. 0 in Numeric based fields. This 
will ensure those values are skipped and the filled out value is searched for.
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Creating A Prompted View: Drop-down List

1. Click on Companies Service, then from the top Navigation Bar, right click the Compa-
nies service and select Create View.

2. In the Name field, enter List of States.

3. Click Filters.

4. From the Field drop-down list, select State.

5. From the Operator drop-down list, select Exactly Matches.

6. Click the Show Advanced button. Click the Prompt Wizard button.

7. Select drop-down and click Next.

8. Enter the values for the drop-down list in the fields provided.

• Click in the white field, Enter TX, NY, and DC, each, one per line.

9. Click Next to continue.

10. Enter TX as the default value.

11. Click Finish.

12. Click OK. Click OK when the Prompt box appears.

13. Observe the displayed records

14. Click the Refresh View icon.

15. When prompted, select NY from the drop-down list, click OK, view the records list.

16. Click on Persons Service, note the view names to the right, click on “List of states” and 
see the prompt.

The procedure for creating a List Box prompted view is identical to the 
procedure for creating the drop-down prompted view.
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Using the Between Operator

In Aptify, users can utilize the Between Operator to display results that exist between two 
dates or numbers. Between Operators can also be used in a Prompted deployment. This can 
be extremely helpful in creating views where date or numeric ranges for the results are 
variable.

Using the Between Operator on a set basis

Follow these steps to use the Between operator

1. From the top Navigation Bar, right click the Persons service and select Create View.

2. In the Name field, enter Member Join Date.

3. Select the Filters Tab.

4. In the Field column, enter Join Date.

5. In the Operator field, select Between.

6. In the Value field, click on the ellipsis (...).

7. In the Join Date From field, enter 1/1/2008.

8. In the To date field, enter 12/31/2008.

9. Click OK to close the Date Range box.

10. Click OK to run the view.

11. Observe the results of the View showing members who joined during the date range.
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Using the Between Operator with a Prompted View

Follow these steps to use the Between operator with a Prompted View:

1. From the top Navigation Bar, right click the Persons service and select Create View.

2. In the Name field, enter Member Join Date Prompt.

3. Select the Filters Tab.

4. In the Field column, select Member Type (make sure it is member type text).

5. In the Operator column, select Contains.

6. For the Value, create a Prompt text box as learned in previous exercises (Show 
Advanced Button),

7. On the second Filter line, in the Field column, enter Join Date.

8. As the Operator, select Between.

9. Leave the Value field blank.

10. Click the Prompt Wizard.

11. The Between Operator should default as checked.

12. Click Next.

13. In the Join Date From field, enter 1/1/2008.
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14. In the To date field, enter 12/31/2008.

15. Click the Finish button to close the Prompt Wizard box.

16. Click the OK button to run the view.

17. Enter Student in the Member Type Contains field.

18. Leave the Date fields as the default 2008 dates. These can be edited in the future.

19. Click the OK button.

20. Observe the results of the View.
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Utilizing Base Views

Base Views are pre-created views that combine fields from multiple services into one, 
selectable view setting. By selecting an existing Base View in a New View, users have access 
to the data and fields from the services designated in that Base View.

In the example below, users will select from a View of Persons the PersonsWithCommittees 
Base View. Users will consequently see four Services represented in the Fields tab and in the 
subsequent results when the View is run:

• Persons

• Committees

• Committee Terms

• Member Records

Base Views give users unlimited cross reference possibilities across the entire system. Once 
users develop a competency in Views, they can request that certain Base Views be built by 
System Administrators and be populated under various services as a Base View value when 
creating a new View.

1. From the top Navigation Bar, right click on the Persons service and select Create View.

2. In the Name field, enter Base View for Committees & Persons.

3. From the Base View field drop-down, select PersonsWithCommittees.

4. Click on the Fields tab.
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5. Expand the View and observe the Selected Fields area.

6. There are four Services represented in the Fields:

• NameWCompany - Persons Service

• TermTitle - Committee Terms Service

• TermRole - Term Member Service

• CommitteeName - Committee Service

7. Select the Filters tab - the same Fields are represented under the Filter Fields column.

8. Click the OK button

• This will run the View without Filters - users are normally encouraged to apply at 
least 1-2 Filters.

• This View can be modified/edited like any other List View.
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Copying & Editing Existing Views

Once familiar with the Viewing systems, users can start to edit/create more complex 
Prompted Views. For this exercise, users will open an existing prompted view, copy that 
view, and then edit it.

1. Under the Customer/Member Searches group shortcuts, click to run the Persons by 
Location shortcut. 

2. For the Prompt, select the Cancel button (note: the view is active).

3. On the Navigation Bar, right click the Persons by Location view.

4. Select Copy.

• This View is Read Only because it was made a shortcut from a Shared Folder.

• Users are copying the View in order to Edit.

• Discussion of the use of Shared Folders is in Ch. 5.

5. On the Navigation Bar, click on Persons, then right click on Persons.

6. From the list, select Paste View.

7. The displayed Views’ Name should now read: Copy of Persons by Location, Click 
Cancel on the displayed prompt.

8. Open the View Properties by:

• Clicking the Properties button in the View button bar

• or right clicking in the View and selecting View Properties

9. Select the Filters tab - observe the previously created filters.
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10. Click in the Field section of the last open row. (to add an additional filter)

11. From the drop-down, select Country.

12. From the Operator drop-down, select Exactly Matches.

13. Leave the Value field Blank.

14. To create a new prompt, click on the Show Advanced button.

15. Select the Prompt Wizard button.

16. Ensure that Text Box is checked.

17. Click the Next button.

18. From the Enter a Prompt Caption field, delete the words Exactly Matches.

19. In the Prompt Caption field, enter a Colon after the word, Country.

20. In the Default Value field, enter <Country>.

• By entering a default value between < > the user ensures that if that field is NOT 
used in the prompt, no value will be recognized.

• Because this uses OR in the Advanced Filter string, there must be a default value 
placeholder of <Country>.

21. Click the Finish button.

22. Change the last Filter logic parameter from AND to OR.

23. Click the OK button.

24. In the Country: prompt, enter Ireland.

25. Observe the results.
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Grouping Data in Views

Users can group records in a list view by common characteristics, and display a summary of 
the grouped records, which makes it easier to interpret and analyze data. For example, a user 
can group similar Orders records together, and then display the total value of those orders.

1. Open the Copy of Persons By Location view, click on the Properties button.

2. Select the Grouping tab.

3. Click the Enable Grouping checkbox.

4. From the Field drop-down, select Company. 

5. From the Summary Position drop-down, select BelowData.

6. Select the Fields tab.

7. Expand the View Properties window.

8. Select the ID row by clicking once.

9. Use the bottom scroll bar, move to the right of Selected Fields section and find the 
Aggregate Function column.

10. Click the Aggregate Function cell in the ID row, then click the down arrow.
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11. Select the Count value.

12. Click OK.

13. In the Country prompt field of the Prompt Select Box, enter Ireland. Click OK.

14. In the displayed View, observe:

• ID column displays the Count of Persons for each company in the light blue line.

• Users can expand/collapse company groups using the + and - buttons.
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Grouping is extremely valuable for aggregating financial data such as Orders or Payments. 
Users can choose multiple fields to aggregate using different functions. The following will 
demonstrate some of those capabilities: 

1. Under Orders Shortcut Group, click on Orders Balance Grouped by Company View.

2. In the Bill To Company prompt field, type Hitachi.

3. Click OK.

4. Observe the view is grouped by Company and aggregated for Count in the ID field and 
SUM in the Balance field.
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Preview Pane

The Preview Pane is an optional display area at the bottom of a view, which allows users to 
access a record’s data without having to open the actual record. Preview Panes are configured 
by Administrators, but are turned on and off by end users from a View. They can be enabled 
for any View in Aptify, and can display any data that is contained in the view’s records. 

Note that Preview Panes do NOT have to display the data currently shown in the View. This 
allows users to see information contained on any tab inside a record. Users may also edit the 
data in the preview pane.

In the Persons View below, the Preview Pane button is activated, and a record is selected in 
the View. The Preview Pane shows Membership information from the record’s Membership 
tab. The View itself displays basic Name, Company, Address, and Title information.
4.32 Aptify End User Training Manual



Working with Views Selecting the Preview Pane
Selecting the Preview Pane

Users also have the option on a View to select any form template as a Preview Pane under the 
Configuration tab. This enables users to create multiple Views with differing Preview Panes. 
If a Preview Pane is NOT selected, the default Preview Pane will be displayed.To select a 
Preview Pane:

1. Open the San Francisco Student Members View created earlier.

2. Click the Properties button, then click the Configuration button.

3. In the Preview Template lookup field, enter Persons. Select the Tab button.

4. From the Lookup List that displays, scroll to click Persons.Orders, then click Select.

• (The one with Persons Orders Tab Sub-Template in the Description field)

5. From the View Properties pane, click OK. 

6. From the View’s button bar, click the Preview Pane button.

7. Select one of the records in the View by clicking a name field of a person record.

8. Observe the Orders information that displays in the bottom half of the View.

9. Click Refresh button to return to previous view.
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Composing a Bulk Message

In this exercise, a user will draft a sample bulk message that could be sent to the Persons who 
appear in a filtered view. Note that this exercise will draft the message but not actually send it.

1. Open the San Francisco Student Members view created earlier.

2. In the View toolbar, click the Messaging button.

• The Aptify Messaging window appears.

3. In the Subject field, enter Your Orders - Last 30 Days.

4. Select the Plain Text Message tab.

• A user can compose messages in either HTML or Plain Text format. For this 
exercise, use the Plain Text format.

5. Click in the text field and type Dear [space].

6. Click the Insert Field button.

7. Expand the Name folder and select FirstLast.

8. The message field should now read: “Dear <<FirstLast>>”. Enter a colon after 
“<<FirstLast>>” and click the Enter key twice.

9. To move the cursor to the line below, click the Enter button.

10. Click the Insert Part button.

11. Locate the Accounting folder.

12. Expand the Order Information folder.

13. Select the Order History Part.
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14. Select the Options tab.

15. Select the Addressing sub-tab.

16. In the From Name field, enter your name.

17. In the From Email and Reply To fields, enter your email address.

18. Select the Preview tab and select the Text sub-tab.

19. Use the arrow buttons to preview the personalized messages addressed to the people in 
your San Francisco Student Members view.

• Note: the <<FirstLast>> field is replaced with Person’s First and Last Name.

• Note: each Person’s email address appears in the To: field for each message.
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Attaching Reports

Users can also attach Crystal Reports to a Bulk Message. This enables users to create a View 
for an audience that they wish to send a particular report to, and then attach a specific report, 
such as Invoice, Name Tent, Badge, Activity Consolidation, etc. Users would check the 
particular Report from the Attachments tab and send the message. The system will then send 
the appropriate Report to the individual user with only their relevant data.

Note: It is necessary to be upgraded through Service Pack 5.5.1 for this function.

1. Click the Attachments tab of the Bulk Message.

2. Click the scroll bar to the right of the Report to Attach section.

3. Scroll and then select the Aptify Badge report.

Note: Only certain reports will be available from Views of particular services. For example, 
Invoice Reports are only available when a View of Orders is created.

4. Click the X button in the upper right corner of the window to close the Aptify Messaging 
dialog without sending the message.

Do NOT click the Send Messages button.
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Topic Codes

Topic Codes provide a sophisticated way to collect information about the areas of interest 
of customers/members. Topic codes can be used effectively for customer/member 
profiling as well as driving personalized content to a particular user’s Web site (if the organi-
zation is using the optional Aptify E-Business Suite). Topic codes can also be a great resource 
for target marketing or determining the viability of a new product or service offering. 

Although topic codes are most commonly associated with people, companies, products, or 
news articles, their flexibility allows them to link to any type of record in Aptify. Because 
topic codes can be associated with any service, records in new custom modules can also link 
to topic codes, providing virtually unlimited possibilities.

The default Aptify installation provides a Topic Codes tab on the following forms: Organi-
zations, Companies, Employees, Persons, and Products. Multiple records, such as Persons 
and Products, linked to a particular Topic Code provides a powerful and flexible relationship 
which is useful when targeting marketing campaigns.

Note that Topic Codes are also referred to as “Personal Interest Codes.”

The Topic Code service is located under the Administration – CRM application, but Views 
of Topic Codes can be created from any of the major services.
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In the default Aptify installation, all users have the ability to add or edit Topic Code records. 
In practice, Topic Codes are typically configured by administrators or advanced users so this 
form will not be reviewed in great detail in this end user manual.

This illustrates how Topic Codes appear on a record form.

After a user has added Topic Codes to a particular service, the available codes appear under 
the Topic Codes tab. 

In the example above from the Employees form, there are Top-Level Topic Code categories. 
Each of these categories can have one or more sub-topics that a user can access by clicking a 
category’s hyperlink.

Aptify creates a Topic Code link between the record and the code (or codes) that a user 
checked when the record is saved. 

The Browse by Category sub-tab displays topic codes by category. After selecting one or 
more topic codes, save the record. Then a user can click the All Selected Topics tab to see a 
list of the codes they selected (regardless of category).

Note that selecting a Top Level topic code within the Browse by Category sub-tab does not 
automatically enable all of that category’s sub-topics. Users need to place a check mark next 
to each Topic Code individually. 

From either sub-tab, a user can click the Check All button at any time to select all of the 
codes on that particular screen (it does not enable all topic codes, just the ones that are 
currently visible). Likewise, a user can de-select all of the visible codes by clicking the Un-
Check All button.

When a user wants to analyze records based on Topic Code selection, they can create a 
filtered view of the Topic Code Links service in of the major services (Persons, 
Companies, etc.)
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Creating View Templates

Templates can be created for Views as well as records. View Templates enable users to load a 
pre-formatted View’s settings into a new View. View properties such as Filters, Sorting, 
Formatting, and Scheduling are automatically copied from the desired Template into the new 
View. This saves time and prevents mistakes from being made when creating the view.

Creating a View Template

1. Open the View Properties of the view desired to use as a Template.

2. In the lower left corner, click the Save Template button.

3. Enter the Name of the Template.
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4. At the far right of the Category field, click the New button.

5. Enter a New Category Name.

• Defining a Category name creates a folder into which users can organize views.

6. Click OK to save the Category.

7. Click OK to save the Template.

Loading a View Template

1. Create a View from the desired service.

2. In the lower left corner of the View Properties window, click the Load Template button.

3. Click the desired Category, which appear as tabs.
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4. Double-click the desired View template to load it.

5. Observe that the view’s settings have been imported into the new View.
Aptify End User Training Manual 4.41



Creating a Chart View Working with Views
Creating a Chart View

Aptify can visually represent data in a chart format, making it easier for users to interpret the 
information. Follow the steps below to create a Chart View:

1. Right click the Persons service and select Create View.

2. Name the view Individual Membership in CA by City.

3. From the View Type drop-down list, select Chart.

4. Click the new Chart tab and select the Pie Chart 3D type.
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5. Under the Charts tab, click the Grouping sub-tab.

6. From the Group By drop-down list, select City.

7. Click the Display sub-tab and select Show Legend. 
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8. Click the Title sub-tab and in the Top field, enter Membership % in CA by City.

9. Click the Filters tab and set up filters to match those in the following figure.
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10. Click OK to see the displayed 3D Pie chart:

11. Then close the view.
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Creating a Calendar View

Calendar views display records representing events or transactions in a calendar according to 
the date and time at which they occur. Calendar views are very flexible; users can organize 
them by either day, week, month, or year. If a user sets the view in day or work week mode, 
they can select one of several time intervals ranging between one minute to one hour. 

1. Click the Meetings service on the left.

2. From the top Navigation tool bar, right click the Meetings service and select Create 
View.

3. Name the View Upcoming Meetings

4. From the View Type drop-down, select Calendar.

5. Click the new Calendar Tab.

6. From the Mode drop-down, select Month View.

7. From the First Visible Date drop-down, select Manual.

8. From the Date drop-down, select the 1/1/2008.
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9. Click the Data sub-tab.

10. From the Start Date Field drop-down, select Start Date.

11. From the Duration Mode drop-down, select Standard Duration.

12. From the Title Field drop-down, select ID.

13. Click the Filters tab.

14. Keep Meetings as the Service.
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15. For the Field, select Date.

16. For the Operator, select the > symbol.

17. For the Value, select 1/1/2008.

18. Click OK to display the View.
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Pivot Tables

Pivot Tables are interactive tables used to summarize data. Users Rotate (or pivot) rows and 
columns to view different summaries of data. A Separate Pivot Table tab appears in View and 
users employ the Properties dialog to specify settings.

Users can also move rows and columns to change the organization of the data cells. This is 
known as “pivoting.” 

The two screen shots above illustrate how the organization of data changes when users move 
(or pivot) row headings.

In the top image, Order totals (in white) are organized based on the BillToCompany name (at 
the far left). By expanding a company heading (as in the case of Danube Partners), a user can 
further break down the Order totals based on specific products ordered by the company 
(Products are identified by their Product ID number in this example). Danube Partners 
ordered $100 worth of products on 12/4/2003, of which $25 was for Product 9.

The bottom image shows the same data except the BillToCompany heading has been moved 
to the right of the Order Line ProductID heading. Now instead of showing Order Totals based 
on Company, the table displays Order Totals based on the Products Ordered. Rearranging 
the two headings changed the format of the data and provides new insight into the data. With 
the new layout, a user can now determine that $125 worth of Product 9 was sold on 12/4/
2003, of which $25 worth was purchased by Danube Partners.

NOTE: Many Pivot Tables can be replaced by Base Views. Base Views are often more 
effective than Pivot Tables as they use considerably less processing power, are more 
easily displayed in dashboards, and provide more data management options.
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Managing and Sharing Views

Managing Views

All pre-created Folders, Views, and Shortcuts in BASE (out of the box/Training/
Sandbox) Aptify are tied to the Baseline Admin profile. That metadata is then tied to the 
Baseline profile via Shared Folders. When Administrators are initially setting up End Users 
in Aptify, they should ALWAYS copy the Baseline profile in step 6 of the User Adminis-
tration Wizard. By copying the Baseline Profile that user will automatically receive the pre-
loaded Views, Shortcuts, Shared Folders, and developed Dashboards. 

The Baseline Admin profile and the Baseline profile are NOT the same; the Baseline Admin 
profile is used to house all metadata (Folders, Views, Shortcuts, etc.) - it is the profile from 
which ALL metadata should be distributed. The Baseline profile is the most complete END 
USER profile that is LINKED to all the metadata owned by the Baseline Admin user. By 
linking the data from the Baseline Admin to the Baseline profile, the metadata is not repli-
cated and can be governed for ALL users that copy the Baseline profile by editing it from the 
Baseline Admin.

Views that display for the Baseline User are non-editable since they are linked back to the 
Baseline Admin’s Shared Folders. This includes all views that initially linked to Shortcuts in 
the left hand side of the screen. When users become more comfortable with the Viewing 
system they can then copy those views, edit them, and create new views.

In addition, ANY changes made by the Baseline Admin to the views located in Shared 
Folders, will be inherited by any users connected to that Shared Folder.

If an administrator wants to transfer control of the Baseline Admin’s Folders or Views to 
another user, possibly a Manager of a particular department, the Administrator could run the 
Entity Bulk Operation Wizard from a view of the Baseline Admin’s Folders or Views.

Once Aptify is installed and a Client goes live, there are two major methods of distrib-
uting Views to End Users:

Creating/Sharing Views via the Views Service:

1. Administrator creates a View under Framework, Views service. 

2. Administrator assigns the View to a manager or possibly to a specific end user.

3. The manager (or end user) can then share the views with other users, via Shared Folders.

Creating/Sharing Views via Shared Folders:

1. A manager (or end user) creates a View in their local instance of Aptify.

2. A manager (or end user) places a View in a Shared Folder.

3. The manager (or end user) informs their team that they can connect to the Shared Folder.

Important - Aptify recommends that most new and critical (not pre-loaded) end user Views 
be created by an administrator or manager and then placed on a dashboard, or shared. This 
helps reinforce standard business processes, ensures Views accuracy, and allows managers to 
quickly update the Views for all end users. End users should be encouraged to create their 
own views by copying those existing views and editing them to ensure a baseline of accuracy.
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Connecting to Shared Folders and Views

Follow these steps to connect to a shared view:

1. From the Navigation Bar, right click the Persons service and select Connect to Shared 
Folder from the list.

2. Expand the desired user (in this case, the SA user), then select the shared folder.

3. Click OK to add the Shared Folder to the Folder List.

4. Expand the Shared Folder to see the list of shared view folders.
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5. Expand a shared view folder to see all the views that are currently being shared.

6. Disconnect from the shared folder.

• Right click the shared folder and from the list, select Delete. Click OK.

Creating a Shared Folder

1. Right click the Persons service and select Create Folder.

2. In the Name field, enter My Shared Views.

3. In the Share this Folder box, place a check mark.

• A user can also create folders for their own use (for example, if a user wants to 
organize their views into categories). In this case, they should not check the 
Share this Folder box and the views in this folder will not be available to other 
users.
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4. Click OK.

5. From the folders list, move the Basic View to the Shared folder. Note that this feature 
only works with the Folder List. Views cannot be dropped from the Navigation 
Bar

• Click the Basic view.

• While holding down the left mouse button, drag the view into the shared folder.

• Release the left mouse button to move the view into the folder.

6. Other users can now connect to the shared folder and open the view that have been 
shared.

Any changes made by the owner of the folder will be inherited by the end user that 
connects to a shared folder. 
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Objective

In this section, users will understand some of the Aptify reporting features and how views are 
used to report and communicate data, including how Aptify integrates with Microsoft Excel, 
how to run a Report, and how Aptify integrates with Business Objects Crystal Reports.

After completing this section, users will know the process for:

• Exporting a view to Microsoft Excel

• Working with Lists

• How to run Reports
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Exporting a View to Microsoft Excel

The following directions explain how to export a specific Views’ results (Companies) to 
Microsoft Excel using the Excel Integration Wizard. 

1. Create a new list view from the Companies service, specify the following characteristics:

• Use a filter to display only Companies in Oregon.

• Edit the Fields to display only the Name, City, State, and ZipCode. 

• When finished, the view should display the sample companies in Oregon. Try to 
create this view on your own. If you need assistance, follow these steps:

• Select the Companies service and select Create View.

• Assign a name for the view (like “Companies in OR”).

• Click Filters.

• From the Field drop-down list, select State; from the Operator drop-down 
list, select Exactly Matches; in the Value field, enter OR.

• Click Fields.

• Move fields between the two display columns so that only Name, City, State, 
and ZIPCode appear in the Selected Fields column.

• Click OK.

2. From the view button bar, click the Export to Excel button to launch the Excel Integra-
tion Wizard.

• A user should not have any records selected when they click this icon (otherwise, 
only the selected record(s) will be exported rather than all records in the view). If 
a user has selected a record, right click within the view and select Clear Record 
Selection from the pop-up list before clicking the Microsoft Excel Export icon.

3. From the Type options, select Copy Data.

4. From the Mode options, select View in Excel.
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5. From the Column Header Display Options, select Use Database Field Names.

6. Click OK.

• A Microsoft Excel window appears; the window contains the information from 
the view.

• After exporting the view data to Microsoft Excel, a user can format the spread-
sheet and resize the columns as necessary.

7. Close Microsoft Excel without saving the file.

8. From the Companies in OR view, click the Microsoft Excel Export icon again.

9. Select Link to Data from the Type options.
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10. Select Save to File + View in Excel from the Mode options.

11. Select Use Display Names from the Column Header Display Options.

• Users will not notice a difference between these two options since the Field 
Name and the Display Name are identical for these company fields. 

• Note that the Display Name refers to a parameter in the field’s definition and 
not to a Display Name a user modifies in a view’s properties screen. There-
fore, an administrator would need to edit the Display Names to have an effect 
on the exported data.

12. Enter CLASSEXCEL.XLS in the File Name field.

• A user can also browse for a location to store the file by clicking the ellipsis (...) 
button.

• Microsoft Excel files use the .XLS extension.

13. In the Worksheet Name field, enter Companies in OR.

14. Click OK.
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Excel Notes: 

• Depending on how Microsoft Excel is configured on a computer, a user may see 
a message box concerning automatic data refreshes before the spreadsheet opens. 
Select the “disable automatic refresh” option if this message appears.

• Once Microsoft Excel opens, it displays the CLASSEXCEL.XLS file, which 
contains the contents of the view.

• Note that the Linked Data is automatically formatted in Microsoft Excel.

• If a user only sees “Linked_Data” in the first cell, right click on the cell and 
select Refresh Data from the pop-up list.

• Note that the Workbook Name a user configured appears on the spreadsheet tab.

• To manually refresh the data, right click within the data area and select Refresh 
Data from the pop-up list.

15. Return to Aptify but do NOT close Excel.

16. Open a Companies record the user created and change the State to OR. 

17. Save and close the Companies record.

18. Open the Companies in OR view (or refresh the view if it is already open).

• the Companies record should appear in the view (along with the Companies 
records of the other students in class).

19. Return to the CLASSEXCEL.XLS spreadsheet

20. Right click within the data area and select Refresh Data from the pop-up list.
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• The new Companies records should now appear in the spreadsheet.

21. Open this Company record again and change the State field back to its original value. 

22. Save and close this Companies record.

23. Open the Companies in OR view (or refresh the view if it is already open).

• Only the original records should appear in the view.

24. On the CLASSEXCEL.XLS spreadsheet, right click within the data area and select 
Refresh Data from the pop-up list.

• The spreadsheet only displays the original records.

25. Open the View Properties dialog for the Companies in OR view.

26. Click Fields and to the Selected Fields column, add the MainPhone field.

27. Click OK to return to the Aptify desktop.

• The MainPhone field should now appear in the view. 

28. On the CLASSEXCEL.XLS spreadsheet, right click within the data area and select 
Refresh Data from the pop-up list.

• The new MainPhone field is not added to the spreadsheet. When the 
Excel Integration wizard’s Type is set to Link to Data, Aptify updates the Excel 
file with changes made to the displayed fields; it does not update the Excel file to 
reflect changes made to a view’s properties. 

29. Close Microsoft Excel.

30. Close the Companies in OR view.
5.6 Aptify End User Training Manual



Reports How Reporting Works
How Reporting Works

With the Report Wizard, a View can be exported to almost any report format. The Report 
wizard can generate standard reports or mailing labels, export records to another format, 
print name badges, and more. Note that the Report Wizard automatically creates a new Lists 
record when generating a report. This List contains the records that appear in the selected 
View.

The Report Wizard walks the user through the steps to generate reports. Although there are 
general types of reports that apply to all of the services, most reports are service-specific. The 
general reports in every service are the List, Detail, and Export reports. 

List and Detail reports print out the information contained in the View. Export reports are 
often useful for selecting specific fields and records from the service and exporting them for 
use in other software applications. 

Other reports that are specific to a service are listed on various category tabs in the Report 
Wizard. Aptify ships with several service-specific reports which may be modified or replaced 
as required. Contact the System Administrator to add client-specific reports to a particular 
service.

Note that when printing mailing labels, the List ID appears on each label for marketing 
purposes –users can identify information about the mailing (such as when the label was 
printed) based on the List ID.

While the View system provides sophisticated capabilities to filter and sort data, it simply 
shows results in a tabular format. To provide robust output, Crystal Reports® is integrated 
into the View system through the Report Wizard. 

Crystal Reports is a database reporting tool created by Crystal Decisions (http://
www.crystaldecisions.com). An administrator can create new customized Crystal 
Reports for an organization but users need to purchase a license from Crystal Decisions 
first.

Aptify provides a wide variety of Crystal Reports with Aptify that can be used without 
purchasing a license from Crystal Decisions. These reports include creating a pie chart to 
analyze view data or mailing labels which can be used to send new literature to customer/
members.

However, if a user wants to develop new reports or edit existing reports, they would need to 
purchase a license to Crystal Reports from Crystal Decisions for every developer responsible 
for report writing. These licenses are not provided by Aptify.
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Running a Standard Export Report

In this section, a user will learn how to export data from a view to a text file.

1. Create a new Persons view that displays persons whose State exactly matches OR.

2. After loading the view, click the Report Wizard icon in the toolbar.

• Alternatively, a user can right click within the view and select Report Wizard... 
from the pop-up list.

3. Select the Export report (under the General tab) and click Next.

4. Move the following fields to the Selected column: AddressLine1, City, FirstLast, State, 
and ZipCode.
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5. Click Next to continue.

6. Click Finish to create the export file.

• Users will use the default file name and location for this file. The wizard will cre-
ate a file called export.txt and place it in their computer’s C: root folder.
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7. Click OK when prompted that the export operation has completed successfully.

• If a user wants to see what the exported data looks like, they can open the 
export.txt file using Notepad. It will look something like this:

• After creating the export file, a user can import its contents into another program, 
such as Microsoft Word or Excel.
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Running a Crystal Report

In this section, users learn how to run two specific Crystal Reports.

Running an Analysis Report

1. Open the Companies Service and click to open the General Look up Views folder.

2. Run a view such as, All Companies. At the top of the view, Click the Report Wizard 
icon.

• The Report Wizard launches and displays the list of reports supported by the 
Companies service.

3. Select the Analysis tab.

4. Select the Pie Chart by State report. (Note that this is a Crystal Report.)
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5. Click Next.

6. Click Finish to preview the report.

• A window opens that contains the report. The company data on the class system 
differs from the example below but the results should look something like this:

• A user can print the report from this screen.

7. Double-click one of the California slices in the pie chart.

• This displays the records that correspond to the pie slice.

• Click the grey X in the upper right-hand corner of the view to return to the main 
screen of the report.

8. Click the X in the upper right-hand corner of the Crystal Reports window to close the 
report.
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Creating Mailing Labels with Crystal Reports

1. Open the Persons in OR view created previously.

2. Click the Report Wizard icon in the toolbar.

3. Select the Labels tab.

4. Select Avery 5161 Label and click Finish.

• If a user had a printer with the Avery 5161 Label sheets, they could print out the 
labels directly from the Crystal Report window.

• Alternatively, a user could export the report to another format by clicking the 
Export icon in the Crystal Reports toolbar (the envelope icon).

5. Close the Crystal Report. 
Aptify End User Training Manual 5.13



Creating Mailing Labels with Crystal Reports Reports
5.14 Aptify End User Training Manual



Chapter 
 6 Contact Logs
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Understanding Contact Logs .......................................................................................... 6.2

Creating a Contact Log from the Persons Service.......................................................... 6.3

Creating a Contact Log Record from the Employees Service........................................ 6.5

Creating a Quick Contact Log Record from a Persons View ......................................... 6.6

Objective

In this section, users will understand how to use the Contact Log service. Contact Logs are 
used to track customer interactions throughout the Aptify system. They can be created 
manually from several locations or automatically created as part of a process flow.

After completing this chapter, users will be able to:

• Understand Contact Logs 

• Create a Contact Log from the:

• Persons Service

• Employees Service

• Contact Log Service
6.1



Understanding Contact Logs Contact Logs
Understanding Contact Logs

Users can keep track of their interactions with customers by creating a Contact Log record 
each time they communicate with a customer (via mail, telephone, fax, e-mail, etc.).

Users can link a Contact Log record to one or more related records in another service. 
For example, a Contact Log record detailing a telephone conversation with Anthony Atkins 
regarding a specific order can be linked to Anthony Atkins’s Persons record, an Employees 
record, and the relevant Orders record.

The Contact Logs service also integrates with Microsoft Outlook. If an organization uses 
Microsoft Outlook for email, follow-up appointments scheduled within a Contact Log record 
automatically appear in the Outlook Calendar.

Users can create a Contact Log from the Contact Log tab on another form, such as the 
Persons, Employees, or Orders form. When a new Contact Log record is opened from a 
Persons, Employees, or Orders record, Aptify automatically adds a link to that record in the 
new Contact Log’s Link tab.

Users can also quickly record a Contact Log record from the Persons View. If a user right 
clicks on a Persons record, selects Person Options, automatically either a “Left Voice Mail” or 
“Record Phone Call” contact will be created.
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Creating a Contact Log from the Persons Service

A user can create a Contact Log record from the Persons, Employees, Orders, or Contact Log 
service. In this exercise, a user will create a Contact Log record from a Persons record.

1. Open a Persons record.

2. Select the Contact Log tab.

3. To open a new Contact Log record, in the toolbar, click the New Record button.

• Aptify automatically fills in the Date/Time field with the current date and time.

4. In the Description field, enter XYZ Contact Log (where XYZ are your initials).

5. Leave the Type field set to Phone and Category set to Sales.

6. Change the Direction to Inbound (customer initiated contact).

7. On the Next Contact tab, enter the last day of the current month and a time of 8:30 AM 
in the Date/Time field.

• For example, 12/31/20xx (xx=year) 8:30 AM (no periods)

8. From the Status drop-down list, select In-Progress.

9. In the Assigned To field, enter the Persons record created previously in training.

10. In the Forward field, enter Juan Carlos.

11. In the Reason field, enter Call XYZ Company with requested information.

12. Click Save and Close.
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13. When a Contact Log is created and saved:

• Aptify auto-adds user name to the Creator field (After Saving & Closing).

• If Microsoft Outlook is installed on the computer, Aptify automatically creates an 
appointment based on the information provided within the Next Contact tab.

14. On the Contact Log record, select the Links tab. 

• There should already be two links listed on this screen. Aptify automatically adds 
a link to Persons record and that person’s Companies record from which the user 
opened the new Contact Log record.

15. Click Save and Close to save and close the record.

16. Return to the Persons record and note that the Contact Log record now appears in the 
Persons record’s Contact Log (Incomplete tab).

17. Close the Persons record.
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Creating a Contact Log Record
from the Employees Service

Users can create a Contact Log record from the Persons, Employees, Orders, or Contact Log 
service. This exercise, will create a Contact Log record from a Employees record.

1. Open the Employees record that corresponds to the Aptify User Account.

• When in class, an instructor can assist if you cannot identify which Employees 
record is linked to your User Account.

2. Select the Contact Log tab.

• This tab should already list the Contact Log created in Exercise 1.

3. In the toolbar, click the New Record button to open a new Contact Log record.

4. In the Description field, enter Sent introductory e-mail to XYZ Company representa-
tive.

5. From the Type drop-down list, select E-Mail.

6. On the Next Contact tab, from the Status drop-down list, select Complete.

7. Click Save.

8. Select the Details tab and enter text.

• For example, a user could paste the text of an e-mail message in this field.

9. Select the Links tab.

10. From the Link Type drop-down list, select Persons.

11. In the Link field, enter your Persons record and click the Tab key.

12. Click Add to add the link to the Contact Log record.

13. Click Save and Close to save changes and close the record.

14. Return to the Employees record and note that two Contact Log records now appear in 
the Contact Log tab.

15. Close the Employees record.

16. Open the Persons record.

17. Select the Contact Log – Complete tab.

• Note that the Contact Log record created in this exercise was added to the Per-
son’s Contact Log > Complete tab rather than the Contact Log > Incomplete 
tab since the Contact Log’s Status was set to Complete.

18. Close the Persons record.

IMPORTANT NOTE: As a rule, users should NOT create Contact Logs from the Contact 
Log service as the Contact Log will then NOT be linked to any Persons, Company, or 
Employee record. Users should instead create MOST contact logs from those services. Users 
should use the Contact Log service to create VIEWS of Contact Logs.
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Creating a Quick Contact Log Record
from a Persons View

Users can create a quick Contact Log record from a View of Persons. There are two process 
flows tied to views: Left Voice Mail and Record Phone Call. The following exercise will 
take users through the use of these quick contact logs.

1. Run the San Francisco Student Members view (shortcut).

2. Click once on the first record in the View to select (but not open); right click this record.

3. Float over the Persons Options selection from the drop-down list.

4. Select Left Voice Mail.

• A Contact Log is automatically created under that Persons’ Contact Log tab

5. Click to open the Persons record. 

6. Select Contact Log tab to view the Contact Log format.

7.  The Contact Log will be placed under the Contact Log, Select the Complete tab. Close 
the box.

8. Right click on the Persons record, Persons Options again. Float over the Persons 
Options selection from the drop-down list

9. This time select Record Phone Call.
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10. The Contact Log automatically Opens, as it assumes the user is speaking to a person.

11. Note Contact Log box to easily enter information.

12. Close box. 
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Creating Cases ................................................................................................................ 7.2
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Objective

Users will be able to:

• Create Cases

• Track Cases from inception to conclusion

Overview

Case management is included in the Aptify CRM application to allow organizations to track 
their customer’s inquiries and their resolution. Individual Cases track incidents, or “tickets” 
as some organizations call them. This allows each customer request to be tracked, allows each 
request to be monitored through its individual process and supports the creation of detailed 
customer histories.  Some examples where Case Management can be used:

• Track Initial Customer Inquiries

• IT Help Desk

• Customer Support requests and Ticketing

• Sales Inquiries
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Creating Cases

Using the New Cases Wizard

1. Click the Case Management dashboard shortcut.

2. Click the New Case wizard button. 

3. In the Company field, enter the name of XYZ company that submitted the case. 

4. In the Contact field, enter the name of the person.

5. In the Source field, specify the source of the case as External. 

6. In the Date Reported field, confirm that today’s date appears.

7. In the Recorded By field, confirm your name (if not automatically populated). 

8. For the Case Report Method, select phone. 

9. In the Contact Log Description field, enter a description which will be generated auto-
matically when this new case is created. This will tie the Contact Log to this new case.
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10. Click the Next button.

11. For case Title enter, XYZ Case

12. Choose a Category of Finance.

13. Enter a Priority of High

14. Enter Type of Complaint

15. Enter a Summary of “Customer was billed incorrectly”

16. Click the Next button
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17. For the Primary Designee, select an employee record. For class enter ID #1

18. For Manager, select an employee record. For class, enter Linda Jameson.

19. Click the Finish button

20. Observe the success message and click the OK button.
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Reviewing Cases

1. Open the case just created.

2. Click the Status drop-down and select Completed.

3. For Date Closed, select today’s date.

4. For the Closed By employee select ID #1.

5. Open the Contact Log tab.

6. Observe the Contact Log that was created using the Wizard.
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7. Select the Tasks tab

8. Open the Task that was created using the Wizard.

• Tasks can be used for the tracking of small projects

• Users can associate Main Tasks and multiple sub-tasks. Sub-Tasks can be rolled 
up to track hours for a project

9. Close the Task record.

10. Save and Close the Case. 
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Objectives

In this section, users will work with the Committee Management application. When finished, 
a user will be able to:

• Create a Committee record

• Create Committee Terms

• Add members to committee terms

• Assign titles and ranks to committee members

Overview

Organizations frequently assemble committees to focus on specific tasks or events. The 
committee may be designed to operate for one function for a short period of time, such as 
organizing a corporate event, or it may be a long-term project that operates indefinitely. 
Additionally committees may be organized into sub-committees. 

Aptify’s Committee Management application provides diverse functionality to address the 
varying committee structures of an organization. The Committee Management application 
includes two services. The Committees service tracks the overall information about the 
committee and its purpose. The Committee Terms service tracks similar information, but the 
information is specific to the scope of the particular term. For instance, a committee may be 
designed to schedule a particular event, and its mission may be to successfully hold the event 
and stay within a budget. A committee term could be created to handle the tasks up until the 
event occurs, and then another committee term could be created to handled all the follow-up 
tasks. Each committee term could have its own schedule and purpose. In Aptify, members are 
associated with the Committee Terms record, which requires each committee to have at least 
one committee term linked to it.

Note: If a user’s organization does not use Committee Terms, they would create one 
Committee and one Committee Term for each Committee.
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Creating a Committees Record

1. Click on the Committee Management Application, then Committees Service.

2. Right click the Committees service and select create New Committees Record.

3. In the Name field, enter XYZ Finance Committee (XYZ= your initials).

4. In the Organization field, enter an ID number of 1, click Tab.

5. From the Committee Type drop-down, select Standards.

6. In the Coordinator field, enter (number) 1, click Tab to auto-fill.

7. In the Description field, enter Balance Budget.

8. In the Goal field, enter Balance Budget.

9. From the Reach drop-down list, select National.

10. In the Date Founded field, enter a date (ELEVEN MONTHS PRIOR TO TODAY’S 
DATE).

11. Click Save.
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Creating Committee Terms

The Committee Term records tracks individual terms of different committees and their info. 

1. Select the Terms tab on your Committees record.

2. Click the New Record button in the toolbar.

• A new Committee Terms record appears.

• Aptify automatically fills in the Committee field and the Start Date.

3. In the Name field, enter XYZ Finance Committee 20XX (committee term name.

4. In the Director field, enter your Persons record name.

5. Enter the Start Date as (11 MONTHS PRIOR TO TODAY’S DATE).

6. Enter the End Date as (1 MONTH IN THE FUTURE FROM TODAY’S DATE).

7. Click Save and Close.
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Adding Members from a View

1. Click on the San Francisco Student Members View shortcut.

2. Select the first Person in the view.

3. Click the Add Persons to Committees... button. 

4. Click No to add all Persons in the view, when prompted.

5. From the Filters options in the Select Committee Terms window, select All Committee 
Terms.

• This displays all Committee Terms in the system regardless of their Start/End 
Dates.

6. Select the Selected checkbox for each of your XYZ Finance Committee terms.
8.4 Aptify End User Training Manual



Committees Adding Members from a View
7. Click OK.

8. Click Yes to confirm the addition of the people from the view to the selected committee 
terms.

9. Click OK when prompted that the people were successfully added to the committee 
terms.

10. Open the All Persons view and sort the records by ID (if not already sorted).

11. Select the first record.

12. Hold down the CTRL key and select the second record.

• Two records should now be selected.

13. Click the Add Persons to Committees... button.

14. When prompted, click No to add only the two selected Persons to committees.

15. Select All Committee Terms from the Filters options in the Select Committee Terms 
window. Re-sort the Committee Term records by ID if they are not already sorted this 
way.

16. Expand the box to full screen to see all fields. Place a check mark in the Voting Member 
box (far right) for your XYZ Finance Committee 20xx term only

17. Place a check mark in the Selected box for your XYZ Finance Committee 20xx term only.
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18. Click OK.

19. Click Yes to confirm the addition of two people to the selected committee terms.

20. Click OK when prompted that the people were successfully added to the committee 
terms.

21. Open the second record and select the Committees tab.

• Note that this screen now displays the person’s Committee Term.

22. Close the record.
8.6 Aptify End User Training Manual



Committees Adding Members from a Record
Adding Members from a Record

1. Open the Persons record created at the start of the class.

2. Select the Committees tab.

3. Click the Add to Committees button.

4. From Filters options in Select Committee Terms window, select All Committee Terms 

5. In the Voting Member box and the Selected box for your XYZ Finance Committee terms, 
place a check mark.

6. In the Rank column for each term, Enter 2.

7. Click OK.

8. Click Yes to confirm the addition to the selected committee terms.

9. Click OK when prompted that Person was successfully added to the committee terms.

• Committee terms should now appear Persons record’s Committee tab. A user can 
edit or delete a Person’s Committee term settings by right clicking on an entry.

10. Close the Persons record.
Aptify End User Training Manual 8.7



Editing Member Information Committees
Editing Member Information

1. Open the previously created XYZ Finance Committee record.

2. Select the Members tab.

• This tab displays all of the members of all of the Committee Terms. Note- those 
members who are in both Committee Terms are listed twice (once per term).

3. Select the Terms tab.

4. To open the Committee Term record, double-click XYZ Finance Committee 20xx.

5. Select the Members tab.

6. To open the corresponding Committee Term Members record, double-click the first 
record entry.

7. In the Rank field, enter 1.

8. In the Title field, enter Chairman.

9. Change the Start Date to 1/1/20xx and the End Date to 12/31/20xx.

10. In the Voting Member box, place a checkmark.
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11. Click OK.
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12. Open the second Committee Term Members record.

13. Change the Start Date to 12/1/20xx.

14. Change the End Date to yesterday.

15. Click OK.

16. Click Save to save these changes to the Committee Terms record.

17. Click the In-Active Members tab.

• That person should now be listed as an inactive member since term has expired.

18. Select the Nominees tab.

19. Open a new Committee Term Nominees record.

20. In the Member field,enter Jensen, Pamela. (This field links to the Persons service.)

21. In the Title field, Enter Secretary.

22. In the Rank field, enter 3.

23. Click OK.

24. Save and Close the Committee Terms record and then the Committees record.
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Objective

In this lab, users will add products to the Aptify system. This includes:

• Understanding products

• Creating a new products record

• Adding prices to a product

• Creating a Related Product Prompt

• Creating a Kit Product

• Creating an Inventory Location

• Creating a Product Inventory Ledger

• Creating a Product Inventory Ledger Entry
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Understanding Products

Product Types

Aptfiy groups similar products together based on required functionality. Basic products use a 
General type designation. Extended products use a name-specific designation.

All Products fit into these 6 General and Extended Types:

General

Publications

Meetings

Expos

Housing

Classes

Publications, Meetings, Expos, and Housing are all Extended Products Types. When a user 
specifies a product type other than General on a Products record, Aptify automatically adds 
an extended product tab to the Products form. For example, when the Publications product 
type is selected, a Publications tab appears on the Products record. Additionally, extended 
order detail forms are defined for products with product types of Expos, Meetings, and 
Housing. 

Product Types are configured by administrators.

Product Categories

Product Categories are configured by users and group similar products together. Users can 
create product hierarchy of categories and sub-categories. Users can also create General 
Ledger (GL) Accounts that flow down to new products in a category. This enables a 
simplified product setup.

Aptify's sample database includes several predefined product categories. An organization 
should create new product categories as necessary based on its particular product/service mix. 
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Creating a New Products Record

1. Select the Product Maintenance Application and note the dashboard shortcuts.

2. Click the New Products Record button on the dashboard.

3. In the Name field, enter XYZ Product (where XYZ are your initials).

4. In the Category field, enter Books/Publications. Click Enter.

• Note that the Publications Type was automatically entered for the user. Aptify 
will automatically set the type of product as it relates to the category selected.

5. Click Save.
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GL Accounts Tab

1. Select the Accounting > GL Accounts tab.

• Notice how six GL Accounts are listed. These accounts flowed down from the 
Product Category.

Inventory Tab

1. Select the Inventory tab. 

2. In the Require Inventory box, place a checkmark.

3. In the Re-Order Qty field, enter 100.

4. In the Minimum Stock field, enter 500.

5. Click Save.
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Understanding Pricing

Can specify multiple prices to target specific audiences

• Member-based pricing

Can specify different prices for members and non-members

• Date-based pricing (Early Bird specials) 

Set prices based on Order date 

• Group Discounts

Provide discounted prices if customer orders specified number of units or above

• Can Combine multiple pricing features

For example, an early bird special for members only

• Support for prices in Multiple Currencies

The Order Entry System automatically selects the correct price based on membership, order 
date, and/or order quantity.

Pricing Can be set at three different levels:

•   Organization

•   Employee 

•   Product 

Setting permissions on the Organization level gives all of its employees the ability to 
override the configured price(s), select a price from a list of available prices, or allow the 
product to be given to a customer/member for free (price = $0). Organization-level permis-
sions take precedence over the Employee and Product permissions settings. (In other words, 
once a user has enabled these permissions for the entire organization, all users will have these 
abilities regardless of the individual Employee and Product settings.)

If a user wants to set permissions on an Employee-by-Employee basis, enable Order Entry 
Permissions only for specific Employees and leave these settings disabled for the Organiza-
tions and Products records.

If a user wants to set permissions on a Product-by-Product basis, enable Order Entry 
Permissions only for specific products and leave these settings disabled for the Organizations 
and Employees records.

A user can also utilize the Employees and Products permission sets in conjunction (keep in 
mind that the Employee setting takes precedence over the Product setting). For example, a 
user can enable these Permissions on Employees records for managers so they can override 
the price of any product (while leaving these Permissions disabled for non-managers). Then, 
a user could enable these permissions for specific products whose prices non-managers can 
override and leave them disabled for products that non-managers cannot override.
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Organization Pricing 

Employee Pricing

Product Pricing
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Adding Prices to a Product

Each product can support multiple prices based on membership type, order quantity, and/or 
other order characteristics (such as those identified by a filter rule). Then, when taking an 
order, Aptify automatically applies correct price based upon the characteristics of the order.

Follow these steps to setup pricing for the product created in Exercise 1:

1. On your XYZ Product record, select the Prices tab.

2. From the sub-type area, open a new Prices record.

• To do this, on the sub-type toolbar, click the New Record... button or right-click 
in the gray area and select New from the pop-up list.

3. In the Name field, enter Member.

4. In the Price field, enter $100.00

5. From the Member Type drop-down list, select Member (if not already selected).

6. From the Type drop-down list, select Base Price.

7. Click the OK and New button.
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8. Note on the Product record in background, the Member Price record appears in the 
Prices tab.

9. In the Name field, enter Non-Member.

10. In the Price field, enter $0.00.

11. From the Member Type drop-down list, select Non-Member (if not already selected).

12. From the Type drop-down list, select % of Base Price.

13. In the % of Base field, enter 200.

14. Click OK. Click Save.

• By choosing Base price for the Member and Percent of Base for the Non-Mem-
ber the user can control future price changes by only editing the Base Price.

Important Note: Filter Rules is an available and valuable tab under a Prices record. Filter 
Rule records can be set up to cross reference specific areas/services to set a particular price. 
For instance, a user could tie a discount to the amount of Continuing Education Credits a 
Bill To Persons has or to the number of Classes they have taken in a particular year.
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Creating a Related Product Prompt

A Related Product is considered to be an additional product that can be seen as an accessory 
or a cross-sell product. The related product will appear next to the Order form, as a separate 
window when a user places an order.

For example, if an organization is selling a subscription for maga-
zines, the related product may be a travel bag at a discounted price. 

1. From the XYZ Product record, select the Details tab.

2. Select the Related Products sub-tab.

3. Open a new Related Products record.

4. In the Related Product hyperlink field, enter Financial Planning.

5. In the Product Relationship Type field, enter Accessory.

6. In the Start Date field, enter today’s date.

7. In the Prompt Text field, enter the Financial Planning Available.

8. In the Web Prompt field, enter the Financial Planning Available.

9. Click OK.

• When a user takes an order for XYZ Product later in this class, a pop-up dialog 
box will appear to inform them that there are related products available.

10. Save and Close the XYZ Product record.
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Inventory Objectives

Because users checked the Require Inventory button under the Products, Inventory tab, 
they will have to set up and understand:

• Creating an Inventory Location

• Creating a Product Inventory Ledger (PIL)

• Creating a Product Inventory Ledger Entry (PILE)

How Aptify tracks inventory

• Optional on a per-product basis

• Membership Dues usually do not have inventory but can if the number of avail-
able memberships is limited

• Inventory stored in multiple warehouses and transferred between as necessary

• Inventory records configured by the organization’s Accounting department

3 Services related to Inventory Management:

Inventory Locations (ILs)

• Inventory Location must be identified first. For physical products, the location is 
a bin or pallet location in the warehouse. 

• For meetings, it would be a block of seats available in the meeting room. 

Product Inventory Ledger (PILs)

• Product Inventory Ledgers must be created next. Each Inventory Location will 
have a ledger for each product it contains. These Ledgers are used to house the 
inventory transactions created in the PILES. 

• Product inventory ledgers (PIL) are records that track inventory activity for a par-
ticular product. Every product must have its own product inventory ledger. Led-
gers are only created once at the creation of a product.

Product Inventory Ledger Entries (PILEs)

• Inventory transactions – 4 types

Purchase: for adding new inventory

Transfer: for moving inventory between locations

Adjustment: for making corrections or for returning inventory

Batch: Removes shipped units from inventory

• Automatically generated during batching process

• Each PILE is tied to a PIL

•  A saved PILE cannot be modified

• Use an Adjustment PILE to make corrections if necessary
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Products & Inventory Creating an Inventory Location
Creating an Inventory Location

1. Return to the Product Maintenance Application.

2. On the dashboard, click the New Inventory Location button.

3. In the Name field, enter XYZ Warehouse.

4. In the Description field, enter Contains XYZ products.

5. In the Organization field, enter 1.

6. Leave Type set to Bin and Status set to Active.

7. In the Max Units field, enter 5000.

8. In the Replenish Level field, enter 500.

9. In the Replenish Quantity field, enter 500.

10. In the Manager field, enter John Samuels (this links to the Employees service).

11. Click Save.
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Creating a Product Inventory Ledger 

A Product Inventory Ledger (PIL) is created to manage and track inventory. Each product for 
which a user tracks inventory must have a Product Inventory Ledger assigned to it.

1. Select the Product Inventory Ledger tab on the Inventory Locations record created 
previously.

2. Click the New button in the toolbar to open a new Product Inventory Ledger record.

• Aptify fills in the Inventory Location field automatically since the user opened 
this record from an Inventory Location record. A user can also open new Product 
Inventory Ledger records directly from the Product Inventory Ledger service.

3. In the Product field, enter XYZ Product.

4. Click Save.

• Note that the Product Inventory Ledger Entries tab is now active.
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Products & Inventory Creating a Product Inventory Ledger Entry
Creating a Product Inventory Ledger Entry

Users will utilize Product Inventory Ledger Entries (PILEs) to add, transfer, or remove 
inventory from different locations. 

1. On the Product Inventory Ledger record created previously, select the Product Inven-
tory Ledger Entries tab.

2. Click the New Record button and open a new Product Inventory Ledger Entries 
record.

• Aptify fills in the Product Inv. Ledger field automatically since a user opened this 
record from a Product Inventory Ledger record. A user can also open new Prod-
uct Inventory Ledger Entries records directly from the Product Inventory Ledger 
Entries service.

3. In the Description field, enter Add 1000 units.

4. In the Quantity field, enter 1000.

5. In the Unit Cost field, enter $20.00.

6. Click Save.

7. Click Close.

8. Note the Product Inventory Ledger record, then Save and Close.

9. Refresh, then Save and Close the Inventory Locations record.

10. Open the XYZ Product record (dashboard, Find Product).

• A user can access the Products service and their custom views from either the 
Inventory Management or the Product Setup and Maintenance application.

11. Open the record, then select the Inventory tab.
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12. Notice that the Quantity On Hand field reads 1000.
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General and Prerequisites Subtabs

Two additional areas that are useful for product configuration are the General and Prerequi-
sites subtabs found under the Details tab. 

General Tab 

The General tab contains additional information that can be stored, linked, and configured 
for the product - the most useful of which concerns Order Lines generated by purchasing a 
product. 

1. Select the Details tab.

2. The record should default to the General subtab.

3. Check the Open Order Line on Add checkbox.

• Checking this box automatically opens up the Order Line on an Order form when 
the product is added.

• Useful feature when additional information is required on an order such as addi-
tional shipping info, booth info for an expos sale, registrant info for a class, etc.

4. Check the Allow Description Override checkbox.

• Feature enables users to type over the Product Description that is auto-added 
when a product is ordered.

• Useful if particular instructions are needed regarding a particular product on a 
specific order.
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Prerequisites Tab 

The Prerequisites enables users to set up prerequisites for a product. Clients will only be able 
to order a product if they meet the prerequisites set up under this tab. 

1. Select the Prerequisites subtab.

2. Check the Require Prerequisites checkbox.

3. Observe the Prerequisites Failure Message and the Web Prerequisites Failure Mes-
sage linked fields.

• These boxes communicate the exact failure message that will display as a result 
of a client ordering the product that does NOT meet the prerequisites.

• Failure messages are linked via Aptify Culture Strings which are created by 
Administrators. These can easily be created to reflect the desired message.

4. Click on the Prerequisites Failure Message link to open a blank record.

5. In the Name and Base String fields, enter Purchasee must be from the State of 
_________ to purchase. (In the blank, fill the state of the Persons record created earlier).

6. In the Category field, enter Products.

7. Click Save and Close.

8. Click in the Service Column under the Filter Rules area.

9. From the Service field, select Ship To Person.

10. In the Field field, enter State.

11. In the Operator field, enter Exactly Matches.

12. In the Value field, enter the State from step 5 above.

13. Save and Close the Products record.
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Products & Inventory Creating a Kit Product
Creating a Kit Product

Kits are products that contain two or more products and are sold as a bundle.

Kits often bundle complementary products to provide customers with a price discount when 
compared to the cost of purchasing each product separately. Products in a kit may also be sold 
individually depending on the top level item setting.

1. Return to the Product Maintenance dashboard.

2. Click the New Product button.

3. In the Name field, enter XYZ Kit Product (where XYZ are your initials).

4. In the Category field, enter Books/Publications.

• The Product Type ID should be set to Publications.

5. Click Save.

Assembly Tab

1. Select the Assembly tab.

2. From the Kit Type drop-down list (red), select the Kit Product type.

3. Click the Assembly Using Inventory From Sub-Products checkbox.

• Notice that the Assembly functionality is now active.

4. In the toolbar, click on the New record icon to open a new Parts record.

5. In the Sub Product field, enter XYZ Product.

6. In the Quantity field, enter 1.

7. In the % of Revenue field, enter 75.

8. Click OK.
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9. Open another new Parts record.

10. In the Sub Product field, enter Sampco Baseball Hat.

11. In the Quantity field, enter 1.

12. In the % of Revenue field, enter 25.

13. Click OK.

14. Click Save.

Prices Tab

1. Select the Prices tab.

2. Click the New Record button.

3. Add a Member Price of $105 for each kit.

4. Click the OK and New button.

5. Add a Non-Member Price of $210 for each kit. Mark this price as the default.

6. Click Save and Close.

Product Grouping

• Easy way to add multiple products to an order in one operation

• Setup like a Kit product

• Group itself is not added to an order

• Only the individual products in the group

• Products added by group can be removed from order w/out affecting other products.
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Objective

Within Aptify, once products, inventory, and prices have been established, an organization’s 
employees can take orders from customers and/or members. In this chapter, users will have 
the opportunity to work with the Aptify Order Entry system. This includes:

• Types of Orders

• Taking Orders

• Shipping Orders

• Creating a Back Order

• Canceling an Order
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Types of Orders

The Aptify Order Entry system enables organizations to process any type of transaction 
within one module. A single order can combine different types of transactions. For example, a 
service representative could process a new membership, register that individual for a meeting, 
and sell a book all in one transaction with one invoice. 

In Aptify, all income-generating items are classified as products, including booth space at 
expos, meeting registrations, subscriptions and membership dues. Aptify has developed a 
sophisticated method of tracking the extended information associated with these complex 
transactions within the Product Service/Order Entry system. Unlike some generic products 
that encourage workarounds to handle these types of transactions through a centralized Order 
Entry system, Aptify was designed to handle all transactions. 

The Aptify Order Entry system provides full-feature order and payment processing. The 
Order Entry system has the following features and capabilities: 

• Orders can be placed for multiple and diverse products on the same invoice. 

• Orders and Payments records automatically pull address information from 
customer records for shipping and billing addresses saving order processing 
time. 

• Pricing information is automatically pulled from a Products record. Each 
product can be configured to have multiple pricing options, which can be associ-
ated with different marketing campaigns/member/customer types. The Order 
Entry system has logic that automatically selects the best price each customer or 
member is eligible for, and enables price overrides with appropriate permissions. 

• Income from certain items, such as membership dues and subscription orders, is 
earned over time and therefore should not be entirely recognized at the time of 
the order. To accommodate this, Aptify has a deferred income option that can 
automatically generate scheduled transactions over a given time period to recog-
nize the income as it is earned.

• The Order Entry system automatically creates back orders for products that are 
not currently in stock. The shipping status for regular and back-ordered items is 
maintained separately so that partial orders can be shipped and invoiced. 
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Order Entry Ordering a Product
Ordering a Product

This section gives users the hands-on knowledge and experience of ordering a product and 
viewing the decrease in inventory. Normally, Orders would be done using a user’s 
companies E-Business web site OR by using a wizard - see the next exercise. An Order 
would NOT normally be created by using a Persons record - users are doing so in this 
exercise to see features - such as advanced addressing - that would not be accessible via the 
web site/wizard.

1. Open the Persons record.

2. Select the Orders tab.

3. In the toolbar, click the New Record button to open a new orders record.

• New Orders record displays: Aptify automatically fills in fields, including:

• The Ship To information (Name, Company, Address, etc.) since the form 
was opened from a Persons record.

• The Date field with today’s date.

• Note that the same address information that was added to the Ship To section is 
also added to the Bill To section. To specify different Bill To information, 

4. Remove the check mark from the Billing Same As Shipping box.
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Ordering a Product Order Entry
5. To the right of the Ship To field, click the Addresses button (record center).

• This button is circled in the following figure.

• Clicking this button displays a drop-down list that contains all of the addresses 
associated with the Person and the Company (including the addresses found on 
the Addresses tab).

6. Select Ship To Person Addresses > to use the address added to the record’s Addresses 
tab in the previous Companies & Persons exercise.

7. Of the choices, select Home.

• Note: Ship To address information changes to the Home address.

8. From the Billing Same as Shipping box, remove the check mark.

9. In the Bill To field, the person and Bill To Company then populates automatically.

10. On the right side of the order, under Order Addresses, use the address drop-down list to 
switch from the Ship To Address to the Bill to Address. Note that the Bill To Address 
still uses the original address (note when toggling between the Ship To Address and Bill 
To Address using the address drop-down list).

11. Next to the Ship To field, click the Addresses button, and from the pop-up list, select 
Person > Vacation Address.

• The Bill To address is updated to use the vacation address entered previously.

12. From the drop-down list items, click between the Bill To and the Ship To.

• Notice that there are now specified different Bill To and Ship To addresses.

13. In the Find Products field, Enter your XYZ Product, and click the Tab key.

14. In the Quantity field, Enter 1.

15. Click the Add button (right of Quantity).

• An Order line is added to the form for 1 unit of the XYZ Product.
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16. To delete an order: Highlight Order Line 1 (as shown in Figure 10.3) and click the Delete 
key. Click Yes to confirm the deletion of the order line.

17. In the Find Products field, enter XYZ Product and click the Tab key.

18. In the Quantity field, enter 2 and click Add, which initiates the actual order.

• An order line for 2 units is added to the Order at $200 each for a total of $400.

• The related product prompt appears to the right of the form. 

19. In the Price field, click the 200.00 to display an ellipsis (...) button.

20. Click the ellipsis button and review the available prices for this product.

• Note that this person is charged $200 since this person’s Member Type is Non-
Member. The Member Type is also reported below the Order Level field on the 
Order form. It should read Non-Member.

21. From the drop-down list, select 100 (the member price).

22. When prompted if a user is overriding the automatic price, click Yes.

• The price updates to $100/unit and the Order Total changes to $200.

23. Select the Payment Type drop-down.
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Ordering a Product Order Entry
24. From the Pay Type drop-down list, select Visa.

25. In the CC Account # field, enter 4123 4567 8901 2345 (any 16 digits beginning with 4).

26. In the CC Exp. Date field, enter a date two years from today’s date.

Note: On the training server, users can enter any value in the Acct # field since it is not 
configured to validate credit card numbers through Paypal. On a Live system, users 
would only use valid credit card numbers provided by a customer/member.

27. Check the Save for Future Use checkbox(towards bottom right); this enables users to 
reuse the CC on subsequent orders for this Person without having to re-type. 

Note: This function must be enabled per payment type under the Order Entry Admin-
istration application, Saved Payment Types service.

28. Click the Save button.

29. The system prompts users that this order can be shipped because all of the products on the 
order have:

• The Requires Fulfillment box cleared (this box is on the product form’s Inven-
tory tab) 

• The product has available inventory (Requires Inventory box is checked and 
this product is stocked in the warehouse).

30. On the order prompt screen asking if the user wants to have the item shipped, click No. 
(Later, in another exercise, this order will be manually shipped).

31. Close the Orders record.
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Creating a Multi-Line Order

In this exercise users will enter an Order using the New Order Wizard. The New Order 
Wizard should be the standard method for end users to enter a customer request handled over 
the phone or in person. It is the quickest/most efficient way to handle a standard order. It is 
important to note that ANY order processed using the wizard will only be given a status of 
Taken. Users will have to mark orders as Shipped in a separate function.

1. Click on the Order Entry application to open the dashboard.

2. Click on the New Order Wizard button.

3. In the Ship To field, enter your Persons name and click Tab.

4. Click the Next button.

5. In the Find Product box, enter 16 and click Tab.

6. Click the Add button.

• The system will add the 16 oz. shot glass to your order.

7. In the Find Product box, Enter Arm and click the Tab key (arm chair fills in).

8. Click the Add button.

• The system will add the Arm Chair product to your order.
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Creating a Multi-Line Order Order Entry
9. Click the Next button.

10. Select the Saved Payments icon next to the Payments Type drop-down.

11. Float the cursor over the Persons selection.

12. Click to select the Credit Card information that displays to the right. Note the informa-
tion autofills. 

13. Click Finish to place the order.

• Note that a user is not prompted that this order qualifies for auto-shipment since 
both products have the Requires Fulfillment box checked on their respective 
Products records.

14. Click Yes to create another Order.
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Order Entry Creating a Quotation
Creating a Quotation

At times, members will call to find out a Quote without purchasing the product. Aptify 
allows end users to create quotations.

1. From the Order Type drop-down list, select Quotation. Change Order Source to 
Phone.

2. In the Ship To field, enter the persons name. Click Tab to auto-fill. Click the Next button

3. To the Order Line, add your XYZ Product.

4. Click the Next button. Click Finish - quotations do not require payment information.

5. Click No to create another Order.

6. Click on the My Orders Today shortcut (Under the Orders Shortcut Group).

7. Double-click on the Quotation entry created above to open the Orders record.

8. Change the Order Type from Quotation to Regular.

9. Select the Saved Payments icon next to the Payments Type drop-down.

10. Float the cursor over the Persons selection.

11. Select the Credit Card information that displays to the right.

12. Click Save.

13. Change the Order Status from Taken to Shipped.

14. Click Yes to indicate that all items in the order have been shipped.

15. Click Save and Close.

16. Click the Refresh button on the My Orders Today view.

17. The Quotation is changed to a Regular Order.
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Ordering a Product w/Related Product Prompt

1. Click on the New Order Wizard (Order Entry Dashboard).

2. In the Ship To’s Name field, enter 1 and click the Tab key.

• Information from the Aiesha Baldwin record (who is Person ID 1) automatically 
populates the Name, Company, and Address field on the Ship To and Bill To sec-
tions.

3. Click Next.

4. Create an order line for the XYZ Product. User should try to do this on their own. Other-
wise, follow these steps:

• In the Find Product field, enter XYZ Product and click the Tab key.

• In the Quantity field, enter 1.

• Click the Add button.

5. Notice that the Related Product Prompt configured in the previous exercise now 
appears to the right of the Wizard. Drag the prompt to the center of the screen.

• Users may receive an error message if attempting to close the Related Product 
Prompt. An Allow Related Product Prompt Close option on the Employees 
form’s Details tab can be enabled in order to allow users to close this pop-up.

6. Double-click the plus (+) sign in the column on the far left of the dialog to automatically 
add one unit of the Financial Planning product to the order.

7. Click the Next button.

8. Next to the Payments Type drop-down, select the Saved Payments icon.

9. Float the cursor over the Persons selection.

10. Select the Credit Card information that displays to the right.

11. Click Finish.

12. Click OK.

13. Click Yes to create another Order.
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Ordering a Kit Product

1. Enter your Persons info for the address info.

2. Click the Next button.

3. Create an order line for 1 unit of your XYZ Kit Product.

• The price of the order is the kit price and not the sum of the individual products.

4. To the right of the Add button, click on the Expand checkbox to see the components.

5. The components of the Kit product display.

6. Click the Next button.

7. Next to the Payments Type drop-down, select the Saved Payments icon.

8. Float the cursor over the Persons selection.

9. Select the Credit Card information that displays to the right.

10. Click Finish.

11. Click Yes to create another Order.
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Processing a Price Adjustment

Aptify allows users to make price adjustments to an order. This ability will override any 
prices that are set in the system. This assumes that the Order Entry Permissions for the 
Organization, Employee, or Order allow users to override prices.

1. Create an order for 10 units of your XYZ Product.

• The Order line uses a price of $50 per unit, which is the Group Member price you 
created for the product.

2. Click in the Price field to display an ellipsis button.

3. In the price field, double-click to edit the price.

4. Enter 60 in the Price field.

5. Click out of the Price field and select Yes when the price override prompt appears.

• The price changes to $60/unit on the Order line and the Order Total updates to 
$600.
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Making a Partial Payment for an Order

In some cases, a customer/member may make only a down payment at the time the order is 
taken.

1. Click on the New Order Wizard (Order Entry Dashboard).

2. Create an order line for 1 unit of your XYZ Product.

3. Select the Saved Payments icon next to the Payments Type drop-down.

4. Float the cursor over the Persons selection.

5. Select the Credit Card information that displays to the right.

6. Change the Initial Payment Amount from $200.00 to $100.00.

7. Click Finish.

8. Users can process additional Payments by using the New Payment button on the Order 
Entry dashboard.
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Paying with a Purchase Order

1. Open a new Order.

2. Create an order line for 3 units of your XYZ Product.

3. Double-click the far left, non-editable field in the order line to open the Order Line 
Details window.

4. Change the Quantity from 3 to 5.

5. In the Discount field, enter 25.

• This will apply a 25% discount to the order line.

6. Click OK.

• Notice that the Quantity, Price, and Discount fields have been updated based on 
the changes made in the Order Line Detail window.
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7. Select the Customer tab (if not already open).

8. Click the Ship To Company link to open the XYZ Company record.

9. Select the Details >>Organization tab on the XYZ Company record.

10. Confirm that the Credit Status is set to Approved and the Credit Limit is set to 
$10,000.00.

• Only Companies or Persons that have Credit Status set to Approved and a Credit 
Limit that is greater than the Order Total can use a Purchase Order to place an 
order.

11. Close the XYZ Company record.

12. Set the Payment Type to Purchase Order under the Order’s Payment heading.

13. Enter 23 as the PO #.

14. Click Save and click No when asked if the user wants to ship the order.
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Marking Orders As Shipped

Once the products in an order have been shipped to a customer/member, users will need to 
change the Order Status from Taken to Shipped. For accounting purposes, General Ledger 
(GL) entries are created once an order is marked as shipped.

A user can manually open each Orders record and change the Order Status to Shipped (as 
done for the Order in Exercise 3) or a user can use the Marked As Shipped function 
(described in this exercise).

1. Observe the Orders Over the Last 30 Days view on the Order Entry dashboard.

2. All Orders should have a Taken By status.

3. Click to select all entries in the view.

4. Right click anywhere in the view and select Order Options > Marked as Shipped.

5. All Orders that qualify will now be marked as Shipped.

• Orders in a quoted status will not be shipped; only orders that have a payment 
associated with them can be shipped.

• This function is generally reserved/accessible for users who will be doing the 
actual packaging/shipping of the product. This function is also applicable to vir-
tual products that not need to be packaged, but do need approval to be shipped

6. Refresh the View and confirm that the Order Status is Shipped for the Orders.
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Canceling an Order with the Order Cancellation 
Wizard

In this exercise, users will cancel one of the XYZ Product Orders from a previous exercise.

1. In the View of Orders over the Last 30 Days, select the first order listed.

2. Click the Order Cancellation button on the dashboard.d

3. Review the welcome screen and click Next.

4. In the Order field, enter the first order number.

5. From the Cancellation Reason drop-down list, select Incorrect Product.

• Employee should populate automatically based on your user’s Employees 
record.l
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6. Click Next to continue.

7. Place a check mark next to the XYZ Product order line to indicate that both units are 
being returned.

8. Click Next to continue.

9. Using the wizard, a user can either keep credits that result from a cancellation on account 
to apply against future orders (as a Credit Memo) or a user can refund the amount. In this 
case, select Refund.

• The Refund Amount is automatically calculated to equal the Cancelled Amount. 
A user can specify a lower refund amount but not a greater one (the Refund 
Amount must be equal to or less than the Cancelled Amount).
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Order Entry Canceling an Order with the Order Cancellation Wizard
10. Click Next to continue.

11. Click Finish to generate the cancellation order.

12. When prompted, click Yes to open the cancellation order and review its details.

• Notice that the quantity of the order line is negative.

• Notice that the order total is a credit amount.

• Notice that the cancellation order is linked to the original order (via the Original 
Order field) and the Order Type is Cancellation.

• Notice that the payment is a refund amount equal to the cancellation order total. 
The original order was paid via credit card and the system automatically gener-
ated the refund payment to the same CC account.

Figure 10.1
Cancellation

Order

13. Change the Order Status to Shipped and save the order. 

• A user need to SHIP cancellation orders for three main reasons:

• Enable Inventory control to inspect the returned product.

• Credit the customers account if product satisfactorily returned.

• Generate GL entries that counter balance the original order’s GL entries

14. Close the cancellation order.

15. Click No when prompted to cancel another order.
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Objective

In this chapter, users will apply payments towards existing orders. The objective of this 
section is to demonstrate the multiple ways of applying payments.

Payments Overview

Payments are taken at the time of the order

• Using the Summary area

• All orders require an initial payment or Purchase Order number with approved credit 
before it can be saved

• System automatically creates a Payments record based on this information

Users can use the Payments service to create additional payments

• When a customer pays off a purchase order

• When a customer, who made an initial payment, pays off an entire balance

• When a customer who made an initial payment pays periodic installments to cover 
remaining balance
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Making a Payment Payments
Making a Payment

Summary Area on an Order Record

Users should access the Summary area to record any payment at the time of the order.

Users should open a separate Payments Record (from the Payments service) to record an 
installment payment or balance payoff.

Payments Record

When a user takes an order with a payment on it, the system automatically generates this 
record. 

Payment Lines - reflect payment made to the order. Automatically assumes full payment. 

If not full payment, the user can double click on the item and change the information.

If a user knows what the order the payment is for, they can use the accounting tab of that 
order to generate this form.
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Multiple Payments to An Order

1. Order an XYZ Product from your Persons’ record Orders tab.

2. In the Summary area, enter the payment type.

3. In the Initial Payment Amount field, enter in half of the total amount that is due for the 
order (as illustrated in Figure 11.1). 

• Note that a user cannot enter a partial payment using a Purchase Order payment 
type, as a purchase order is a promise to pay the full amount.

4. Click Save. Click NO to not ship the order.

• Note that the Balance field reflects an amount due after applying the partial pay-
ment. 

5. Select the Accounting tab and then click the Order Payments sub-tab.

• The system will display past payments applied to the order.

6. Click the New Record button to open a new Payments record.

• The system automatically displays the payoff amount of the order. For this exer-
cise, the payment amount will not be in full.
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Multiple Payments to An Order Payments
7. Double-click the Payment Line to open the Payment Lines record.

8. In the Amount field, enter half of the payoff amount.

9. Update the Comments to indicate that this is a partial payment.

10. Click OK.

11. On the new Payments record, select the Details tab.

12. From the Payment Type drop-down list, Select Visa.

13. In the CC Account # field, enter 4111111111111111.

14. In the CC Exp. Date field, enter 12/31/2014.
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15. Click Save and Close.

16. Return to the Order Payments sub-tab on the Orders record.

• Notice that the payment appears on the order.

17. Click Save.

18. Create another payment to pay off the remaining balance on the order.

• Review Steps 6 through 15 if assistance is needed with this step.

19. Click Save and Close.
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A Single Payment to Multiple Orders

By using the Payments service, users are able to apply a single payment to multiple orders. 
The Payments service is found under the Order Entry application.

1. Open the New Order Wizard (Order Entry dashboard).

2. Create an order line for your XYZ Product.

• The total should be $100.

3. From the Payment Type drop-down list, select Purchase Order.

4. In the PO # field, enter 555.

5. Click Finish. 

6. Repeat steps 1-4 (use 556 for the PO #).

7. Observe the Orders over the Last 30 Days (Order Entry dashboard).

8. Write down the TWO PO Order IDs: _____________

9. From the Order Entry dashboard, select New Payments button.

10. Click the Order # button and enter the ID for one of the orders written down in Step 8. 

11. Click OK.

• A payment line is added for the full amount remaining on the order entered.
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12. Click the Order # button again and enter the ID for the other order from Step 8.

13. Click OK.

• A second payment line is added to the form.

14. Select the Details tab.

15. From the Payment Type drop-down list, select Pre-Paid Check.

16. In the Check Number field, enter a check number.

17. Click Save and Close.

18. Open the Orders Over the Last 30 Days view (Order Entry dashboard).

• Notice that the two orders Balance Total is now $0.00.

19. Open one of the orders from step 8 and select the Accounting > Order Payments tab.

• Notice that the payment created appears under the Accounting tab.

20. Close all open records.
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Apply a Single Payment to Multiple Order Lines

At times, customers may only send a payment to pay for one item on a Purchase Order. 

1. Open a new Order from the New Order Wizard.

2. Create order lines for the following products:

• Line 1: 3 Sampco Baseball Hats

• Line 2: 2 XYZ Kit Product

3. From the Payment Type drop-down list, select Purchase Order.

4. In the PO # field, enter 899.

5. Click Save.

6. Write down the amount in the Extended column for each order line item.

• Line 1: ___

• Line 2: ___

• The order should have two order lines.

7. Save and Close the order.

8. Click on the New Payment button.

9. Click the Order # button.

10. Enter the Order ID from Step 7 and click OK.

• Aptify adds a payment line for the full amount owed on the order.

11. Double-click the payment line to open the Payment Lines record.

12. Click the Applies To drop-down list and select Order Line.

13. From the Order Detail drop-down list, select order line 1 to apply a payment only 
against the Sampco Baseball Hat order line.

14. On the Payment Lines record, enter the extended amount for Line 1 in the Amount field.

15. Edit the Comments field and indicate this payment applies to one line of the order.
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16. Click OK.

17. To open a second Payment Lines record, click the New button.

18. Click the Applies To drop-down list and select Order Line.

19. In the Order field, enter the Order ID from Step 7.

20. From the Order Detail drop-down list, select order line 2. 

21. In the Amount field, enter the extended amount for Line 2.

22. In the Comments field, enter Payment for 2 XYZ Kit Product.

23. Click OK.

• Note that the Payment Total has increased to cover the entire order total.

24. On the new Payments record, select the Details tab.

25. From the Payment Type drop-down list, select American Express.

26. In the CC Account # field, enter 333331111122222.

27. in the CC Exp. Date field, enter 1/1/2012.

28. Click Save and Close.
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Over Payments

At times, a user may receive payments in the mail that are written for more than the balance 
due on orders. Aptify will allow processing of an overpayment. The overpayment will be 
considered a Credit Memo. The Credit Memo can be applied for future purchases by linking 
the credit order to a new Orders record.

In this exercise, a user will process an overpayment for an order and create a credit memo.

1. Create a new Order for one unit of the Sampco Baseball Hat product.

2. Enter a PO payment type with the PO number of 778.

3. Save but do not close the order.

4. Select the Accounting tab and then select the Order Payments sub-tab.

5. Right click under the Payments area and select New Record from the pop-up list.

• A new Payments record appears, with a payment line for the balance on the order.

6. Double-click the payment line to open the Payment Lines record.

7. Edit the Comments field to indicate that this payment line applies to 1 unit of Sampco 
Baseball Hat product. Click OK to close this record.

8. To open a second Payment Lines record, Click the New Record button.

9. In the Order field, enter the Order ID for the order opened in Step 1.

10. Leave the Applies To set to Entire Order.

11. In the Amount field, enter $200.

12. In the Comments field, Enter Customer Overpayment.

13. Click OK.

• The Payment Total updates to $200 greater than the order amount.
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14. Select the Details tab.

15. From the Payment Type drop-down list, select Pre-Paid Check.

16. In the Check Number field, enter a check number.

17. Click Save and Close.

18. Click Save on the Orders record.

• Notice that the Balance on the order has been updated to (200.00), indicating that 
the Person has a $200 credit. This order can be referenced as a Credit Memo to 
pay for another order from the same Person or Company.
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Objective

In Associations and Membership based organizations, the most important aspect tracked is 
Membership. In Aptify, Membership is considered a Subscription based product due to 
the tracking of deferred income. 

The Subscriptions service keeps track of products sent to a Person on a recurring basis, such 
as membership, magazines, newsletters, or journals. Unlike a regular product item, a 
subscription product has the ability to track persons who are purchasing future issues and 
fulfill their orders based on their status.

Recall that Aptify allows users to create “extended” products that support additional product 
features based on the product type. Extended products, however, can also be a subscriptions 
product and sent to a customer regularly. A membership or a monthly journal are examples of 
extended, subscription products.

In this chapter, users will primarily be focused on Membership Subscription products/
orders, but these same steps/processes can be applied to Magazines, Periodicals, 
Newsletters, etc.
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Two Types of Subscriptions

There are two types of basic subscriptions that will be examined in this chapter:

• Manually renewed Membership Subscription

• Subscription is ordered

• Subscription is shipped

• User Opens up a monthly view of Subscriptions for desired month

• User runs the Subscription Renewal Wizard from View’s toolbar

• Order Quotations are generated for that Subscription

• User generates invoices and sends them to customers

• Upon receipt of new payment, user changes Subscription order from status of 
Quotation to Shipped

• Auto-renewed Membership Subscription

• Subscription is ordered

• User opens up the Order line for the Subscription

• User clicks the Auto Renew checkbox on the Subscription tab

• Subscription is shipped

• User can open up the Subscription order that was generated

• User can open the Renewal tab & click on the Standing Order link to modify:

- Date Expires (match CC info/desired length of subscription)

- Schedule

- Order Information (change recipients)

• User runs Standing Order Fulfillment Wizard periodically to fulfill subscrip-
tions that have associated standing orders

Membership Subscription Length/Number of Copies

Same basic order process as for other product types except:

• Changes in an order line Quantity increase length of subscription

• For example, ordering a Monthly Newsletter with a quantity of 2 creates a 
two-year subscription

• Ordering multiple copies of each issue for same Person/Company

• Known as a “Bulk Subscription”

• Specify number of copies on Order Line Details form

• Order Total increases automatically if the number of copies increases
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Creating a Membership Dues Product

1. Click the Product Maintenance Application; open a new Products record.

2. In the Name field, enter XYZ Membership Dues (where XYZ are your initials).

3. In the Category field, enter Memberships.

4. Verify that Type is set to General.

5. Select the Subscription tab.

6. In the Subscription Item checkbox, place a check mark.

7. From the Subs. Type drop-down list, select Monthly.

8. In the Issues field, enter 12.

• Even though this is a one-year membership, a user configures the Subscription 
Type to Monthly with 12 issues to comply with General Accepted Accounting 
Principles (GAAP).

9. In the Grace Period field, enter 1.

10. Verify that the Restart After Days field is set to 180.

11. Change the Restart By field to Restart with New Subscription.

12. Select the Membership sub-tab (Under Subscription tab).

13. In the Dues Product checkbox, place a check mark.

14. In the Member Type field., enter Member

15. Leave the Member Start Date field set to Use Subscription Settings.
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16. Select the Accounting tab and verify that the Deferred Income checkbox is checked.

17. Select the Prices tab.

18. Add a default Non-Member price of $500.

19. Add a Member-Renewal price of $250.

20. Save and Close the record.
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Understanding Membership/Subscription Dates

By default, a subscription in Aptify begins on the date the order is taken and ends when 
all the issues have been fulfilled or the subscription is canceled. However, if a subscription 
or membership is annual, a user can specify a Start Date and Turnover Date in the 
subscription's Products record to create a renewal range. 

• Any membership subscription created after the current Start Date but before the 
next Turnover Date is assigned the current year's subscription. 

• Any membership subscription created after the Turnover Date and before the 
next Start Date is assigned next year's subscription. 

For example, if the current membership subscription cycle started on January 1st and the next 
turnover date is March 31st, a subscription order placed on March 15th would have a start 
date of January 1st. The subscriber may receive back issues for the first three months of that 
year and then continue to receive monthly issues for the rest of the subscription period 
depending on the organization's business practice. 

An order for the same product taken on April 1st would begin on January 1st of the following 
year because the order was taken after the turnover date. 

If no dates are entered in the Start Date and Turnover Date fields, a subscription begins on 
the date the order is taken and ends when all the issues have been fulfilled or the 
subscription is canceled. 

Understanding Membership/Subscription Renewals 

Organizations can determine how to handle lapsed subscriptions using the subscription 
product’s Renewal Behavior settings. For example, an organization may wish to treat a 
renewal that is less than 60 days late as part of the original subscription, while classifying 
renewals after 60 days as new subscriptions. 

Suppose, for example, that a customer wishes to renew their membership after it has lapsed 
for one year. Users would not want the subscription start date to be the end of their last 
subscription, since then their membership would expire immediately. In this case, the 
membership should be treated as a new subscription.

Alternatively, if a customer is only 30 days past due for renewing, an organization may wish 
to consider any membership purchase as a renewal, since the organization may offer benefits 
for maintaining continuous membership.

Note that while the system changes the Member Type of a Persons record or 
Companies record to a member status when the membership product is 
purchased, it does not change the Member Type back to a non-member status 
when the membership expires. This allows for an arbitrary grace period to be 
established. A view can be set up to list all persons or companies whose 
memberships have expired for X number of days, and then manually change 
their membership status back to a non-member type. Alternatively adminis-
trators can create an Entity Bulk Operation to update records in one operation.
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Ordering a Membership Dues Product

This exercise demonstrates how a Non-Member places an order for a dues product and how 
their Non-Member status automatically changes to a Member status.

1. Open a Persons record.

2. Select the Membership tab.

3. Note that the Member Type, Co. Member Type, and Root Co. Member Type are set to 
Non-Member.

4. Select the Orders tab.

5. In the toolbar, click the New Record button.

6. Create an order line for 1 unit of XYZ Membership Dues. (Find XYZ membership prod-
uct, click ADD)

7. Enter payment information (use either Pre-Paid Check or a Credit Card). If CC, checkbox 
at bottom labeled, Save for future use.

8. When asked if the user wants to ship the order, click Save and click Yes.

• Click the Refresh button.

• Notice that the Customer Type reported on the Order changes to Non-Member/
Member.
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9. From the order record, select the Subscriptions tab.

• Notice that a Dues Subscription was created for this order.

10. Save and Close the order to return to the Persons record.

11. At the top of the Persons record, click the Refresh button.

12. On the Persons record, select the Membership tab.

13. Note the following changes that were made to the Membership tab:

• The Member Type has changed to Member.

• The Dues Information section is now filled in.

14. Close the Persons record.
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Manually Renewing Memberships/Subscriptions

The Subscription Renewal Wizard examines a Subscriptions record and generates a quotation 
order for the Subscription product. Once the Quotation is created and a customer indicates 
they wish to renew, users can change the quotation order to a regular order, and renew 
the subscription.

Aptify recommends configuring the messaging system to automatically email customers 
whose subscription will soon expire, reminding them to renew. This can be done by creating a 
view of subscriptions that will end within a certain time frame, and using the Subscription 
Renewal Wizard to create quotation orders for each subscription. 

Users can then create a view of quotation orders and send a pre-configured message to each 
person associated with the orders. Different messages may be sent depending on when the 
subscription will expire, so that customers know when they must renew by, as well as how to 
renew.

Follow the steps below to manually renew a subscription:

1. Click the Membership dashboard.

2. Observe the All Active Subscriptions view.

3. Select the Membership Dues subscription at the very top - sorted by ID.

4. Click the Subscription Renewal Wizard icon in the View Toolbar.

5. When prompted that the user is renewing 1 subscription, click OK.

6. In the Due Date field when prompted, enter the last date of next month.
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7. Click OK to continue.

8. When prompted that the renewal process is complete, click OK.

• Aptify automatically created an order quotation for the subscription renewal.

9. Click the Order Entry dashboard

10. Look under the Orders Over the Last 30 Days view.

11. Locate the most recent order whose Ship To Name is your Person

• This should be the order in the view with the highest ID number since it was the 
last order created by the system using your Employees record.

12. Double-click to open the quotation order.

13. Change the Order Type from Quotation to Regular.

14. In the Summary area, enter the payment information (use Pre-Paid Check or credit card).

• Note that the Payment Type defaults to Purchase Order for quotations created by 
the renewal wizard.

15. Click Save and click Yes to ship the order.

16. Select the Subscriptions tab.

• Notice that the End Date is now two years from the Start Date. If a user opens the 
Subscriptions record, the number of Issues Purchased on the Marketing tab has 
increased to 24.
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Auto-Renewing Memberships/Subscriptions

Auto-Renewing subscriptions automatically generate standing orders that can regularly be 
converted to regular orders. Once the regular order is shipped, the subscription is renewed. 
Aptify strongly encourages all organizations to use auto-renewal, so that customers never 
forget to renew their membership. 

1. Click the Order Entry Application

2. Click the New Order Wizard.

3. Enter a persons’ record information. Create an order line for 1 unit of your XYZ Sub-
scription product.

4. Open the Order Lines record by double-clicking the orange box to the far left.

5. Select the Subscriptions tab of the Order Lines record.

6. Check the Auto Renew checkbox.

7. Click the OK button.

8. Finish processing the order in the New Order Wizard.

9. Ship the order from the Orders Over the Last 30 Days view.
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Fulfilling the Auto-Renewal Standing Order

1. Click the Membership dashboard.

2. Observe the Active Standing Orders view.

3. Select the Membership Dues standing order at the very top - sorted by ID.

4. Click the Standing Order Fulfillment Wizard... button in the View Toolbar to launch 
the wizard.

5. Click Next to continue.

6. Select the Process Only The Highlighted Records In The View option.

7. Click Next to continue.

8. For Step 2, the wizard automatically inserts today’s date as the Order Date. Click Next to 
continue without changing the Order Date. 

9. To process the Standing Order, click Finish and then when prompted, click OK.

10. When notified that the Standing Order fulfillment completed successfully, click OK.

11. Within the Standing Orders view, double-click to open the standing order that was just 
fulfilled.

12. Select the Purchases tab.

13. There will be no record here until the date of shipment has been reached (i.e. the first day 
of the subscription), then deferred income will be actualized.
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Cancelling a Membership/Subscription

Subscriptions - Full Cancellation

1. Open the New Order Wizard from the Order Entry dashboard.

2. Create an order line for 1 unit of your XYZ Subscription product.

3. Enter the payment information - use saved credit card info.

4. Ship the Order from the Orders Over the Last 30 Days view.

5. In the View Toolbar, click the Order Cancellation Wizard button to launch the wizard.

6. Click Next.

7. In the Order field, enter the ID of the order created above (the subscription).

8. From the Cancellation Reason drop-down list, select Incorrect Product.

9. Click Next.

10. To the left of the row for the XYZ Subscription order line, place a check mark. Leave 
the Cancel Quantity set to 1.

11. Click Next and follow the on-screen instructions to complete the cancellation process.

• When prompted to select a balance type, select Refund. If prompted, in the 
Check Number field, enter “12345” for the refund check.

12. To open the cancellation order when prompted, click the Yes button.

13. When prompted, change the Order Status to Shipped and select Yes.

14. Save and Close the order.

15. When asked to process another cancellation, click No and close the wizard.

16. Open the view of the Subscriptions service.

17. Double-click the entry to open the corresponding Subscriptions record.

• Notice that the Status field is set to Cancelled and the Cancellation Order 
cancelled all 12 issues of the monthly subscription.
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18. Select the Marketing tab.

• Notice that the number of Issues Purchased is 0.

19. From the Reason Cancelled drop-down list, select No Longer Needed.

20. Click Save and Close.
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Subscriptions - Partial Cancellation

1. Open a new Orders form from the Persons record.

2. Create an order line for 1 unit of your XYZ Subscription product.

3. Enter the payment information in the Summary area (use Pre-Paid Check or Credit Card).

4. When asked to ship the order, click Save and click Yes.

5. Select the Subscriptions tab to confirm that a Subscription has been generated.

6. Save and Close the order.

7. Open a view of the Orders service.

8. Select the most recent order.

9. In the View Toolbar, click the Order Cancellation Wizard button to launch the wizard.

10. Click Next to begin the wizard.

11. Observe that the ID of the order created above (your Persons subscription) is already 
entered in the Order field.

12. Leave the Cancel Reason field blank.

13. Click Next.

14. In the checkbox for the XYZ Subscription order line, place a check mark. 

15. Set the Cancel Quantity to .5. 

• This will cancel half of the subscription. Therefore, for a 12-month subscription, 
this will cancel 6 issues. 

• Note that a user can also enter a fraction (such as 6/12) in the Quantity field and 
Aptify will automatically convert the fraction to the decimal value.

16. To complete the cancellation process, click Next and follow the on-screen instructions.

• When prompted to select a balance type, select Keep On Account.

17. Click Yes when asked to open the cancellation order.
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18. Change the Order Status to Shipped and when prompted, select Yes.

19. Save and Close the order.

20. When asked to process another cancellation, click No.

21. Open the view of the Subscriptions service.

22. Double-click the most recent entry to open the Subscriptions record.

• Notice that the Subscription’s Status is still Active but the End Date for the 
original subscription purchase is 6 months out rather than 1 year).

23. Select the Marketing tab.

24.

• Notice that the number of Issues Purchased is 6.
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Objective

In this chapter, users will have the opportunity to work with Campaigns. This includes:

• Creating Campaigns, manually or using the Campaign Setup Wizard

• Creating Campaign Segments to target users’ marketing efforts

• Adding Persons to a Prospect List

• Apply a Campaign to an Order

Campaigns Overview

Allows organizations to create different marketing campaigns 

• Sales to move products

• Campaigns to increase product awareness

Within the service, organizations have the ability to:

• Discount products based on Membership type

• Discount Products and/or Product Categories

• Tie a Prospect List to a campaign

• Track Prospect status

• Whether they have accepted or declined the marketing offer

• Track Documents and Tasks related to a Campaign effort

At the time of order, the order entry clerk can specify a campaign for the entire order or 
apply the campaign to a specific order line
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Using the Campaign Setup Wizard

The Campaign Management application enables users to incorporate products specifically 
tied to a marketing campaign in order to offer discounted prices. Once a campaign is tied to 
an order, all products linked to the campaign will display the appropriate discount.

1. Click to open the Campaign Management dashboard.

2. Click the Campaign Setup Wizard button.

3. In the Name field, enter XYZ Campaign.

4. In the Description field, enter Introduce XYZ Product.

5. Enter an End Date of one month from today.

• The wizard automatically populates today’s date in the Start Date field. Users 
can modify this date as necessary.

6. In the Coordinator field, enter the Employee.

7. Select the Invitation Required checkbox.

• When checked, only persons and companies in the Campaign’s prospect list with 
a status of Invited will be able to respond to the campaign.

8. Click Next.

9. Leave the Status as In-Progress.
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10. In the Type field, enter Marketing.

11. Click Next.

12. Select No to not add category pricing and click Next.

• Discount Pricing can be added for a whole Category of different products.

13. Select Yes to add per-product pricing to the campaign and click Next.

14. In the Product field, enter XYZ Product.

15. In the Discount Type column for both Member & Non-Member row, select Discount %.

16. In the Amount field for the Member row, enter 20%.

17. In the Amount field for the Non-Member row, enter 10%.

18. In the Amount field for all other Member Types, enter 20%. 

19. Click Next.

20. When asked if a user wants to enter another product, select No, and click Next.

21. Click Finish to create the Campaigns record and click OK when the prompt appears.

22. Open the Campaigns record just created. 

23. Select the Discounts tab and note how the wizard applied the settings to the record.

24. Click Close.
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Adding Prospects to a Campaign

A list of prospects can be added to campaigns to identify the target audience for a direct 
marketing campaign. Aptify provides several technique to add Persons to a Campaign’s 
Prospect List. 

1. Open the XYZ Campaign record (if not already open).

2. Select the Prospect List tab.

• Click the New Record button to open a new Campaign List Detail record.

3. From the Type drop-down list, select Person.

4. Use the Find Items dialog to locate the Habika Harris record (ID 8). 

• After selecting the record, Harris, Habika/X.E. Awaken Components Limited 
should appear in the Person field.

5. The Prospect Status field should default to Invited.

• After a Person has responded to the marketing offer, they would return to this 
screen and change the Person’s status as appropriate.

6. Save and close the Campaign List Detail record.

7. Open a second Campaign List Detail record from the Campaign’s Prospect List tab.

8. From the Type drop-down list in the second row, select Company.

9. Use the Find Items dialog to locate the U. Hardwick Physics AB record (ID 2). 

10. Clear the Prospect Status field and enter Invited.

11. Click Save and Close.
13.4 Aptify End User Training Manual



Campaigns Adding Prospects to a Campaign
12. Open the All View of Persons.

13. In the All View, select the first 8 persons that display.

14. In the View Toolbar, click the Add to Campaign button.

15. Use the Find Items dialog to select the XYZ Campaign record.

16. Click OK when prompted to add the Persons to the selected campaign.

17. Click OK after the records have been added to the campaign.

18. Open your XYZ Campaign record.

19. Confirm the 8 Persons from the All View have been added to campaign’s prospect list.
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Creating a Campaign Segment 

An organization can use Campaign Segments to identify the target audiences for a marketing 
effort targeting multiple groups. In this exercise, users will create a Campaign Segment for 
the XYZ Product Launch Campaign.

1. Open a new record from the Campaign Segments service.

2. In the Campaign field, enter XYZ Campaign.

3. In the Name field, enter SF Student Members.

4. From the Filter Type drop-down list, select View.

5. From your shortcuts, select the San Francisco Student Members view.

6. In the Rank field, enter 1.

7. Click Save.

8. Close the record.
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Adding Prospects from a Campaign Segment

1. Open a view of the Campaigns service.

2. In the View Toolbar, click the Campaign List Builder Wizard button.

3. Click Next to begin the Aptify Campaign List Builder Wizard.

4. In the Campaign field, enter XYZ Campaign.

5. Select the Initialize List checkbox. 

6. Clear the Preserve Manual List Entries. If this was left checked, the wizard would 
leave intact any prospects that were manually added to the list but not add any of the Seg-
ment values.

7. Select No Response from the Default Status drop-down list.

8. Click Next.

9. When prompted, click Finish that the campaign has been built.

10. Open the XYZ Campaign record.

11. Review the list of Prospects that were added by the Campaign Builder Wizard.

• Each Person from the San Francisco Student Members view has an entry in the 
Prospect List.
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Applying a Campaign to an Order

In this exercise, users will learn how to apply a campaign to an entire order and to each 
individual item in an order.

Applying a Campaign to an Entire Order

1. Open the Order Entry Application.

2. Click on the Orders Service.

3. Right click the Service arrow, select New Orders Record.

4. In the Campaign field (left middle portion of record) enter XYZ Campaign.

• When applying a single campaign to an entire order, a user MUST enter the 
Campaign first before adding products to the order.

5. In the Ship To field, enter Mary Warner (use the format: Warner, Mary).

Note that a user can use Campaign pricing with any Person; the Person does not need to be 
on the Campaign’s Prospect 
List.

6. Create an order line for 2 units of XYZ Product.

• Note that the Campaign Discount is applied automatically. Since Mary Warner is 
a Non-Member in the example above, the discount is 10%. The specific discount 
rate may vary depending on the current membership status of Mary Warner and 
her company in the training database.

7. Click Next. 

8. Enter payment information on the Payment tab.

9. Save the record and click NO when asked if the user wants to ship the order.

10. Click Save and New.
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Applying a Campaign to Each Order Line

1. Enter a Person in the Ship To field. (This is the Persons record created previously).

2. Create an order line for 1 unit of XYZ Product.

3. Double-click a non-editable field (such as Product name) in the Order Line row to open 
the Order Lines record.

4. Enter XYZ Campaign in the Campaign Code field.

• The system automatically calculates the appropriate discount percentage based 
on the person’s and company’s member type. In the example below, the person or 
company is a member so the discount is calculated as 20%.

5. Click OK.

6. Create an order line for 1 copy of the book called The Sampco Way.

7. Double-click a non-editable field (such as Product name) in the Order Line row to open 
the Order Lines record.
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8. In the Campaign Code field, enter XYZ Campaign.

• Notice that a discount is applied to the order line. For example, if the person and 
company on the order are both non-members, the discount percent is 1%. This 
corresponds to the $1.50 discount for non-members specified when creating the 
campaign in Exercise 2. (The Order Entry system automatically calculates the 
percentage discount: $1.50/$150.00 = 1%.)

9. Click OK to return to the order.

10. Save the record and click No when asked if the user wants to ship the order.

11. Close the order.
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Objective

The Meetings function enables users to track meetings, meeting sessions and meeting 
registrants. After completing this exercise, users will be able to:

• Copy an existing Meeting using the New Meeting Wizard

• Understand the parts of the Meeting record

• Order a meeting and register additional students on an order

• View all meeting Registrants

• Close a meeting and track Attendees

Overview

“Extended” product type

• Supports Meeting-specific features in addition to the General Product features

• Same setup and configuration as a standard Product

• Meetings use a Products record that includes an additional Meeting tab

Tracks meeting registrants, attendees, and additional information about the meeting

• Uses Aptify Inventory system to manage meetings with limited space

• Nearby hotels for attendees

• Meeting Location

• Required resources (such as audio/visual equipment)

• Sessions
14.1
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Using the New Meeting Wizard

The New Meeting Wizard enables users to create a new meeting based on the information 
entered in an already existing meeting. This can save valuable time as Meeting coordinators 
often have similar meetings scheduled throughout the year that they can simply copy and then 
adjust details concerning such as dates, time, speakers, location, etc.

In this exercise we will use the New Meeting Wizard to copy an existing XYZ Meeting and 
make some modifications to make it unique.

1. Click on the Meeting Management Application.

2. Click on the New Meeting Wizard button.

3. The first screen of the Meeting Wizard will display.

4. In the Copy Existing Meeting field, enter XYZ Meeting (exactly; do not substitute xyz 
for your initials).

5. Click the Tab button. Click to Select a meeting. 

6. Click the Next button.
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Meetings Using the New Meeting Wizard
7. The second screen of the New Meeting Wizard displays.

• On this screen users can edit the basic information concerning the meeting such 
as the name, date, coordinator, etc.

8. Change the New Product Name field to your initials plus the word Meeting (i.e. DOC 
Meeting).

9. Change the Start Date and Time to next week on Monday.

• The year should automatically have defaulted to the current year.

• IGNORE the dates in the screenshot; these are just placeholders

10. Change the End Date and Time to next week on Friday.

11. Click the Next button.
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12. The third screen of the New Meeting Wizard displays.

• This screen enables users to edit the Meeting Logistics and information such as 
Location, Sponsors, Topic Codes, etc.

13. Leave the information intact.

14. In the Meeting Title column, double-Click on the Meeting Title, XYZ Session I

15. Observe that the basic information could be edited for the Session at this time.

• Observe the dates have automatically justified based on the date choices for the 
main meeting on Wizard screen #2.

16. Click OK.
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Meetings Using the New Meeting Wizard
17. Click the Next button.

18. Click the Finish button.

19. The finished Meeting Product record will now display.

20. Observe the changes to the Name and Date that were made in the wizard.

21. Select the Meeting Logistics tab.
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22. The Location tab defaults as displayed.

• The Meeting Logistics tab displays the information that has been stored specifi-
cally for this Meeting including the Sessions.

23. Observe the Location tab information.

• This tab displays information about the location of the meeting and can include 
room information as well. 

• Venue and Room records can be created/saved to create a database of reusable 
values

24. Select the Sessions tab.
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25. The two sessions that carried over from the Wizard are available.

26. Double-click the XYZ Session I record and change the Product Name and Meeting 
Name to your initials.

27. Save and Close the record.

28. Double-click on the XYZ Session II record and change the Product Name and Meeting 
Name to your initials.

29. Save and Close the record.

30. Select the Speakers tab.
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31. The Speaker that was designated on the original record displays.

32. Double click on the Speakers record.

33. Change the Start Date to next Monday at 9:00 AM.

34. Change the End Date to next Monday at 10:00 AM.

35. Click the OK button.
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Meetings Using the New Meeting Wizard
36. Select the Sponsors tab.

37. Sponsors can be added, edited, and deleted as needed.

38. Select the Hotels tab.

39. Hotels and their locations, offers and directions can be added, edited, and deleted as 
needed.

40. Select the Resources tab.

41. Resources and their types, quantity, start and end dates can be added, edited, and deleted 
as needed.
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42. Select the Education Units tab.

43. Education Categories can be set up to track how many Continuing Education Units an 
attendee will receive for attending a particular meeting.

44. Double click on the Continuing Education Units line.

45. The Meeting Education Units Record displays.

46. These records can be added and edited to fit the class requirements.

47. Once a student is marked as Attended (But not just as Registered) for this meeting he or 
she will automatically receive the designated number of credits.

48. Click OK on the Meeting Education Units record.

49. Save and Close the Meeting record.
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Creating Meeting Registrations

In this exercise, a user will order three of the XYZ Meeting products just created so that a user 
can register three separate individuals for that meeting (your Person and IDs #1 and #2). A 
user will also order the associated sessions for just your Persons record.

1. Click the Order Entry dashboard.

2. Click the New Order Wizard button. Enter a Persons’ information for Ship To.

3. Add XYZ Meeting to the Order Line.

4. When a user Adds the product, a pop up window will display with Registration and Ses-
sion information.

• The auto-pop up of the Order Line/Registration information can be enabled at the 
Product level on a per Product or per Category level.

5. Check the box next to XYZ Session I.

6. Select the Dec. 28 20xx tab.

7. Check the box next to XYZ Session II.

8. Click the Save button. 

9. On the success message, Click OK.
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10. DO NOT close the Pop up window

11. Observe BOTH the Meeting product and each of the Sessions have been added as Regis-
trations to the Order Lines. 

12. In the Pop up window, delete your name from the Registrant field.

13. Enter ID #1 (Aiesha Baldwin)

• This will now register a second person from this Pop Up window

14. Clear the two Sessions; to only register Aiesha for the Main Meeting.

15. Click the Save button.

16. On the Success pop up, click OK.

17. Repeat steps 11-15 for ID #2 (Alexandra Wade).

18. Close the Pop up window (x in upper right).

19. Observe the complete Order Lines:

20. Enter the Payment at the bottom of the screen using the saved Credit Card.

21. Click Save and Close. 

22. Click Yes when asked if the user wants to ship the order.
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Placing a Person on the Waiting List

1. Open a new order from the New Order Wizard using ID #3 (Athena Scott). 

2. Order one of the XYZ Annual Meeting. Click Add.

3. On the Waiting List Warning Pop up, click OK.

4. The Registration Pop up will display.

5. Click Save.

6. Click OK.

7. Enter a Payment with a Pre-Paid Check number of 1234.

8. Click Save. 

9. Click Save and Close.

10. Click No when asked if the user wants to ship the order.

• The order can not ship since the meeting lacks sufficient inventory.

• The order will remain in a Taken status.
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Checking Meeting Registrants

1. Click the Meeting Management dashboard.

2. Observe the Registration By Count dashboard View.

• Shows registrations by Meeting

• Shows registrations by Session

3. Expand the Meeting Management application (if not already expanded).

4. Expand the Meetings service.

5. Run the pre-loaded Wait List prompted view.

6. Observe the results; Athena Scott should display.

NOTE: These are just two of multiple methods to find and see this information. 
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Canceling a Registration

The Order Cancellation wizard can be used to cancel orders that have one or more meeting 
registrations. In this exercise, users will employ the wizard to cancel the second person 
ordered for a Meeting registration.

1. Open the view titled, Orders Over the Last 30 Days.

2. Identify and highlight the Order ID that has three XYZ Meeting Registrations.

3. Launch the Order Cancellation Wizard (top of the view)

4. Enter the Cancellation Reason.

5. Click Next.

6. The Cancellation wizard displays all order lines.

7. Check the box to the left of the order line for the Alexandra Wade.

8. Click Next to continue.

9. Select Keep On Account and click Next to continue.

10. Click Finish to generate the cancellation order.

11. Click Yes when prompted to open the cancellation order.

12. Change the Order Status to Shipped. 

13. Select Yes when asked if all items have shipped.

14. Save and Close the cancellation order.

15. Click No when asked if the user wants to process another cancellation.

16. Open the Person record for Athena Scott.

17. Select the Orders tab.
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18. Open the order for the XYZ Meeting.

19. Click on the order line.

20. Select the Meetings tab.

21. Change the Status from Waiting to Registered.

22. Click OK.

23. Change the Order Status from Taken to Shipped. Click Yes when asked if all items 
have been shipped.

24. Save and Close the record.

25. Open the Meetings record (if not already open).

26. Confirm that the person has been moved from the Wait List tab to the Registrants tab on 
the Meeting Product.
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Closing a Meeting

1. Open the Meetings record (if not already opened).

2. Select the Meetings tab and select the General sub-tab (if necessary).

3. Change the Status from Planned to Occurred.

4. Click the Close Meeting... button.

5. From the Filter drop-down list, select Registered.

• This displays only the meeting’s Registrants.

6. For the first entry, click the Status field and select Attended from the drop-down list.

• This method can be used to change the Status for each Person individually.

7. Click the Change All button.

8. From the Status drop-down list, select Attended.
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9. Click OK.

• The Status changes to Attended for all Persons in the list.

10. Click OK to close the Close Meeting Wizard.

11. Click OK to update all Registrant information.

12. Select the Attendees tab.

• Confirm that all three registrants are now listed under the Attendees tab.

13. Click Save and Close to close the Meetings record.
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Transferring a Meeting Registration

The meeting transfer wizard is able to perform two functions for an existing meeting regis-
tration. It can substitute a different person for the same meeting, or it can transfer a person’s 
existing meeting registration to a different meeting.

• The wizard is available for orders in either a Taken or Shipped status

• For Shipped Orders, the process creates a cancellation order and then a new 
transfer order

1. Create an Order for the Golf Meeting (ID 9927).

2. Save and Ship the Order.

3. Open up a View of All Meetings (may need to create).

4. Click on the Meeting Transfer Wizard button.

5. Enter your Persons name in the Persons field.

6. Enter the Golf Meeting (ID 9927) in the Meeting field.

Note: If a user remembers the Order ID, they can put that in the Order field without 
filling out the Person or Meeting fields.

7. Click the Next button.
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8. Enter Aiesha Baldwin (ID #1) in the New Attendee field.

9. Enter the Golf Meeting (ID 9927) in the New Meeting field.

10. Select the Line 1 box.

11. Click the Transfer button.

12. Click the Next button.

13. Click OK at the Credit Card/Credit Memo message.

14. Click the Next button.

15. Review the Advanced Settings/Payment Reconciliation screen.

• Users could select a Transfer Fee to apply

• Users could change the Payment Type or Keep on Account

16. Click Next.

17. Click Finish.

18. Click Yes at next 2 Ship screens; user shipping both Transfer and Cancellation Orders.

19. Click No to sign up other Sessions.

20. Click No to Transfer another Person.
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Objective

Aptify web interface allows users to access most Aptify functions through a web browser 
such as Google Chrome. In addition, it provides many new features that make using Aptify 
even easier than with the Aptify Desktop client.

In this chapter, you will learn:

• How “Spaces” can be used to quickly perform common tasks and share information

• How Global search can locate views and records across the entire Aptify system

• How to create a new Persons record and place an order for that person
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Overview

Aptify web interface uses HTML5 web-technology to provide users with Aptify access from 
any device with a web browser and internet connection. 

Figure 15.1
Aptify web

interface
Dashboard

This includes desktop computers, laptops, tablets, or other mobile devices, such as phones. In 
addition, if a user ever loses internet connectivity, the interface automatically saves the last 
changes the user made and synchronizes with the Aptify database once the network 
connection is restored.
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Spaces

“Spaces” in Aptify web interface are the equivalent of a social media newsfeed, where users 
can see other users’ most recent Aptify activity, as well as post their own updates.

Figure 15.2
Aptify web

interface
Spaces

Spaces also function as a gateway for users to quickly perform common functions, including 
creating Contact Logs, assigning Tasks, and updating records. Users can even link directly to 
specific records from within a post, which can save users time locating specific data.

Figure 15.3
Linking to

Records in
Spaces

In addition, users can configure their Spaces to notify them if certain events occur. For 
instance, a user may wish to be notified if their corresponding Persons record is included in 
another user’s post. Notifications appear as an Alert icon with a red box, which indicates the 
number of events that are unviewed.

Figure 15.4
Alert

Notification
Icon
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Clicking the alert icon displays a drop-down list where the user can select one of the alerts to 
view the corresponding post. Once the post has been selected, it disappears from the alert list.

Figure 15.5
Viewing
Spaces

Notifications
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Use Spaces to Create a Contact Log

In this exercise, use a Spaces post to create a Contact Log record and link to the Persons listed 
in the contact log. 

1. Double-click the Aptify web interface shortcut on the desktop.

• A prompt asking for your user name and password appears.

• This information has already been entered and saved on the training computer.

• Normally, if using Windows Integrated Security, you would enter your Windows 
login credentials.

2. Click Log In.

3. From the Dashboard, click the Spaces tab.

4. Click inside the white text box that reads “What are you up to?”

• An HTML window appears.

Figure 15.6
Creating a

Spaces Post

5. Enter Spoke to @ in the window.

• As soon as the @ symbol is entered, a search record text box appears.

• Users can also click the @ Link button to access the search.

6. Enter Baldwin, Aiesha in the search box.

• A list of matches appears as you type. 

Figure 15.7
Spaces Search

Results
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7. Click the Aiesha Baldwin result to add it to the post.

8. Enter need to follow up next week #. 

• As soon as the # symbol is entered, a list of actions appears.

• Users can also click the Action button to access the list.

Figure 15.8
Creating a
Follow Up

9. Click the Calendar button and select next Monday as the follow up date.

10. Enter Answer membership questions in the Description text box, then click 
Update.

• The new spaces record appears with a link to both Aiesha Baldwin’s record and a 
Contact Log of the scheduled follow up event.

Figure 15.9
Spaces Post
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Global Search

In the Aptify Desktop client, users must navigate to a service to search for a specific kind of 
record; to find Aiesha Baldwin’s Persons record, a user would run the find dialog from the 
Persons service, and the results would only include Persons records. However, Aptify web 
interface significantly improves search functionality with a Global Search that allows users to 
locate records from multiple services. By default, these services include Persons, Companies, 
and Views, but Global Search can be configured to include any service.

Figure 15.10
Global Search

Bar

Typing Danube, for instance, could bring up a list of not only Persons who work for Danube 
Partners, but also any Companies, Orders, or other records that matched, with the results 
being grouped by record type. 

Figure 15.11
Global Search

Results

Similarly, searching for a person might bring up the Persons record in addition to their 
associated Orders and Contact Logs.
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Global search also enables users to search for views. Typing in a name of a view locates any 
matching views that contain the search term. This makes it easy to quickly navigate Aptify 
and find any data needed.

Figure 15.12
Global Search

View Results

Finally, be aware that users can see their search history by clicking the Clock/Magnifying 
Glass next to the Search Bar, and can search only within a specific Service by first clicking 
the drop-down arrow next to the search bar, then selecting the desired service.

Figure 15.13
Global Search

Service
Selection
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Search for a Persons Record

In this exercise, use the Global Search feature to locate Aiesha Baldwin’s Persons record by 
searching for her Company, Danube Partners. Then, search again to find the Danube Partners’ 
Companies record.

1. Click in the search bar at the top of the screen and enter Danube Partners.

• A list of results containing both Persons who work for Danube Partners, and 
Companies records, appears.

2. Select Aiesha Baldwin to open her Persons record.

3. Click the X on Aiesha Baldwin’s Persons record’s tab to close her record and return to 
the dashboard.

4. Click the arrow next to the search bar to open a drop-down list. 

5. Select Companies to search only within the Companies service.

6. Click in the search bar and enter Danube Partners.

• A list of results appears.

Figure 15.14
Global Search

Company
Results

7. Select the first Danube Partners Companies record to open it.
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Navigating Persons Records

When a Persons record is first opened in the interface, a summary of the person’s key infor-
mation is shown. This includes their membership status, a headshot photograph, and an 
activity summary, which lists events such as orders and contact logs. 

Figure 15.15
Persons
Record

To view the rest of a Person record’s information, a user must first click Open In Edit Mode to 
the right of the summary data. From there, the user can see and edit the rest of the record’s 
details. Note that in Aptify web interface, records are organized using a drop-down list, rather 
than tabs as with the Aptify Desktop client. 

Figure 15.16
Person Record

Edit Mode
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To see the various types of information, such as related Orders or Committees, click the arrow 
next to the Contact header, then select a category.

Figure 15.17
Person Tab

Selection
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Order a Membership

In this exercise, locate Aiesha Baldwin’s Persons record, then open the record in Edit Mode to 
place an order for an Individual Membership.

1. Click the arrow next to the search bar and select Persons. 

2. Click in the search bar and enter 1.

• This the ID for Aiesha Baldwin’s Persons record.

3. Select Aiesha Baldwin’s record from the list of results.

4. Click Open In Edit Mode.

• This displays additional Person information and allows the record to be modified.

5. Click the arrow next to Contact.

• A list of options, corresponding to record tabs in the Aptify Desktop client, 
appears.

6. Select Orders.

Figure 15.18
Persons

Orders Tab

7. Under Orders for Aiesha Baldwin, click New Record.
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8. Click in the Find Product field, enter Individual Membership, and click Add.

• The product appears on the order line.

Figure 15.19
Adding a

Product to an
Order

9. Click the Payment & Summary heading to expand the payment area.

10. Click in the PO Number field and enter 123456.

Figure 15.20
Entering Order

Payment
Information

11. Click Save.

12. Click Wade/Alexandra in the Ship To field to return to her record.

13. Click Refresh.

• Observe Alexandra Wade is now a Corporate Member.
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Access a View

In this exercise, search for and open the San Francisco Student Members view created in the 
Views chapter.

1. Click in the search bar at the top of the screen and enter San Francisco.

2. Select the San Francisco Student Members result.

• Observe the view contains the same settings that were used in the Aptify Desktop 
client. 

Figure 15.21
Aptify web

interface List
View
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3. Note that users can edit the view’s filters and other settings by clicking More and then 
selecting Properties.

Figure 15.22
Accessing

View
Properties
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Summary

• Access Aptify web interface from laptops, tablets or other mobile devices

• Use Spaces to keep your organization up-to-date on Aptify activity

• Take advantage of Global Search to easily find any type of record

• Open Persons records in Edit Mode to see all of their information
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Objective

Users will be able to:

• Nominate Persons for Awards

• Track Awards from inception to conclusion

Overview

Many organizations offer incentives and awards to their employees and members. The 
Awards application allows organizations to track various awards and incentives programs. 
The application includes the ability to create many awards programs, to track awards 
nominees and finally to represent recipients of awards. Common programs include:

• Committee Years of Service Pins (and similar awards)

• Employee of the Month

• Sales Team Incentive Tracking
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Defining Award Types

Before an organization can begin tracking awards in Aptify, the types of awards and incen-
tives that will be offered by the organization must be defined. The Award Types record tracks 
the name of the award as well as description of the award type. Follow these steps to create a 
new award type:

1. Open a new record from the Award Types service.

• The Award Types service is located in the Award Management application.

2. Enter Innovation in the name of the award in the Award Type field.

3. Enter Test the Description field.

Figure A.23
Award Types

Record

4. Save and close the record.
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Tracking Award Nominations

Aptify’s Award Management application includes the Awards Nomination service that can be 
used to track the award nomination process. The Awards Nomination service is for tracking. 
By default, the system does NOT automatically convert a nomination to award. 

Nominating a Person for an Award

The Awards Nomination record tracks the nomination process. Persons can be nominated for 
an award by another person or the person can apply for the incentive themselves depending 
on the organization’s award practices. 

1. Open a new record from the Awards Nomination service.

2. Select the Innovation award created earlier from the Award Type drop-down list.

3. Enter your Persons ID in the Person Nominated field. 

4. Enter Dalton Brown in the Nominated By field.

5. Enter the date on which the nomination was received in the Nomination Date field.

6. Keep Pending as the current status of the nomination from the Status drop-down list. 
Pending is selected by default. Once a person has been added as an award nominee, you 
can add more information or modify the person’s nomination status at any time as neces-
sary during the nomination process. The available Status types are as follows:

• Pending — Selected by default. The process is pending, no decision made yet.

• Approved — Nominee has been accepted to receive specified award/incentive.

• Rejected — The nominee will not receive the specified award or incentive.

7. Enter Test in the Description field.

8. Save the record.
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Tracking Awards and Incentives

The Awards Granted service can be used to track awards and incentives given out by an 
organization. A record in this service tracks information such as the type of awards given, the 
recipient or recipients, the location of award ceremony, etc.

1. Open a new Awards Granted record with one of the following methods:

• Open a new record from the Awards Granted service.

• Open a new record from the Awards tab on a Persons record.

2. Select the Nomination award from the Award Type drop-down list.

3. Enter Edward Aaronson in the Person Awarded field. 

4. Enter today’s date in the Date Achieved field.

5. This award is the result of an accepted nomination; link the corresponding nomination to 
the award by specifying the previously created record in the Award Nomination field.

• If this award was for more than one person, you could specify a second winner in 
the Second Person Awarded field.

6. Enter HQ in the Award Ceremony Location field.

7. Enter Cash in the Other Benefit Provided field.

8. Enter Car in the Other Benefit Details field.

9. Enter Memento in the Memento Type field.

10. Enter Solid Gold in the Memento Type Details field. 
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11. Click the Description tab and add additional details about the award being grant or about 
the recipient(s).

12. Save the record.
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B Sales Force Automation

Objective........................................................................................................................  B.1

Creating Opportunities Records ....................................................................................  B.2

Objective

Users will be able to:

• Create Opportunities Records

• Track Opportunities

Overview

Organizations have a growing need to support contact management and opportunity tracking 
related to their prospective customers. The SFA application is designed to bring an integrated 
approach to tracking the lead generation process to their CMS/AMS system. In addition, 
many organizations employ inside sales team members. Features like Call Scripting are 
central to ensuring a common message. 
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Creating Opportunities Records

1. Bring over the Sales Force Automation application.

1. Open a New Record from the Opportunities service. 

2. Enter XYZ Opportunity in the Name field. 

3. Select General from the Type drop-down list. 

4. Enter yourself as the primary contact for this opportunity in the Account Manager field. 

5. Enter a name for the primary contact person for this opportunity in the Person field. 

6. Enter your XYZ Company as the name of the prospect in the Company field.

7. Enter today’s date in the Requested On field

8. Enter the date three days from today in the Expected Decision Date

9. Look at the options for the Status, Stage, and Source fields, but keep the defaults.

10. Click on the Details tab
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11. Observe the Details fields, especially the Commission Percent and Confidentiality 
Level fields

12. Return to the Details tab

13. Change the Status to On Hold

14. Open up the History Tab

15. Observe: the Status change history is recorded under this tab.
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16. Click on the Line Items tab

17. Open a new Line Item

18. The Line Items tab stores information about the set of goods and/or services being offered 
to the prospect in the opportunity's proposal. In other words, this tab stores the items that 
the organization is actively selling to the prospect as a solution to the requirements speci-
fied in the prospect's RFP (Request for Proposal).

19. Save the record

20. Click on the Competitors Tab
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21. The Competitors record tracks information about any known companies competing for a 
particular opportunity. 

22. Add a New Competitor’s Record

23. Observe the fields available to track your competition:

24. Save and Close the Record.
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C Accounting and Batching

Accounting Information ................................................................................................  C.1
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Creating an Orders Batch ..............................................................................................  C.3

Creating a Payments Batch............................................................................................  C.8

Expanding a Scheduled Transaction Group ..................................................................  C.11

Cash Control Batches ....................................................................................................  C.16

Accounting Information

Financial Management Features

• Tracks General Ledger (GL) accounts

• Creates GL entries for orders and payments

• Includes Cash Control management

• Integrates with VeriSign Payflow Pro for credit card authorization and payment captures

• Supports multi-entity accounting between parent organization and subsidiaries

• Supports multiple currencies
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Batching

General Ledger (GL) Batches in Aptify are used to transfer the GL Entry information from 
the Orders, Payments, and Scheduled Transactions services to the organization’s accounting 
system. The Batch is designed to sum the individual entries in multiple orders, payments, or 
scheduled transactions. Batches can sum up any number of orders, payments, or scheduled 
transactions but can not include more than one type of record. For this reason, four batch 
types exist. They are Order Batches, Payment Batches, Scheduled Transaction Batches, 
and Cash Control Batches. 

GL Batching:

• Aggregates all individual GL entries form the records into one ledger entry

• A single GL batch includes records of the same type and the same currency

• If using multiple currencies, one General Ledger batch is created for each 
currency type

• Once batched, a record’s financial fields cannot be modified

• This maintains integrity between Aptify and the Accounting system

• The General Ledger batch number appears on the record

• General Ledger Batch records contain GL entries that can be exported to 
your organization’s financial system

• During the order batching process, Aptify automatically adjusts a product’s inven-
tory count as necessary

In this section, you will learn how to:

• Create an Orders Batch 

• Create a Payments Batch

• Expand Scheduled Transaction Groups

• Create a Scheduled Transaction Batch
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Creating an Orders Batch

Order Batches are used to transfer the GL Entries from a set of shipped orders to the 
accounting system.

1. Open a view of orders that you have created that are in a Shipped status. 

• If you do not have one already, you can create a view that displays only the 
orders where the Taken By field shows your Employees record. You can also ask 
your instructor for assistance constructing this type of view.

2. Right click within the view and select Order Options > Create Order Batch from the 
pop-up list.

Figure C.1
Create Order

Batch

3. Read the introduction on the first screen of the Aptify Batch Wizard -- Orders and click 
Next to continue.
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Figure C.2
Order Batch

Wizard

4. The wizard reports the number of records that qualify for the batch and the number of 
records that do not qualify.

• Only orders that have shipped and have not been previously batched qualify.

• To view the list of included or excluded orders, click in the Details field and click 
the button that appears.

Figure C.3
Review

Records for
Batching

5. Click Next to continue.
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6. Review the instructions for Step 2: Generate Order GL Entries and click Next. 

• Do not select the Regenerate Entries checkbox.

• Depending on the number of orders in the batch, it may take an extended amount 
of time to complete the regeneration process.

• In most cases, you do not need to regenerates the entries before batching orders. 
In general, you should only regenerate entries if you made changes to the 
system’s GL accounts since the orders you are batching were created.

7. Click Next to continue.

• The wizard displays the debit and credit totals for the orders in the batch. 

8. Click in the Details field and click the button that appears to review the Batch Summary 
GL Entries.

Figure C.4
Batch

Summary GL
Entries

9. Click OK to close the summary screen.

10. Select the Approval checkbox.

Figure C.5
Approve Batch
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11. Click Next to continue.

12. Click in the Batch Name field and add your initials to the beginning of the batch name.

Figure C.6
Modify Batch

Name

13. Click Finish.

• The Batch Results window appears and reports the ID for the batch you just 
created.

• You can also double-click an entry to export the batch results to a file. By default, 
Aptify supports exporting the results to a CSV (Comma Delimited) file.

14. Write down the Batch ID here: ___.

15. Click OK to close the wizard.

16. Open the first record in the My Orders view.

• Note that the Batch ID now appears under Customer Type.
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Figure C.7
Batch ID on

Orders Form

17. Close the record.
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Creating a Payments Batch

1. Right click the Payments service select Create View from the pop-up list.

2. Enter My Payments in the Name field.

3. Click the Filters tab.

4. Add the following filter:

• Service: Payments

• Field: EmployeeID

• Operator: =

• Value: The ID number of the Employees record that is linked to your user 
account. Ask your instructor if you need assistance identifying this number.

5. Click OK to save and open the view.

• The view displays all of the Payments records for which your Employee ID 
appears in the Taken By field.

6. Right click within the view and select Payment Options > Create Payment Batch from 
the pop-up list.

Figure C.8
Create

Payment Batch

7. Read the introduction on the first screen of the Aptify Batch Wizard -- Payments and 
click Next to continue.
C.8 Aptify End User Training Manual



Accounting and Batching Creating a Payments Batch
8. The wizard reports the number of records that qualify for the batch and the number of 
records that do not qualify.

• Payments that have already been batched are excluded from the batch process.

• To view the list of included or excluded payments, click in the Details field and 
click the button that appears.

9. Click Next to continue.

10. Review the instructions for Step 2: Generate Payment GL Entries and click Next. 

• Do not select the Regenerate Entries checkbox.

• In most cases, you do not need to regenerates the entries before batching pay-
ments. In general, you should only regenerate entries if you made changes to the 
system’s GL accounts since the payments you are batching were created.

11. Click Next to continue.

• The wizard displays the debit and credit totals for the payments in the batch. 

12. Click in the Details field and click the button that appears to review the Batch Summary 
GL Entries.

13. Click OK to close the summary screen.

14. Select the Approval checkbox.

15. Click Next to continue.
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16. Click in the Batch Name field and add your initials to the beginning of the batch name.

17. Click Finish.

• The Batch Results window appears and reports the ID for the batch you just 
created.

• You can also double-click an entry to export the batch results to a file. By default, 
Aptify supports exporting the results to a CSV (Comma Delimited) file.

18. Write down the Batch ID here: ___.

19. Click OK to close the wizard.

20. Open the first record in the My Payments view.

• Note that the Batch ID now appears at the bottom of the Payments record.

Figure C.9
Batch ID on

Payments
Form

21. Close the record.
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Expanding a Scheduled Transaction Group

The Scheduled Transaction Groups service exists for performance reasons. Since a single 
order could require a substantial number of Scheduled Transactions records to be created in 
order to recognize revenue over a long earn-out period, generating all the Scheduled Transac-
tions records at the time the order is shipped could place a substantial load on the system. 

The process of generating the actual Scheduled Transactions records from the Scheduled 
Transaction Groups record is known as Expanding Scheduled Transaction Groups. The 
process may be invoked at any time by choosing the Expand Scheduled Transaction Groups 
icon from the toolbar in any Scheduled Transaction Groups view. 

Note: Aptify recommends that Scheduled Transaction Group expansion occur after 
hours, since the process may be resource intensive (depending on how many groups 
you are expanding). Create or open a view of the Products service.

1. Open your XYZ Subscription record (or the ID of another subscription product).

2. Write down the Product ID here: _______.

Figure C.10
Locating

Product ID

3. Close the record.

4. Right click the Scheduled Transaction Groups service and select Create View from the 
pop-up list.

• Scheduled Transaction Groups is located under the Accounting application.

5. Enter XYZ STG in the Name field (where XYZ are your initials).

6. Click the Filters tab.

7. Add the following filter:

• Service: Scheduled Transaction Groups

• Field: ProductID

• Operator: =

• Value: The ID number of Subscription product (which you wrote down in 
Step 3). 

8. Click OK to save and open the view.

• The view displays all of the Scheduled Transaction Groups records related to 
subscription product.
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9. Click the Expand Scheduled Transaction Groups button.

• Alternatively, you can right click within the view and select Scheduled 
Transaction Groups Options > Expand Scheduled Transaction Groups from 
the pop-up list.

Figure C.11
Expand

Scheduled
Transactions

Groups

10. Click OK to expand all pending Scheduled Transaction Groups.

Figure C.12
Confirm

Expansion of
Scheduled

Transaction
Groups

11. Be patient while the Scheduled Transaction Groups are expanded. Click OK when 
prompted that the process is complete.

12. Click the Refresh button on the Scheduled Transaction Groups View Toolbar.

• Note that the Status changes from Pending to Complete.

• Close the View
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Creating a Scheduled Transactions Batch

1. Right click the Scheduled Transactions service (under the Accounting application) and 
select Create View from the pop-up list.

2. Enter XYZ Transactions in the Name field (where XYZ are your initials).

3. Click the Filters tab.

4. Add the following filter:

• Service: Products

• Field: ID

• Operator: =

• Value: The ID number of the XYZ Subscription product 

• Click OK twice to save and open the view.

5. Click OK to load the view.

6. Click the Create Scheduled Transaction Batch icon in the view toolbar to launch the 
Batch wizard.

Figure C.13
Create

Scheduled
Transactions

Batch

7. Read the introduction on the first screen of the Aptify Batch Wizard -- Scheduled 
Transactions and click Next to continue.

8. The wizard reports the number of records that qualify for the batch and the number of 
records that do not qualify.

• Transactions that have already been batched are excluded from the batch process.

• To view the list of included or excluded transactions, click in the Details field 
and click the button that appears.
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9. Click Next to continue.

10. Click Next to expand any pending Scheduled Transactions Group and compile the 
relevant GL entries.

Figure C.14
Expand

Scheduled
Transaction

Groups Step (if
necessary)

11. The wizard displays the debit and credit totals for the transactions in the batch. 

12. Click in Details field and click button that appears to review Batch Summary GL Entries.

13. Click OK to close the summary screen.

14. Select the Approval checkbox.

15. Click Next to continue.
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16. Click in the Batch Name field and add your initials to the beginning of the batch name.

17. Click Finish.

• The Batch Results window appears and reports the ID for batch you just created.

• You can also double-click an entry to export the batch results to a file. By default, 
Aptify supports exporting the results to a CSV (Comma Delimited) file.

18. Write down the Batch ID here: ___.

19. Click OK to close the wizard.

20. Open the first record in your Scheduled Transactions view.

• Note the Batch ID now appears at the top of the Scheduled Transactions record.

Figure C.15
Batch ID on
Scheduled

Transactions
Form

21. Close the record.
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Cash Control Batches

The manual processing of cash receipts is performed by creating a new Cash Control Batches 
record, and manually entering the cash receipts/corresponding Payments records. Once total 
receipts and applied payments are equal, cash control batches may be marked as approved. 
Once approved, Cash Control Batches are considered locked and can no longer be edited. 

Follow these steps to create a cash control batch: 

1. Open a new record from the Cash Control Batches service.

• The Cash Control Batches service is located in the Accounting application. 

• Today's date automatically populates the Date Entered field.

2. Enter date for deposited funds into organization's bank account in Deposit Date field.

3. Your name should default in the Entered By field.

• This field links to the Employees service.

4. Enter a cash receipt on the Cash tab, following these steps:

• Enter the customer's name in the Customer field. 

• Enter the amount of the cash receipt in the Amount field. 

• Enter the payment type of the cash receipt in the Type field. 

• This field links to the Payment Types service. 
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• Typically, the payment type is Pre-paid Check. But depending organiza-
tion's policies, it could also be a credit card (for example, if a cus-
tomer/member returned order form with credit card information 
completed).

5. Click the Add button to add the entry to the receipt list.

6. To track the check number of the cash receipt or add more information, double-click the 
cash receipt in the list to open the Cash Detail record. 

• Enter the Check Number in the field provided. 

• Click the Comments tab and enter any additional information. 

• Click OK to close the form. 

Note: that the Lock Box Information section of the form is not applicable to a manual 
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cash control batch (these fields are used with the Lock Box functionality).

7. Add additional cash receipts, as needed. 

As you add cash receipts to the record, the system automatically updates the Cash Total 
field to equal the sum of the individual cash receipts, as shown below.
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8. Save the Cash Control Batches record. 

9. Associate the cash receipts in the Cash Control Batch with Payments records in Aptify. 

• Generally, each cash receipt has a corresponding Payments record in Aptify that 
is applied to an Orders record. 

• You do not associate a particular receipt with a Payments record directly. Instead, 
you associate a Payments record with a Cash Control Batch. 

• As payments are associated with the Cash Control Batch, they appears on the 
Payments Posted tab, and the value of the Payment Total field increases, as illus-
trated above. (Note that you may need to close and reopen the Cash Control 
Batches record to see the updated Payment Total.).

10. Follow one of these step to associate a payment with a Cash Control Batch: 
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If a payment already exists that corresponds to this cash receipt, open that Payments record 
and click the Details tab. Then enter the ID of the Cash Control Batches record in Cash 
Control Batch field. Save and close the Payments record. 

a) If the payment does not yet exist that corresponds to the cash receipt but the order 
does exist (for example, the customer provided a Purchase Order for future 
payment at the time the order was taken), create a new Payments record and 
specify the appropriate Cash Control Batch in the field on the Details tab. Note 
that if you open a new payment from the Cash Control Batches record's Payments 
Posted tab, the system will pre-populate the Cash Control Batch field on the new 
payment for you.

b) If an order and payment corresponding to the cash receipt does not yet exist in the 
system (for example, if the customer sent in a completed mail order form with 
payment), create a new order for the customer and specify the appropriate initial 
payment information. 

11. Click the approve button once the Payment Total equals the Cash Total. 
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12. Click OK when prompted to confirm the approval request. 

The system automatically performs the following actions: 

• It inserts the current date and time in the Date Approved field. 

• It replaces the Approve button with a De-Approve button. 

• It inserts your name in the Approved By field (this links to your Employees 
record). 

• It locks down the Cash tab to prevent any further modifications to the cash 
receipts information. 

• It prevents any additional payments from being associated with this Cash Control 
Batches record. 

• It prevents any modification to the payment information in the Payments records 
associated with the Cash Control Batch
Aptify End User Training Manual C.21



Cash Control Batches Accounting and Batching
13. If you need to modify the Cash Control Batch after it has been approved, follow these 
steps: 

a) Click the De-Approve button: the system clears the Date Approved and Approved 
By fields and re-enables the Cash tab.

b) Modify the Cash Control Batch as necessary. 

c) When finished, click the Approve button again to re-approve the Cash Control 
Batch.
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Appendix
 D Publication Functions

Objective

Users will be able to:

• Alter the Delivery schedule of a subscription publication.

• Understand the Fulfillments function.

• Add Publication contributors to a product record.
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Altering the Delivery Schedule

You can change the delivery schedule for a subscription so that a recipient can receive their 
subscription while on vacation or at another office location.

1. Select the Delivery Schedule tab on the Subscriptions record.

2. Click the New button to open a new Subscription Delivery Schedule record.

3. Enter a date one month from today in the Start Date field.

4. Enter a date two months from today in the End Date field.

5. Enter an alternate address and contact information in the fields provided.

6. Enter your Persons ID in the Requested By field.

7. Enter Hard Shipment in the Distribution Type field.

8. Click OK.

9. Click Save.

• At the time of fulfillment, Aptify will look at the date and create the mailing label 
with the alternate address.
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Viewing Subscription Fulfillments

The Subscription Fulfillments service enables you to track the distribution of a subscription’s 
issue, specifying the distribution date, volume, and the recipients. In addition, by processing a 
subscription fulfillment, mailing labels are automatically generated.

Fulfillment means to send out an issue. A fulfillment is made for all issues sent this month. 

Creating the fulfillment generates a mailing label for magazines and decreases a subscription 
count by one. Subscription Fulfillment is done monthly for each subscription product. 

After you run a fulfillment, observe the Output, Mailing Labels to see how the mailing labels 
will look. You can also go back to the delivery log to observe how an entry is made after 
fulfillment. You will not be able to use the Output field during fulfillment if you did not make 
the Delivery Type “Hard Shipment”.

1. Right click the Subscription Fulfillments service and select New Subscription Fulfill-
ments Record from the pop-up list.

2. Select XYZ Subscription from the Product drop-down list.

3. Enter next month’s date in the Name field.

• For example, if the current month is January 20XX, you would enter February 
of the same year in the Name field.

4. Enter today’s date in the Distribution Date field.

• The Date Prepared field defaults to today’s date.

5. Enter 1 in the Volume field.

6. Enter 1 in the Issue field.
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7. Verify that the Use Vol. and Issue Number option is selected (this is the default setting).

8. Click the Create List button.

• A dialog box appears that informs you how many people qualified for this distri-
bution.

9. Click OK.

• The record is saved automatically and an ID number is assigned.

• The qualified recipients appear under the Recipient tab. You should see the fol-
lowing information if you completed the earlier exercises in this lab:

• 1 issue was sent to your Person, leaving 11 remaining.

• 3 copies of the item were sent to your Person, who had a bulk subscription.

• 1 issue was sent to your Person, leaving 5 remaining (since you canceled 
half of the original order in an earlier exercise).

10. Click the Output tab.
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11. Click the Mailing Labels button. (This option is applicable for hard shipment 
subscription products.)

• This opens the Report wizard for the Subscription Fulfillment service, which 
includes a standard subscription fulfillment label report. This report displays the 
address for each recipient so they can be printed to mailing labels.

• Within the Report wizard, click the Labels tab.

• Select the Subscription Fulfillment Label Report and click Next.

• Click Finish to display the mailing labels for the recipients.

12. Close the Subscription Fulfillment Label Report window.

13. Save and close the Subscription Fulfillments record.
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Creating a New Contributors Record

1. Select the Publications tab on your Subscription Product/Publications record.

2. Select the Publication Contributors sub-tab.

3. Click the New button on the toolbar to open a new Publication Contributors record.

4. Enter your Person in the Person field.

5. Select Editor from the Role drop-down list.

6. Leave Commission Type set to Flat Amount.

7. Enter $100.00 in the Commission field.

8. Leave Primary In Role selected (person is primary editor of the publication).

9. Click OK.

• The contributor’s record is added to the Publication Contributors tab.

10. Click the Prices tab and add prices for the product.

11. Save and close the record.
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Creating an Expos Record .............................................................................................  E.3

Adding Expo Prices .......................................................................................................  E.4

Creating Floorplans .......................................................................................................  E.5

Creating Booths Using the Booth Generator.................................................................  E.7

Using the Booth Combination Wizard ..........................................................................  E.11

Linking Meetings to Expos............................................................................................  E.15

Taking an Order for a Booth..........................................................................................  E.17 
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Using the Floorplan Copy Wizard.................................................................................  E.22 

Objective

Within Aptify, you can create and track Expos and design the layout of booths in the Expo’s 
venue. After completing this chapter, you will be able to:

• Create a new Expo

• Create a Floorplan

• Link a Meeting to an Expo

• Work with Booths

• Order a Booth

Overview

The Expos service provides an easy-to-use interface where an organization can create 
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Overview Expos
and manage all aspects of an exposition, including floorplans, booths, dates of the 
exposition, and contact information for the company and persons sponsoring the 
exposition. The Expo Management functionality is used to plan and manage a single 
expo, multiple expos, or for an exposition that is part of a larger event. Each Expos 
record tracks the total units of booth inventory, as well as any meetings that may be 
linked to the exposition. 

Expos are created as products with extended characteristics. Creation of an expos 
product requires the following items to be set up beforehand: 

• All GL accounts required by the organization to track expo finances. 

• One or more Product Categories records for Expo products that are associated with the 
GL accounts created to track expo finances. 

• A Product Types record named Expo that enables the Expo tab to display on the Products 
record. (This is included with the standard Aptify installation.) 

• A Products record for the expo, associated with the expo product category and product 
type.
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Creating an Expos Record

1. Click on the Expo Management dashboard.

2. Click New Expo button.

• An Expo record is a Products record with Type set to Expo. There is also an 
Expo tab added to the Products form.

3. Enter XYZ Expo in the Name field (where XYZ are your initials).

4. Enter Exhibits in the Category field.

5. Click the Expo tab.

Expos > General Tab

6. The General tab appears.

7. Enter XYZ Expo in the Expo Name field (where XYZ are your initials).

8. Enter your Company in the Vendor field.

9. Enter your Persons record in the Vendor Contact field.

10. Enter next Monday’s date in the Start Date field.

11. Enter next Friday’s date in the End Date field.

12. Enter this Saturday’s date in the Setup Date field.

13. Enter this Sunday’s date in the Setup Req. Date field.

14. Click Save.
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Adding Expo Prices Expos
Adding Expo Prices

Establishing prices for booth space at an Expo is different from setting prices for other 
products. An exhibitor pays for booth space at an Expo. If these booths are all the same size, 
then you can charge a uniform amount per booth to each exhibitor. However, if you offer 
booths of varying sizes you can define a base unit (such as a base booth size) and then 
configure expo pricing based on the number of units that the booth occupies. 

Example 1: An exhibitor rents floor space to accommodate a 10x10 booth (100 sq feet). If all 
of the booths at the Expo are the same size, 1 unit can equal 1 booth. In this case, you would 
use the following pricing rule if one booth costs $1000.00: 

Example 2: Your venue supports two booth sizes: an 8x10 booth (80 sq ft) and a 10x10 
(100 sq ft). In this case, you define a unit based on a common denominator between the two 
booth sizes. Therefore, 1 unit equals 20 sq ft, and the 8x10 booth is 4 units (4x20 = 80), and 
the 10x10 booth is 5 units (5x20=100). If you establish a price of $200 per unit, then these 
booths would have the following prices: 

Adding Member and Non-Member Prices

1. Click the Prices tab on your Expo record.

2. Right click in the gray area and click New to open a new Prices record. 

3. Enter Member Price in the Name field.

4. Enter $100 in the Price field.

5. Select Member from the Member Type drop-down list.

6. Enter Non-Member Price in the Name field.

7. Enter $200 in the Price field.

8. Select the Default box to indicate that this is the default price for the product.

9. Select Non-Member from the Member Type drop-down list.

10. Click OK.

11. Save and Close the Expos record.

Dimensions Number of Units Total Cost for Booth

10x10 Booth (100 sq ft) 1 unit $1000.00

Dimensions Number of Units Total Cost for Booth

8x10 Booth (80 sq ft) 4 units
1 unit = $200

$800.00

10x10 Booth (100 sq ft) 5 units
1 unit = $200

$1000.00
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Expos Creating Floorplans
Creating Floorplans

A Venue can have one or more Floorplans that define the possible layouts of the venue space. 
Floorplans are tied to Expos.

In this exercise, you will create a new floorplan.

1. Open the Floorplans tab 

2. Open a New Floorplans Record link.

3. Click on the red Floorplans link to the left of the Floorplans field.

• The New Floorplan Wizard launches automatically.

4. Click Next to continue.

5. Select Create Blank Floorplan.

6. Click Next.

7. Click Finish to create the blank floorplan.
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Creating Floorplans Expos
8. Enter XYZ Expo Floorplan in the Name field.

9. Enter XYZ Convention Center in the Venue field.

• Open the Venue record by clicking the red field link to the left of Venue field.

• Observe the information that can be stored for a Venue and Room - these records 
are created and controlled by Administrators of Aptify.

10. Select Feet from the Unit of Measure drop-down list (if not already selected).

11. Enter 200 in the Width field and 100 in the Length field.

12. Enter 1 in the Page Scale field and 100 in the Drawing Scale field.

• These two parameters form a ratio that defines the scale of the floorplan map. In 
this exercise, the scale is 1:100.

13. Enter 10 in the Default Width field.

14. Enter 10 in the Default Length field.

15. Enter 1 in the Default Units field.

• In this exercise, the default unit size is a booth that is 10x10 (100 square feet).

16. Enter XYZ Booth in the Next Booth Name field.

17. Enter 1 in the Booth Increment field.

18. Select Arrange & Assign from the Status drop-down list.

19. Click Save.
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Expos Creating Booths Using the Booth Generator
Creating Booths Using the Booth Generator

1. Click the Booths tab on the XYZ Expo Floorplan record.

2. Click the Booth Generator button.

3. In the Starting Location section, select the option in the upper left-hand corner.

• With this option selected, the Booth Generator will begin labeling booths from 
the upper left-hand corner.

4. Change the Initial Number to 1.

5. Select the Horizontal option in the Incrementation Rules section.

6. Click the Apply Rules button in the Horizontal section.

• The Adjacent and Aisle Separation fields update automatically.

• Leave the Number of adjacent Vertical booths prior to aisle separation set to 5.

• These settings determine booth layout and numbering.
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Creating Booths Using the Booth Generator Expos
7. Click Generate Grid.

• The Booth Generator adds booths and aisles to the floorplan.

8. Select Booth 101 and click the Space button.

• You can use this option to add spaces within the floorplan.

9. Select the Space cell and click the Booth button.

• The Space is changed back to a Booth.

10. Select the blank Booth and click the Booth Names button.

• The Booth is renumbered back to 101.
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Expos Creating Booths Using the Booth Generator
11. Click OK.

• Be patient while the system creates the necessary Booths records.

• If only one booth shows up in the Booths view, refresh the view to show all of the 
booths.

12. Double-click the first Booths entry in the Floorplan’s Booth tab to open the correspond-
ing Booths record.

13. Add 3 to the Maximum# field (in the Booth Registrant Information section).

14. Review the format of the Booths record.
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Creating Booths Using the Booth Generator Expos
15. Save and Close the Booths record.
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Expos Using the Booth Combination Wizard
Using the Booth Combination Wizard

You use the Booth Combination Wizard to combine one or more booths into a larger booth or 
to break up a combined booth to two or more smaller booths.

Combining Booths

1. Open the XYZ Expo Floorplan record’s Booths tab (if not already open).

2. Click the Booth Combination Wizard icon to launch the Booth Combination Wizard.

3. Click Next to continue.

4. Enter XYZ Expo Floorplan in the Floorplan field and click Next.
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Combining Booths Expos
5. Select Combine booth records to create a larger booth and click Next.

6. Select the Selected checkbox for the following booths: Booth1, Booth3, Booth5, Booth7, 
and Booth9. Note: You may need to scroll through the list of booths to find the needed 
booths.

7. Click Next.

8. Select the Surviving Booth checkbox for Booth1 and click Next.
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Expos Separating Booths
9. Review the settings for the new combined booth and click Finish.

10. Click No to combine another set of booths.

Separating Booths

At times it may be necessary to separate booths after they have been combined. The Booth 
Combination Wizard offers the flexibility to separate booths.

1. Open the XYZ Expo Floorplan record’s Booths tab (if not already open).

2. Click the Booth Combination Wizard icon to launch the Booth Combination Wizard.

3. Click Next to continue.

4. Enter XYZ Expo Floorplan in the Floorplan field and click Next.

5. Select Break apart a booth record to create smaller booths and click Next.

6. Select the Selected checkbox for the Booth1 booth and click Next.
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Separating Booths Expos
7. Allocate the available Units and Length among the five records.

• Create two 2-unit booths with one 1-unit booth in the middle. (as shown in Figure 
21.13).

8. Click Finish.

9. Select No when asked if you want to break up additional booths.

10. Save and Close the Floorplans record

11. The Floorplans record should now display beneath the Floorplans tab of the Expos 
record.
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Expos Linking Meetings to Expos
Linking Meetings to Expos

An Expo product may be linked to one or more meetings. An organization that sells booth 
space to an event frequently sells attendance for the same event. 

In addition to defining the link between the Expo and Meeting products, you can also track 
Expo Registrants who are staffing a particular booth. Aptify allows the user to specify if a 
meeting registrant is an exhibitor, and if so, which booth he/she will be staffing.

1. Open the Meetings tab of the Expos record.

2. Open a New Meetings Record.

3. Enter XYZ Management Conference in the Name field (where XYZ are your initials).

4. Enter Meetings in the Category field.

5. Click the Prices tab.

6. Add a Member Price of $1000.

7. Add a default Non-Member Price of $2000.

8. Click the Meetings tab.

9. Enter XYZ Management Conference in the Meeting Title field.

10. Enter the dates for the meeting.

• Enter the first day of next month in the Start Date field.

• Enter the third day of next month in the End Date field.

• These are the same Start and End Dates as your Expo.

11. Leave the Status set to Planned (the default setting).

12. Enter your Employee in the Coordinator field.

13. Enter XYZ Expo in the Linked Expo field.
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Linking Meetings to Expos Expos
14. Click Save and Close.

15. The XYZ Management Conference displays under the Expos Meeting Tab.

• Users may have to click the refresh button to display.
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Expos Taking an Order for a Booth
Taking an Order for a Booth

A user reserves a specific Expo booth by placing an order for that booth. Aptify limits the 
selection of the booth to those that are available within one of the floorplans linked to the 
Expo product. The system will not allow the user to assign a booth that has already been 
assigned to another customer or one that has been merged into another booth. In addition, the 
system will validate that the user has purchased enough units.

1. Open a new order.

2. Enter your Persons record in the Ship To field.

3. Create an order line for 1 unit of XYZ Expo 20XX.

4. Click on the Add button.

5. The Order Line, Expos tab should automatically display.

• This occurs IF the Expo Product’s Order Line Details are set up to automatically 
display under the Products, Details tab

6. Click the Booths tab.

7. Select XYZ Floorplan from the Floorplan drop-down list if it is not the default floor-
plan.

8. Enter XYZ Booth1 in the Booth fields.
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Taking an Order for a Booth Expos
9. Click OK to return to the Order form.

10. Enter your saved Credit Card payment information.

11. Click Save and click No when asked if you want to ship the order.

12. Add an order line for 1 unit of XYZ Management Conference.

13. The Order Line, Meetings, General tab should automatically display.

14. Select the Is Exhibitor checkbox.

15. Select XYZ Booth1 in the Exhibitor Booth field.

16. Click OK to close the Order Lines record and return to the order.

17. Save the order, and click Yes when prompted to pay the order in full using the specified 
credit card information.

18. Say Yes when asked if you want to ship the order. 

• The system ships the order and locks down parts of the order to maintain an accu-
rate audit trail.

19. Close the order.

20. Click on the Expo Management application Dashboard.

21. Open the XYZ Expo Floorplan from the Floorplans View.

22. Click the Booths tab.

• Notice that the IsOccupied box is now selected for XYZ Booth1.
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Expos Taking an Order for a Booth
23. Double-click the XYZ Booth1 entry to open the corresponding Booths record.

• Notice that the order information now appears on the Booths record.

24. Close all open records.
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Canceling an Expo Order Expos
Canceling an Expo Order

In this exercise, you will run the Order Cancellation wizard from an Orders view to cancel the 
Meeting and Expo you ordered in Exercise 10.

1. Open an Orders view.

2. Click the Order Cancellation Wizard icon to launch the wizard.

3. Click Next to continue.

4. Enter the ID of the Order you created in Exercise 10 in the Order field and click Next.

5. Select the checkbox for both the Expo and the Meeting and click Next.

6. Select the Keep On Account option and click Next to continue. 

7. Click Finish to create the cancellation order.

8. Click Yes to open the order after the cancellation order has been created.

9. Change the Order Status to Shipped and click Yes when asked if all items have shipped.

10. Close the order.

11. Click No when asked if you want to process another cancellation (this closes the wizard).

12. Open the XYZ Expo Floorplan from the Floorplans service.

13. Click the Booths tab.

• Notice that the IsOccupied field is now set to False for XYZ Booth1.

14. Double-click the XYZ Booth1 entry to open the corresponding Booths record.

• Notice that the order information has been removed from the Booths record.
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Expos Canceling an Expo Order
15. Close all open records.
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Using the Floorplan Copy Wizard Expos
Using the Floorplan Copy Wizard

You can use the Floorplan Copy wizard to create a copy of an existing floorplan (for example, 
if you have previously held an expo in this venue, you can save time by copying an existing 
floorplan and its booths and then make modifications as necessary).

1. Create a view of the Floorplans service using XYZ Floorplans as the Name and add the 
following filter:

• Service: Floorplans

• Field: Name

• Operator: Contains

• Value: XYZ (your initials)

2. Click the Floorplan Copy Wizard icon in the View toolbar to launch the wizard.

3. Click Next.

4. Enter XYZ Expo Floorplan in the Floorplan field and click Next.

5. Select all booths to copy and click Next.

6. Enter XYZ Expo 20XX Production Floorplan in the Name field.
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Expos Using the Floorplan Copy Wizard
7. Click Next and allow the system to generate the booth records. 

8. Click the Display option to view the new Floorplans record.

9. Click the Booths tab and confirm that the wizard copied the booth configurations from 
the XYZ Expo Floorplan.

10. Close all open records and wizards.
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Using the Floorplan Copy Wizard Expos
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Appendix
 F SQL Value Statements for Views

Objective

Users will be able to:

• Insert SQL Statements into View Filter Value fields to create links to Dates and 
Employee IDs

Overview

Following Page contains the filter values that can be inserted for 

• Dates

• Employee IDs

• Sounds-Like 

• LastName = '<PROMPT….>'

• Becomes

• SOUNDEX(LastName) = SOUNDEX('<PROMPT…..>')

• This allows you to do "sounds like" instead of begins with / exactly matches, 
etc.ValueOperator

• UsedResults

• Prompted Proximity
F.1



Overview SQL Value Statements for Views
EMPLOYEE_NAME (Operator = Exactly Matches) - Returns the records associated with 
the current user's employee name. This will return a blank value if the user does not have an 
associated employee record.

EMPLOYEE_ID - Returns the records associated with the current user's Employee ID. This 
will return a blank value it the user does not have an associated employee record. 

SUSER_NAME or 

SUSER_NAME() or

CURRENT_USER or

SUSER_SNAME or

USER

Use Exactly Matches as the Operator to Return the records associated with the current user's 
SQL user name.

TODAY or

GET DATE or

NOW + or - number of days Returns today's date plus or minus the number of days following
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Appendix
 G Quick Reference Guides

Objective

Users will be able to:

• Use the accompanying Quick Reference Guides for understanding of frequently 
used parts of the system

• Print out the guides separately for quick reference use

Overview

Aptify Quick Reference Guides are designed to help users with frequently used parts of the 
system. On the following pages users will find Guides that cover the following topics:

• Creating List Views

• Managing Views

• Reports

• Record Management

• Contact Log

• Membership and Subscription Renewal

Quick Reference Guides should be copied out of the manual when needed. A good practice is 
to hang these guides on your cube wall for use when first using the system. The Guides act as 
functional, step by step reminders of how to conduct the frequently used operations of Aptify.
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Managing Views QRG 

Creating Shortcuts 

1. Select the desired View from the Navigation Bar 
2. Select the desired Shortcut Group by clicking on it - this may contract the Group - click again on the bar to expand 
3. Right click on the desired View in the Navigation Bar and select Add to Shortcut Bar 

a. If one or more shorcuts exists under the Bar, the new View will be placed at the bottom of the Group

Managing Shortcuts 

1. Right Click on an existing Shortcut Group 
2. Shortcut Menu Bar will display with following options: 

a. Add Group 
b. Remove Group 
c. Add Item - Displays Views Search (This can be used as an alternative to steps 1-3 above) 
d. Small Images 
e. Small Images with Text 
f. Large Images 
g. Large Images with Text 
h. Large Images with Text Below 

3. Users can move Groups by Dragging them 
4. Users can move Views within a Group OR from Group to Group by Dragging them 

NOTE: Users can also Drag and Drop Views, Services, and Folders to the Shortcuts area from the Folder List

Creating a View Template

1. Open the Properties of a View - Configure the Properties as desired
2. Click on the Save Template… button in the lower left hand corner
3. The Save Template dialog box will display: Enter the Name of the Template
4. Save to the applicable Category for the Template
5. Users can create New Categories to aid in organizing their View Templates

a. Remember – View Templates are visible to ALL users of that service, not just the creator
b. Check if your Department function has already created a folder

6. To Load the View template, create a new View from that service
7. Click on Load template… button in the lower left hand corner
8. Select the desired View template from the dialog box - All View templates are visible by all users

Creating Shared Folders

1. Right click on the desired Service
2. Select Create Folder
3. Create Folder box displays
4. Enter a Name and Description
5. Click on the Share this Folder box

Connecting to Shared Folders

1. Right click on the desired Service
2. Select Connect to Shared Folder
3. Connect to Shared Folder box displays
4. Expand the desired User to connect to under the All Users list
5. Select the desired folder to connect to: Folder displays within the Service
6. To Edit a View from a Shared Folder:

a. User must Right click on the View in the Navigation Bar
b. Select Copy the View
c. User must Right click on the Service in the Navigation Bar
d. Select Paste the View
e. Copied View will display within the Service labeled “Copy of…”

NOTE: IF Shared Folder edited by Owner, users will automatically receive the updates – this enables the Owner (managers/admin-
istrators) to update/edit views.



Creating View Tips

1. Consider the Use of the View
a. Data mining (Excel Integration & Reports)
b. Communication - Track records needing attention, processing (Dashboards & Wizards), updates
c. Searching for records (prompted views)
d. Dashboard

2. Filter linked fields based on ID instead of Name
a. No spelling mistakes and no problems when the field name changes
b. The Basic Find dialogue is much cleaner than a drop down list of only 100 results

3. Use Prompts with Default Values
a. Ensures future user of the view will know about that criteria
b. Only one extra click, no actual editing required

4. Watch your Filter Logic
a. Scenarios exist where the Filter Logic will reset to all AND statements - ex. if you delete a criteria
b. If editing Filter criteria, always display Advanced area – will be visible

5. Get rid of Unnecessary Columns
a. Tempting to include any/all Fields or leave all default Fields displayed
b. Avoid a displayed scroll bar – trim view to usable fields.

6. Clean up your Column Headings
a. On Fields tab - Display Name & Description– replace cryptic field names/descriptions with sensible ones
b. On Format tab, check Use Custom Formatting…, Wrap Caption – displays heading w/out white space

7. USE the Preview Pane & Hierarchy
a. Provides tons more information per List View entry
b. Preview Pane can be set to a different template per View

Managing Views QRG

1. End Users

a. Use the Shortcuts bar
i. DO NOT use the Folder List! Do you use Windows Explorer to find a Word doc!?
ii. Use Shortcuts bar to organize Views topically and mix together different services
iii. Display the high usage views - avoids the confusing Folder List

b. No really…start using the Shortcuts bar!
i. Start using NOW - right click on Views you use and SHORCUT THEM!
ii. 10 minutes – end of day – organize them
iii. Right click on Shortcut Group for different formats – try Small Icon w/Text

c. Create a “Trash” folder in each service for one-time-use views
i. Dump one time use views in folder
ii. Create one-time use views inside the Trash folder
iii. Keeps list of views from becoming cluttered
iv. Periodically purge your “Trash” folders

d. Once connected to a Shared Folder, logically rename it if needed
i. Avoid displaying multiple folders all named “Shared Views”
ii. The owner still controls original folder name in their Folder List

e. Make sure the view can be easily identified based on its Name
i. Use Description area to add detailed explanations for complex views

2. Administrators
a. Concentrate core shared views into minimal folders

i. Avoid core views spread across folders - creates confusion/ frustration for end users
ii. End users connect to fewer shared folders, reduced clutter/concentrated update area

b. Standardize approach to how CORE views are stored:
i. One person per functional team responsible for team’s shared views
ii. One person responsible for the shared views in each service
iii. All organization-wide shared views transferred to the sa account

c. Create a summary document of available shared views
i. Enables users to avoid reinventing the wheel
ii. Admins can create a View of Views to see ALL users Views – can print/export for managers

d. Clean up Display Names and Descriptions on Entities records
i. It will be easier for end-users to figure out what fields they should use on Filters and Fields tabs
ii. Make sure Display Names will look appropriate in alphabetical order
iii. Add “XX” or “DO NOT USE” to the Display Name of stock Aptify fields that your association doesn’t use to avoid accidental 
use

e. Create View Templates where specific set of filters ALWAYS need inclusion
i. Improves the odds that the set of filters will be built correctly
ii. Allows end-users to then enhance the view based on specific needs

Aptify Training and Education
To arrange for On-Site, Scheduled, or Ad Hoc training please feel free to contact Renee.Thorpe@aptify.com or
dave.oconnell@aptify.com





Appendix
H Views Worksheet

Use the following worksheet to frame your ideas of views you will use in your everyday job.
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Views Worksheet
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